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Installing Pro Tools Software

Welcome to Pro Tools® from Avid. This guide documents how to install and authorize Pro Tools 
on Mac and Windows systems. For detailed information on configuring your Pro Tools system, 
and for complete information about Pro Tools system capabilities and functionality, see the 
Pro Tools Reference Guide  (available from the Help menu in Pro Tools).

There are four types of Pro Tools systems:
Pro Tools Software

These systems include Pro Tools software with Avid 003™ or Digi 002® family audio interfaces, 
Eleven® Rack, Mbox® or Mbox 2 family audio interfaces, or M-Audio hardware. These systems 
also include Pro Tools software using third-party audio interfaces with supported Core Audio 
(Mac, including the built-in audio on Mac computers) or ASIO (Windows) drivers.
Pro Tools HD Software with Hardware Acceleration

Hardware-accelerated Pro Tools HD systems include Pro Tools HD software with Avid HDX, 
Pro Tools|HD, or HD Native hardware. Hardware-accelerated systems provide expanded I/O 
capabilities and low latency monitoring. Pro Tools HD software with Avid HDX or Pro Tools|HD 
hardware also provides dedicated DSP for plug-in processing and for large mixer configurations.
Pro Tools HD Software or Pro Tools Software with Complete Production Toolkit

These systems include Pro Tools HD software or Pro Tools software with the Complete Production 
Toolkit option with any compatible Avid, Core Audio, or ASIO hardware. 
Pro Tools Express Software

These systems include Pro Tools Express software with Mbox family audio interfaces (3rd 
generation). (For more information, see the Pro Tools Express Install Guide.)

For a list of qualified audio interfaces and computers for all Pro Tools systems, visit 
www.avid.com/compatibility. 
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System Requirements and Compatibility
Pro Tools can be used with a qualified audio interface, running on a qualified Windows or Mac 
computer.

A DVD drive is required to use the Pro Tools Installer disc.

An internet connection is required for downloading the Pro Tools Installer.

Avid can only assure compatibility and provide support for hardware and software it has tested 
and approved. 

For complete system requirements and a list of qualified computers, operating systems, hard 
drives, and third-party devices, visit:

www.avid.com/compatibility

Authorized iLok
The standard Pro Tools software package includes a pre-authorized iLok for running Pro Tools 
software. Hardware packages with Pro Tools include one unauthorized iLok and an Activation 
code for your Pro Tools authorization. For more information, see “Authorizing Pro Tools” on 
page 3.

MIDI Requirements
USB, FireWire, and PCI MIDI interfaces work effectively with Pro Tools systems on Mac or 
Windows. Serial MIDI interfaces are supported on Windows systems only.

An authorized iLok must be inserted in an available USB port on your computer to run 
Pro Tools.

For a list of supported MIDI interfaces and controllers, visit www.avid.com.
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Hard Drive Requirements
For optimal audio recording and playback, all Pro Tools systems require one or more qualified 
hard drives. 

Initialize your hard drives with the Disk Utility application included with Apple System software 
(Mac) or Windows Disk Management (Windows).

Avoid Recording to the System Drive
Recording to your system drive is allowed, but not recommended. Recording and playback on 
a system drive may result in lower track counts and fewer plug-ins.

Authorizing Pro Tools
Pro Tools software is authorized using the iLok USB Smart Key (iLok) from PACE Anti-Piracy. 
An iLok can hold hundreds of authorizations for all of your iLok-enabled software. Once an 
iLok is authorized for a given piece of software, you can use the iLok to authorize that software 
on any computer.

For optimum performance, you may want to designate your system drive as a Playback or 
Transfer only volume in DigiBase. For more information, see the Pro Tools Reference Guide.

iLok USB key

You can use either the new version of the iLok (shown above) or the previous version of 
the iLok to hold your Pro Tools authorizations.
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Pro Tools HD Authorization
A Pro Tools HD authorization lets you run Pro Tools HD software on a supported Mac or Windows 
computer with or without Avid HDX, Pro Tools|HD, or HD Native hardware. A Pro Tools HD 
authorization also lets you run Pro Tools HD software with any other Avid-qualified audio 
interface (such as Mbox Pro or Fast Track) or any third-party audio interface with supported 
Core Audio (Mac) or ASIO (Windows) device drivers.

Pro Tools Authorization
A Pro Tools authorization lets you run Pro Tools software on a supported Mac or Windows 
computer with an Avid-qualified audio interface (such as Mbox Pro or Fast Track) or any third-
party audio interface with supported Core Audio (Mac) or ASIO (Windows) device drivers.

Complete Production Toolkit Authorization
A Complete Production Toolkit authorization along with a Pro Tools authorization lets you 
run Pro Tools software with Complete Production Toolkit functionality. Complete Production 
Toolkit software option for Pro Tools provides increased voice and track counts, and surround 
mixing, editing, and automation capabilities that are equal to Pro Tools HD

A Pro Tools authorization is insufficient to run Pro Tools HD software. Attempting to launch 
Pro Tools software on a system with HDX, Pro Tools|HD, or HD Native hardware without 
a Pro Tools HD authorization results in Pro Tools software launching if it can use Core 
Audio or ASIO with the built-in sound or another audio interface, but it will not be able 
to use any installed HDX, Pro Tools|HD, or HD Native hardware.

For more information about Complete Production Toolkit, see the Complete Production 
Toolkit Guide or the Pro Tools Reference Guide.
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Authorizing iLok with an Activation Code
If you purchased a new boxed version of Pro Tools software, it comes with a pre-authorized 
iLok. You can skip this section and proceed with “Installing Pro Tools” on page 6.

If you purchased a new Avid HDX, Pro Tools|HD, or HD Native system, it comes with an empty 
iLok and an Activation Code (on the included Activation Card) for authorizing Pro Tools HD 
software. Follow the authorization instructions below.

If you upgraded from an earlier version of Pro Tools software, it comes with an Activation Code 
(on the included Activation Card) for authorizing your software upgrade on your iLok. Follow 
the authorization instructions below.

To authorize Pro Tools software using an Activation Code:

1 If you do not have an iLok.com account, visit www.iLok.com and sign up for an account.
2 Transfer the license for your software to your iLok.com account by doing the following:

• Visit www.avid.com/activationcard.

– and –
• Input your Activation Code (listed on your Activation Card) and your iLok.com User ID. 

Your iLok.com User ID is the name you create for your iLok.com account.

3 Transfer the licenses from your iLok.com account to your iLok USB Smart Key by doing the 
following:

• Insert the iLok into an available USB port on your computer.

• Go to www.iLok.com and log in.

• Follow the on-screen instructions for transferring your licenses to your iLok.

For more information, visit the iLok website (www.iLok.com).
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Installing Pro Tools

Installation Overview
Installation of Pro Tools includes the following steps:
1 “Installing Hardware Drivers” on page 6.
2 “Installing Pro Tools Software” on page 7.
3 “Installing Avid Virtual Instruments” on page 10 (optional).
4 “Launching Pro Tools” on page 12.
5 Configuring your system for improved performance (see the Pro Tools Reference Guide).
6 Making audio connections to your audio interface. (Refer to the documentation that came 
with your audio interface.)

Installing Hardware Drivers
Before installing Pro Tools software, ensure that you have installed your audio hardware and 
that you have installed the latest drivers for your hardware. Refer to the documentation that 
came with your hardware for more information. For Avid audio interfaces, install the drivers 
for your hardware using the corresponding driver installer on the Driver Installers disc included 
with the Pro Tools Installer package, or visit www.avid.com/drivers to download and install 
the latest drivers for your device.

If you are upgrading Pro Tools, be sure to uninstall any lower version of Pro Tools from 
your computer. See “Uninstalling Pro Tools” on page 14.

For Avid HDX, Pro Tools|HD, and HD Native hardware only, the Pro Tools installer in-
stalls the necessary hardware drivers automatically.

Pro Tools will not recognize your audio interface if you do not install the drivers. If you 
are upgrading Pro Tools, be sure to install the latest drivers for your hardware.
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Installing Pro Tools Software
After you have installed the drivers for your audio interface, you are ready to install Pro Tools.

To install Pro Tools:

1 Make sure you are logged in as an Administrator for the account where you want to install 
Pro Tools. 
2 Do one of the following:
• Insert the Pro Tools Installer disc in your DVD drive. 

– or –
• Download the Pro Tools installer online.
3 Do one of the following:
• On Mac, locate and double-click Install Pro Tools.mpkg.
• On Windows, do one of the following:

• If Windows AutoRun is enabled, a mini-browser appears. Select Install Pro Tools to begin 
installation. 

– or –
• If Windows AutoRun is disabled, locate and double-click Setup.exe, and then select Install 

Pro Tools to begin installation.
 

Before installing this version of Pro Tools, refer to the included Read Me information.

On Windows, if the User Account Control dialog appears, click Allow. Several messages 
are displayed during installation that can be ignored, including multiple “Found New 
Hardware” dialogs and “A Problem Occurred During Hardware Installation.” Additionally, 
if  you get a warning dialog about the driver not passing Windows Logo testing, click 
Continue Anyway.
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4 Follow the on-screen instructions to continue with installation.
5 At the Installation Type page, do one of the following:
• To install all Pro Tools application files and free plug-in suites (and associated content), leave 

the default Installation options selected and click Continue.
– or –

• Select (or deselect) a custom configuration of Installation options (see “Installation Options” 
on page 8) and click Continue.

6 Click Install.
7 If prompted, enter your Administrator password and click OK to authenticate the installation. 
8 Follow the remaining on-screen instructions. 
9 When installation is complete, click Restart (Mac) or Finish (Windows).

Installation Options
Pro Tools 10 Options

To install a subset of Pro Tools software and plug-ins, click the reveal triangle for the Pro Tools 

10 option in the installer, and deselect any of the following options that you do not want installed.
Application Files (Required for Pro Tools). Installs the Pro Tools application and supporting library 
files needed to run Pro Tools. This option must be selected to install Pro Tools.
Avid Effects. Installs free Avid Audio Effects plug-ins. For more information, see the Audio 
Plug-ins Guide.
Pro Tools Utilities. Installs Pro Tools utilities, such as DigiTest and Uninstall Pro Tools (Mac only).
Additional Options.

The Pro Tools installer provides the following additional options to install along with Pro Tools 
software and plug-ins.

The Pro Tools Installer disc includes additional software for your system. For more information, 
see “Additional Software on the Pro Tools Installer Disc” on page 13.
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Mac HFS+ Disk Support Option (Windows Only). This option lets your Pro Tools system read, write, 
record, and play back using Mac-formatted HFS+ disks. HFS+ disks are commonly referred 
to as Mac OS Extended disks. For more information, see the Pro Tools Reference Guide.
Avid Video Engine. The Avid Video Engine is required to use Pro Tools with Avid video peripherals 
such as the Avid Mojo® SDI. For more information, see the Avid Video Peripherals Guide.

Starting Up or Shutting Down Your System
To ensure that the components of your Pro Tools system communicate properly with each other, 
you need to start them in a particular order.

Start up your Pro Tools system in this order:

1 Make sure all your equipment (including your computer) is off.
2 Lower the volume of all output devices in your system. 
3 For systems with an expansion chassis, turn on the chassis.
4 Turn on any external hard drives. Wait ten seconds for them to spin up to speed.
5 Turn on any control surfaces.
6 Turn on any MIDI interfaces and devices, or synchronization peripherals.
7 For systems requiring external power, then turn on the hardware (such as HD I/O or 003). 
Wait at least fifteen seconds for the audio interface to initialize and the status LEDs to stop 
flashing.
8 Turn on your computer. 
9 Launch Pro Tools (see “Launching Pro Tools” on page 12) or any third-party audio or MIDI 
applications. 
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Shut down your Pro Tools system in this order:

1 Quit Pro Tools and any other running applications. 

2 Turn off or lower the volume of all output devices in your system. 
3 Turn off your computer.
4 For systems that use hardware requiring external power, turn off the hardware.
5 Turn off your Pro Tools audio interfaces.
6 For systems with an expansion chassis, turn off the chassis.
7 Turn off any MIDI interfaces, MIDI devices, or synchronization peripherals.
8 Turn off any control surfaces or worksurfaces.
9 Turn off any external hard drives.

Installing Avid Virtual Instruments
Avid provides a suite of free virtual instrument plug-ins with related sample content for use 
with Pro Tools. For more information, see the Audio Plug-ins Guide.

To install Avid Virtual Instruments:

1 Make sure you are logged in as an Administrator for the account where you want to install 
Avid Virtual Instruments. 
2 Do one of the following:
• Insert the Pro Tools Installer disc in your DVD drive. 

– or –
• Download the Avid Virtual Instruments installer and related content online.

To quit Pro Tools, choose Pro Tools > Quit (Mac) or File > Exit (Windows).
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3 Do one of the following:
• On Mac, locate and double-click Install Avid Virtual Instruments.mpkg.
• On Windows, do one of the following:

• When installing from disc, if Windows AutoRun is enabled, a mini-browser appears. Select 
Install Avid Virtual Instruments to begin installation. 

• When installing from disc, if Windows AutoRun is disabled, locate and double-click Setup.exe, 
and then select Install Avid Virtual Instruments to begin installation.

• If you downloaded the Avid Virtual Instruments installer, run Avid Virtual Instruments.exe.

4 Follow the on-screen instructions to continue with installation.
5 Click Install.

6 If prompted, enter your Administrator password and click OK to authenticate the installation.
7 Follow the remaining on-screen instructions.
8 When installation is complete, click Close (Mac) or Finish (Windows).

Virtual Instrument content is very large and may take up to 20 minutes to install. During 
this time, the progress bar may not appear to move but your software is still installing. Do 
not terminate your installation.
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Launching Pro Tools
To use Pro Tools software, you must have an iLok with a license authorizing the version of 
Pro Tools that you have installed (for more information, see “Authorizing Pro Tools” on page 3).

To launch Pro Tools software:

1 Make sure your audio interface is connected to your computer and powered on.
2 Insert an authorized iLok into any available USB port on your computer (see “Authorizing 
Pro Tools” on page 3).

3 Do one of the following:
• On Mac, click the Pro Tools shortcut in your Dock (or double-click the application icon in 

Macintosh HD/Applications/Avid/Pro Tools).
– or –

• On Windows, double-click the Pro Tools shortcut on your desktop (or the application in 
Program Files\Avid\Pro Tools).

4 Use the Quick Start dialog to do one of the following:
• Create a new session from a template.

• Create a new blank session.

• Open any other session on your system.

Do not remove the iLok during Pro Tools launch or use.

For more information about the Quick Start dialog and session templates, see the Pro Tools 
Reference Guide.
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Configuring Your Pro Tools System
After you have installed, authorized, and launched Pro Tools software, you can configure 
your Pro Tools system to meet the specific needs of your studio. For detailed information on 
configuring your Pro Tools software, see the Pro Tools Reference Guide  (which is available 
from the Help menu in Pro Tools).

Additional Software on the Pro Tools Installer Disc
The Pro Tools Installer disc provides additional documentation and software for your Pro Tools 
system in the Additional Files folder.

Documentation
The Documentation folder contains PDF documentation for Pro Tools software, hardware, 
plug-ins, and options.

Tech Support
The Tech Support folder contains PDF documentation, information about online resources, 
and Pro Tools sessions for troubleshooting your Pro Tools system.

Optional Installers
The Optional Installers folder contains installers for Pro Tools software options that can be 
purchased and authorized separately.

HEAT
(Avid HDX and Pro Tools|HD Systems Only)

HEAT (Harmonically Enhanced Algorithm Technology) is a paid software option that adds 
“analog color” to Pro Tools HD with Avid HDX and Pro Tools|HD systems. For more information, 
see the HEAT Software Option Guide.
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Pro Tools Demo Session
The Pro Tools Installer disc includes a demo session that you can use to verify that your system 
is working correctly.

To install the demo session:

1 Insert the Pro Tools Installer disc into your DVD drive.
2 On the Pro Tools Installer disc, locate and open the Additional Files folder.
3 Copy the Pro Tools Demo Session folder to a valid audio drive.
4 Open the demo session.

Uninstalling Pro Tools
If you need to remove Pro Tools software from your computer, use the Uninstaller application 
on Mac or use the Programs Control Panel on Windows. 

Uninstalling Pro Tools on Mac

To uninstall Pro Tools on Mac:

1 Make sure you are logged in as an Administrator for the account where Pro Tools is installed. 
2 Go to Applications/Avid/Pro Tools/Pro Tools Utilities and double-click Uninstall Pro Tools.
3 Click Continue to proceed with the uninstallation.
4 Choose the type of uninstall you want to perform:
Safe Uninstall. Leaves certain plug-ins and system files needed for compatibility with some 
Avid products. Use Safe Uninstall if you are using an Avid application or preparing to update 
to a CS (customer support) release.
Clean Uninstall. Removes all Pro Tools files, including system files, Avid plug-ins, and MIDI 
patch names. Use Clean Uninstall whenever you are preparing to upgrade, or to troubleshoot 
from a clean system.
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5 Click Uninstall. 
6 Enter your Administrator password and click OK. 
7 Click Finish to close the Installer window.

Uninstalling Pro Tools on Windows
To uninstall Pro Tools on Windows:

1 Choose Start > Control Panel.
2 Click Programs and Features. 

3 Click Uninstall a program.

4 Select Avid Pro Tools from the list of installed applications.
5 Click Uninstall.
6 Follow the on-screen instructions to remove Pro Tools.

Note that you will have to uninstall plug-ins (such as Avid Effects), as well as any audio 
and MIDI device drivers separately.
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Optimizing a Mac System for Pro Tools
To ensure optimum performance with Pro Tools, configure your computer first.

Before configuring your computer, make sure you are logged in as an Administrator for the 
account where you want to install Pro Tools. For details on Administrator privileges in Mac OS X, 
see your Apple OS X documentation. 

Turning Off Software Update
To turn off the Software Update feature:

1 Choose System Preferences from the Apple menu.
2 Click Software Update.
3 Click the Scheduled Check tab. 
4 Deselect Check for updates.

5 When you are done, choose System Preferences > Quit System Preferences.

Turning Off Energy Saver
To turn off the Energy Saver feature:

1 Choose System Preferences from the Apple menu.
2 Click Energy Saver.
3 Set the Computer Sleep setting to Never.
4 Set the Display Sleep setting to Never.
5 Deselect “Put the hard disk(s) to sleep when possible” option.
6 When you are done, choose System Preferences > Quit System Preferences.

Do not use the Mac OS X automatic Software Update feature, as it may upgrade your system 
to a version of Mac OS that has not yet been qualified for Pro Tools. For details on qualified 
versions of Mac OS, see the latest compatibility information on our website (www.avid.com).
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Disable or Reassign Mac Keyboard Shortcuts Used by Pro Tools
To have the full complement of Pro Tools keyboard shortcuts, you need to disable or reassign 
conflicting Mac OS X Keyboard Shortcuts in the Apple System Preferences.

To disable or reassign Mac keyboard shortcuts used by Pro Tools (Mac OS X Lion):

1 From the Apple menu, choose System Preferences.
2 Click Keyboard.
3 Click the Keyboard Shortcuts tab.
4 You can disable or reassign Mac OS keyboard shortcuts that conflict with Pro Tools keyboard 
shortcuts. The following list includes several common Mac keyboard shortcuts that, depending 
on the make and model of your Mac, may also used by Pro Tools:
• Under “Launchpad & Dock”

• “Turn Dock Hiding On/Off ”
• Under “Mission Control”

• “Mission Control”

• “Application windows”

• “Show Desktop”

• “Show Dashboard”

• “Mission Control > Move left a space”

• “Mission Control > Move right a space”

• “Mission Control > Switch to Desktop n”

For a complete list of Pro Tools keyboard shortcuts, see the Keyboard Shortcuts Guide (Help > 
Keyboard Shortcuts).
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• Under “Keyboard & Text Input”
• “Move focus to the window drawer”

• Under “Services”
• “Send File To Bluetooth Device”

• “Search With Google”

• “Spotlight”

• “Search Man Pages in Terminal”
• Under “Spotlight”

• “Show Spotlight search field”

• “Show Spotlight window”
• Under “Universal Access”

• “Zoom”

• “Contrast”
• Under “Application Shortcuts”

• “Show Help menu”

To disable or reassign Mac keyboard shortcuts used by Pro Tools (Mac OS X Snow Leopard):

1 From the Apple menu, choose System Preferences.
2 Click Keyboard.
3 Click the Keyboard Shortcuts tab.
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4 You can disable or reassign Mac OS keyboard shortcuts that conflict with Pro Tools keyboard 
shortcuts. The following list includes several common Mac keyboard shortcuts that are also 
used by Pro Tools:
• Under “Dashboard & Dock”

• “Turn Dock Hiding On/Off ”

• “Dashboard”
• Under “Exposé and Spaces”

• “All windows”

• “Application windows”

• “Desktop”
• Under “Keyboard & Text Input”

• “Move focus to the window drawer”
• Under “Spotlight”

• “Show Spotlight search field” 

• “Show Spotlight window”
• Under “Application Shortcuts”

• “Show Help menu”

Disabling Spotlight Indexing
The Mac OS X Spotlight feature automatically indexes files and folders on local hard drives in 
the background. In most cases, this is not a concern for normal Pro Tools operation. However, 
if Spotlight starts indexing drives while recording in a Pro Tools session with high track counts 
for an extended period of time, it can adversely affect Pro Tools system performance. You may 
want to disable Spotlight indexing for all local drives before using Pro Tools for big recording 
projects.

Disabling Spotlight indexing also disables the Find function in Mac OS X. 
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To disable Spotlight indexing:

1 Choose System Preferences from the Apple menu and click Spotlight. 

2 In the Spotlight window, click the Privacy tab.
3 To prevent indexing of a drive, drag its icon from the desktop into the list.

Enabling Journaling for Audio Drives
To yield higher performance from audio drives, enable journaling.

To enable journaling:

1 Launch the Disk Utility application, located in Applications/Utilities.
2 Select the volume in the left column of the Disk Utility window.
3 Select Enable Journaling in the toolbar.

Optimizing a Windows System for Pro Tools
To ensure optimum performance with Pro Tools, configure your computer before using Pro Tools 
hardware and software.

Before configuring your computer, make sure you are logged in as an Administrator for the 
account where you want to install Pro Tools. For details on Administrator privileges, see your 
Windows documentation.

For the latest information about Windows system settings and for information about specific 
computers, visit the Avid website (www.avid.com).
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Required Optimizations
To ensure optimum performance with Pro Tools, configure the following settings before using 
Pro Tools hardware and software.

Disabling User Account Control

To disable User Account Control (UAC):

1 Choose Start > Control Panel.
2 Click User Accounts and Family Safety.
3 Click User Accounts.
4 Click on Change User Account Control settings.
5 Set the slider to Never Notify.
6 Click OK.

Configuring System Standby and Power Management
When using Pro Tools, the Windows System Standby power scheme must be set to Always On.  
This prevents long record or playback passes from stopping due to system resources powering 
down. 

To configure Windows Power Management:

1 Choose Start > Control Panel.
2 Click on System and Security.
3 Click Power Options.
4 Click on the arrow to Show Additional Plans.
5 Select High Performance.
6 Click Change plan settings.

When you are finished changing Windows system settings, restart your computer.
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7 Click Change advanced power settings.
8 In the Power Options dialog, reveal Hard disk > Turn off hard disk after.
9 Click Setting option.
10 Select the value in the Setting (Minutes) field and press Backspace on your computer 
keyboard or scroll the value to Never.
11 Click OK. The hard disk setting changes to Never and the Power Options dialog closes.
12 In the Edit Plan Settings window, click Save changes and close the window.

Recommended Optimizations
Pro Tools can also be affected by other software and hardware drivers installed on your computer. 
For best possible performance, it is recommended (but not required) that you do the following:

• Avoid running any unneeded programs at the same time as Pro Tools.

• Turn off any software utilities that run in the background, such as Windows Messenger, 
calendars, and disk maintenance programs. 

• Turn off any non-essential USB devices while running Pro Tools.

Pro Tools automatically switches to the “High Performance” Power Management settings on 
launch. Windows reverts to the previously selected Power Management settings (if different) 
when exiting Pro Tools. Consequently, when optimizing the Power Management settings 
for Pro Tools, you should always only optimize the High Performance configuration.
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Optional Optimizations
The following system optimizations may help Pro Tools perform better on some systems. It is 
recommended that you only try these optimizations if necessary, as they may disable or adversely 
affect the functionality of other programs on your system.

Adjusting Processor Scheduling

To adjust Processor Scheduling performance:

1 Right-click Computer and choose Properties.
2 Click Advanced system settings.
3 Under the Performance section, click the Settings button.
4 In the Performance Options window, click the Advanced tab.
5 Under the Processor Scheduling section, select the Background Services option.
6 Click OK to close the Performance Options window.
7 Click OK to close the System Properties window.

Disabling System Startup Items
The fewer items in use by your computer, the more resources are available for Pro Tools. Some 
startup applications may be consuming unnecessary CPU resources, and can be turned off. 

If you disable any of the following startup items, do so carefully :
• Portable media serial number (required for some applications that utilize a copy protection 

key)

• The Plug and Play service

• Event log

• Cryptographic services
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To Disable System Startup Items:

1 From the Start menu, type “msconfig” in Start Search and press Enter to open the System 
Configuration Utility.
2 Under the General tab, choose Selective Startup.
3 Deselect Load Startup Items and click OK.
4 Click Restart to restart the computer.
5 After restarting, the computer displays a System Configuration message. Check to see if 
Pro Tools performance has increased before you deselect the “Don't show this message again” 
option. If performance has not changed, run “msconfig” and return your computer Startup 
Selection back to Normal Startup - load all device drives and services. Alternatively, try disabling 
Startup items and non-essential processes individually.

Backing Up Your System
After setting up your system and installing Pro Tools, you should save an image of your system 
drive using a backup utility. By doing this, you can quickly restore your system configuration 
and settings if you encounter any problems.
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Installation du logiciel Pro Tools
Bienvenue dans le logiciel Avid Pro Tools®.  Ce guide présente les procédures d'installation 
et d'autorisation du logiciel Pro Tools sur les systèmes Mac et Windows. Pour obtenir des 
informations détaillées et exhaustives sur la configuration, les fonctionnalités et possibilités 
de votre système Pro Tools, reportez-vous au Guide de référence Pro Tools  (accessible à partir 
du menu Help de Pro Tools).

Il existe quatre types de systèmes Pro Tools :
Logiciel Pro Tools

Ces systèmes incluent le logiciel Pro Tools et une interface audio de la famille Avid 003™ ou 
Digi 002®, Eleven® Rack, Mbox® ou Mbox 2, ou du matériel M-Audio. Sont également qualifiés 
les systèmes composés du logiciel Pro Tools et d'interfaces audio tierces fonctionnant avec 
des pilotes Core Audio (Mac, y compris système audio intégré des ordinateurs Mac) ou ASIO 
(Windows) pris en charge.
Logiciel Pro Tools HD avec accélération matérielle

Systèmes composés du logiciel Pro Tools HD et de matériel Avid HDX, Pro Tools|HD ou HD 
Native. Les systèmes à accélération matérielle fournissent des capacités d'E/S étendues et 
permettent un monitoring à faible latence. Le logiciel Pro Tools HD associé à du matériel 
Avid HDX ou Pro Tools|HD intègre également des DSP dédiés pour les traitements de plug-in 
et les configurations de mixage les plus importantes.
Logiciel Pro Tools HD ou Pro Tools avec Complete Production Toolkit

Ces systèmes incluent le logiciel Pro Tools HD ou Pro Tools avec l'option Complete Production 
Toolkit et tout matériel Avid, Core Audio ou ASIO compatible. 
Logiciel Pro Tools Express

Ces systèmes incluent le logiciel Pro Tools Express et une interface audio de la famille Mbox 
(3e génération). Pour plus d'informations, consultez le Guide d'installation de Pro Tools Express.

Pour consulter la liste des interfaces audio et  ordinateurs qualifiés avec l 'ensemble des 
systèmes Pro Tools, rendez-vous sur www.avid.com/compatibility. 
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Configuration requise et compatibilité
Pro Tools peut être utilisé avec une interface audio qualifiée et sur un ordinateur Windows ou 
Mac, lui aussi qualifié.

Un lecteur DVD est requis pour l 'utilisation du disque d'installation de Pro Tools.

Une connexion Internet est nécessaire pour le téléchargement du programme d'installation de 
Pro Tools.

Avid ne peut assurer une compatibilité des produits et fournir une assistance que pour les 
matériels et les logiciels testés et approuvés par ses soins. 

Pour connaître la configuration requise et consulter la liste exhaustive des ordinateurs, systèmes 
d'exploitation, disques durs et périphériques tiers pris en charge, rendez-vous sur :

www.avid.com/compatibility

Autorisation iLok
Le package logiciel Pro Tools standard comprend une clé iLok sur laquelle est stockée 
l'autorisation de votre copie du logiciel Pro Tools. Les packages matériels Pro Tools contiennent 
une clé iLok ne contenant aucune autorisation et un code d'activation pour l 'autorisation de 
votre logiciel Pro Tools. Pour plus d'informations, reportez-vous à la section « Autorisation 
de Pro Tools »  à la page 27.

Configuration MIDI requise
Les interfaces USB, FireWire et MIDI PCI fonctionnent de manière optimale avec les systèmes 
Pro Tools sous Mac ou Windows. Les interfaces MIDI série sont prises en charge sur les systèmes 
Windows uniquement.

Une clé iLok contenant l'autorisation du logiciel Pro Tools doit être insérée dans un port 
USB disponible de votre ordinateur afin de pouvoir lancer l'application.

Pour obtenir la liste des interfaces et contrôleurs MIDI compatibles, rendez-vous sur 
www.avid.com
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Configuration requise des disques durs
Pour une qualité d'enregistrement et de lecture audio optimale, tous les systèmes Pro Tools 
nécessitent l'utilisation d'un ou plusieurs disques durs qualifiés. 

Formatez vos disques durs à l'aide de l'application Utilitaire de disque incluse dans vos logiciels 
système Apple (Mac) ou du Gestionnaire de disques de Windows.

Enregistrement déconseillé sur le disque système
L'enregistrement audio sur votre disque système est possible, mais déconseillé. Les disques 
durs système affichent parfois des performances inférieures en enregistrement et en lecture, 
ce qui se traduit par un nombre inférieur de pistes et de plug-ins exploitables.

Autorisation de Pro Tools
L'autorisation du logiciel Pro Tools est activée à l'aide de la clé USB iLok Smart Key (ci-après 
iLok) de PACE Anti-Piracy. La clé peut stocker des centaines d'autorisations pour l'ensemble 
de vos logiciels activés par iLok. Lorsque l'autorisation d'un logiciel spécifique a été transférée 
sur une clé iLok, vous pouvez l'utiliser sur n'importe quel ordinateur sur lequel le logiciel est 
installé.

L'utilitaire DigiBase permet de désigner le disque système comme disque de lecture ou de 
transfert uniquement et ainsi d'obtenir des performances optimales. Pour plus d'informations, 
consultez le Guide de référence Pro Tools.

Clé USB iLok

Vous pouvez utiliser la nouvelle version de la clé iLok (représentée ci-dessus) ou sa version 
précédente pour conserver vos autorisations Pro Tools.
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Autorisation de Pro Tools HD
Une autorisation Pro Tools HD permet d'exploiter le logiciel Pro Tools HD sur un ordinateur 
Mac ou Windows pris en charge, avec ou sans matériel Avid HDX, Pro Tools|HD ou HD Native. 
Elle permet également d'utiliser le logiciel Pro Tools HD avec une autre interface audio qualifiée 
par Avid telle qu'une Mbox Pro ou une Fast Track, ou toute autre interface audio tierce prenant 
en charge des pilotes Core Audio (Mac) ou ASIO (Windows).

Autorisation de Pro Tools
Une autorisation Pro Tools permet d'exploiter le logiciel Pro Tools sur un ordinateur Mac ou 
Windows pris en charge avec une interface audio qualifiée par Avid telle qu'une Mbox Pro ou 
une Fast Track, ou toute autre interface audio tierce prenant en charge des pilotes Core Audio 
(Mac) ou ASIO (Windows).

Autorisation du Complete Production Toolkit
Si vous possédez une autorisation pour le Complete Production Toolkit ainsi que pour Pro Tools, 
vous pouvez utiliser le logiciel Pro Tools ainsi que toutes les fonctionnalités du Complete 
Production Toolkit. L'option logicielle Complete Production Toolkit pour Pro Tools prend en 
charge un nombre supérieur de voix et de pistes et offre des fonctions de mixage surround, 
d'édition et d'automation comparables à celles de Pro Tools HD.

Une autorisation Pro Tools ne permet pas d'utiliser le logiciel Pro Tools HD. Si vous lancez 
le logiciel Pro Tools sur un système comprenant du matériel HDX, Pro Tools|HD ou HD 
Native sans autorisation Pro Tools HD, il s'ouvrira s'il peut utiliser le système audio intégré 
ou toute autre interface audio via un pilote Core Audio ou ASIO, mais il  ne pourra pas 
utiliser le matériel HDX, Pro Tools|HD ou HD Native installé.

Pour plus d'informations sur le Complete Production Toolkit, consultez le Guide Complete 
Production Toolkit ou le Guide de référence Pro Tools.
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Ajout d'une autorisation à une clé iLok à l'aide d'un code d'activation
Si vous avez acheté une version boîte neuve du logiciel Pro Tools, une clé iLok pré-autorisée 
est fournie. Vous pouvez ignorer cette section et passer à la section « Installation de Pro Tools »  
à la page 30.

Si vous avez acheté un nouveau système Avid HDX, Pro Tools|HD ou HD Native, une clé iLok 
vide est fournie avec un code d'activation (sur la carte d'activation incluse) pour l'autorisation 
du logiciel Pro Tools HD. Veuillez suivre les instructions ci-dessous.

Si vous effectuez une mise à niveau à partir d'une version antérieure du logiciel Pro Tools, un 
code d'activation est fourni (sur la carte d'activation incluse) pour l 'autorisation de votre 
mise à niveau. Veuillez suivre les instructions ci-dessous.

Pour utiliser le code d'activation de l'autorisation du logiciel Pro Tools :

1 Si vous ne possédez pas de compte iLok.com, rendez-vous sur www.iLok.com et créez un 
compte.
2 Pour transférer la licence de votre logiciel sur votre compte iLok.com, procédez comme suit :

• Rendez-vous sur www.avid.com/activationcard.

– et –
• Saisissez votre code d'activation (indiqué sur votre carte d'activation) et votre ID utilisateur 

iLok.com. Il s'agit du nom spécifié lors de la création de votre compte iLok.com.

3 Transférez les licences de votre compte iLok.com vers votre clé USB iLok Smart Key en 
procédant comme suit :

• Insérez la clé iLok dans un port USB disponible de votre ordinateur.

• Rendez-vous sur www.iLok.com et connectez-vous à votre compte.

• Suivez les instructions à l'écran pour transférer vos licences vers votre clé iLok.

Pour plus d'informations, consultez le site Web iLok (www.iLok.com).
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Installation de Pro Tools

Présentation de l'installation
L'installation de Pro Tools inclut les étapes suivantes :
1 « Installation des pilotes matériels »  à la page 30.
2 « Installation du logiciel Pro Tools »  à la page 31.
3 « Installation d'instruments virtuels Avid »  à la page 35 (facultative).
4 « Lancement de Pro Tools »  à la page 37.
5 Configuration de votre système pour l 'optimisation des performances (reportez-vous au 
Guide de référence Pro Tools).
6 Connexions audio à votre interface audio. Pour plus d'informations, reportez-vous à la 
documentation fournie avec votre interface audio.

Installation des pilotes matériels
Avant d'installer le logiciel Pro Tools, assurez-vous d'avoir installé votre matériel audio ainsi 
que les derniers pilotes pour vos périphériques. Pour plus d’informations, reportez-vous à la 
documentation fournie avec votre matériel. Pour les interfaces audio Avid, installez les pilotes 
requis en sélectionnant le programme d'installation correspondant sur le disque inclus dans 
le package d'installation de Pro Tools, ou rendez-vous sur le site www.avid.com/drivers pour 
télécharger et installer les derniers pilotes disponibles.

Pour effectuer une mise à niveau de Pro Tools, assurez-vous d'avoir au préalable désinstallé 
la version précédente du logiciel. Reportez-vous à la section « Désinstallation de Pro Tools »  
à la page 39.

Pour le matériel Avid HDX, Pro Tools|HD et HD Native uniquement, le programme 
d'installation de Pro Tools installe automatiquement les pilotes adéquats.
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Installation du logiciel Pro Tools
Après avoir installé les pilotes de votre interface audio, vous pouvez installer Pro Tools.

Pour installer Pro Tools :

1 Assurez-vous que vous êtes connecté en tant qu'administrateur pour le compte sur lequel 
vous souhaitez installer Pro Tools. 
2 Effectuez l'une des opérations suivantes :
• Insérez le disque d'installation de Pro Tools dans votre lecteur DVD. 

– ou –

• Téléchargez le programme d'installation de Pro Tools en ligne.
3 Effectuez l'une des opérations suivantes :
• Sur Mac, localisez et double-cliquez sur le fichier Install Pro Tools.mpkg.
• Sous Windows, effectuez l'une des opérations suivantes :

• Si l'exécution automatique est activée, une fenêtre apparaît. Sélectionnez Install Pro Tools 

pour commencer l'installation. 

– ou –

• Si l'exécution automatique est désactivée, naviguez jusqu'au fichier Setup.exe, puis double-
cliquez dessus et sélectionnez l'option Install Pro Tools pour lancer l'installation.

Pro Tools ne reconnaîtra pas votre interface audio si ses pilotes ne sont pas installés. Pour 
effectuer une mise à niveau de Pro Tools, assurez-vous d'avoir au préalable installé les 
pilotes matériels les plus récents.

Avant d'installer cette version de Pro Tools, consultez le fichier Lisez-moi inclus.
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4 Suivez les instructions à l'écran pour continuer la procédure d'installation.
5 Sur la page de choix du type d'installation, sélectionnez l'une des options suivantes :
• Pour installer tous les fichiers d'application Pro Tools et les suites de plug-ins gratuites (ainsi 

que le contenu associé), conservez les options d'installation par défaut et cliquez sur Continuer.
– ou –

• Sélectionnez (ou désélectionnez) les options d'installation pour personnaliser l'installation 
(reportez-vous à la section « Options d'installation »  à la page 33), puis cliquez sur Continuer.

6 Cliquez sur Installer.
7 Le cas échéant, saisissez votre mot de passe administrateur et cliquez sur OK  pour valider 
l'installation. 
8 Suivez les instructions à l'écran jusqu'à la fin de la procédure. 
9 Lorsque l'installation est terminée, cliquez sur Redémarrer (Mac) ou sur Terminer (Windows).

Sous Windows, si la boîte de dialogue Contrôle de compte utilisateur s'affiche, cliquez 
sur Autoriser. Plusieurs messages s 'affichent pendant l ' installation, comme les boîtes de 
dialogue « Nouveau matériel détecté » et « Un problème est survenu pendant l'installation 
du matériel ». Vous pouvez les ignorer. De plus, si un message d'avertissement indique que 
le pilote n'a pas été validé lors du test permettant d'obtenir le logo Windows, cliquez sur 
Continuer.

Le disque d'installation de Pro Tools contient des logiciels supplémentaires pour votre système. 
Pour plus d'informations, reportez-vous à la section « Logiciels supplémentaires du disque 
d'installation Pro Tools »  à la page 38.
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Options d'installation
Options Pro Tools 10

Pour installer un sous-ensemble de logiciels et plug-ins Pro Tools, cliquez sur le triangle en 
regard de l'option Pro Tools 10.0 du programme d'installation, puis, parmi les options suivantes, 
désélectionnez celles que vous ne souhaitez pas  installer.
Application Files (Required for Pro Tools) : installe l'application Pro Tools et les fichiers de 
bibliothèque annexes nécessaires pour exécuter Pro Tools. Cette option doit être cochée pour 
installer Pro Tools.
Avid Effects : installe les plug-ins d'effets audio Avid gratuits. Pour plus d'informations, 
consultez le Guide des plug-ins audio.
Pro Tools Utilities : installe les utilitaires Pro Tools, tels que DigiTest, et désinstalle Pro Tools 
(Mac uniquement).
Options supplémentaires

En plus du logiciel et des plug-ins Pro Tools, le programme d'installation de Pro Tools propose 
les options supplémentaires suivantes.
Mac HFS+ Disk Support Option (Windows uniquement) : cette option permet à votre système 
Pro Tools de lire et écrire des données, d'enregistrer et de lire de l'audio sur des disques Mac 
formatés en HFS+. Les disques HFS+ sont aussi souvent appelés disques Mac OS étendus. Pour 
plus d'informations, consultez le Guide de référence Pro Tools.
Avid Video Engine : le moteur vidéo Avid est requis pour utiliser Pro Tools avec des 
périphériques vidéo Avid tels que Avid Mojo® SDI. Pour plus d'informations, reportez-vous 
au Guide des périphériques vidéo Avid.
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Démarrage et arrêt du système
Pour que les différents composants de votre système Pro Tools puissent communiquer 
correctement entre eux, vous devez les mettre sous tension dans un ordre précis.

Démarrez votre système Pro Tools dans l'ordre suivant :

1 Assurez-vous que tous vos appareils (y compris votre ordinateur) sont éteints.
2 Baissez le volume de tous les périphériques de sortie du système. 
3 Pour les systèmes avec châssis d'extension, mettez ce dernier sous tension.
4 Mettez tous les disques durs externes sous tension. Patientez environ 10 secondes jusqu'à ce 
qu'ils aient atteint leur vitesse nominale.
5 Mettez vos surfaces de contrôle sous tension, le cas échéant.
6 Mettez les interfaces et périphériques MIDI, ou les périphériques de synchronisation sous 
tension.
7 Mettez sous tension le matériel fonctionnant sur une source d'alimentation externe (interface 
HD I/O ou 003 par exemple). Patientez au moins pendant quinze secondes (durée d'initialisation 
de l'interface audio). Les LED d'état cessent de clignoter.
8 Mettez l'ordinateur sous tension. 
9 Lancez Pro Tools (reportez-vous à la section « Lancement de Pro Tools »  à la page 37) ou 
toute autre application tierce audio ou MIDI. 

Arrêtez votre système Pro Tools dans l'ordre suivant :

1 Quittez Pro Tools et toutes les autres applications ouvertes. 

2 Baissez le volume de tous les périphériques de sortie du système. 
3 Mettez votre ordinateur hors tension.

Pour quitter Pro Tools, sélectionnez Pro Tools > Quit (Mac) ou File > Exit (Windows).
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4 Mettez hors tension le matériel fonctionnant sur une source d'alimentation externe, pour les 
systèmes concernés.
5 Éteignez toutes les interfaces audio Pro Tools.
6 Pour les systèmes avec châssis d'extension, mettez ce dernier sous tension.
7 Mettez hors tension les interfaces et périphériques MIDI ou les périphériques de 
synchronisation.
8 Mettez hors tension les éventuelles surfaces de contrôle ou de travail.
9 Mettez hors tension les disques durs externes.

Installation d'instruments virtuels Avid
Avid fournit une suite de plug-ins d'instruments virtuels gratuits avec les samples associés, 
destinée à Pro Tools. Pour plus d'informations, consultez le Guide des plug-ins audio.

Pour installer les instruments virtuels Avid :

1 Assurez-vous que vous êtes connecté en tant qu'administrateur pour le compte sur lequel 
vous souhaitez installer les instruments virtuels Avid. 
2 Effectuez l'une des opérations suivantes :
• Insérez le disque d'installation de Pro Tools dans votre lecteur DVD. 

– ou –

• Téléchargez le programme d'installation des instruments virtuels Avid et du contenu associé 
en ligne.
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3 Effectuez l'une des opérations suivantes :
• Sur Mac, localisez et double-cliquez sur le fichier Install Avid Virtual Instruments.mpkg.
• Sous Windows, effectuez l'une des opérations suivantes :

• Pour une installation à partir d'un disque, une fenêtre s'ouvre si la fonction d'exécution 
automatique de Windows est activée. Sélectionnez Install Avid Virtual Instruments pour 
commencer l'installation. 

• Pour une installation à partir d'un disque et si l 'exécution automatique de Windows est 
désactivée, naviguez jusqu'au fichier Setup.exe, puis double-cliquez dessus et sélectionnez 
l 'option Install Avid Virtual Instruments pour lancer l'installation.

• Si vous avez téléchargé le programme d'installation des instruments virtuels Avid, ouvrez 
le fichier Avid Virtual Instruments.exe.

4 Suivez les instructions à l'écran pour continuer la procédure d'installation.
5 Cliquez sur Installer.

6 Le cas échéant, saisissez votre mot de passe administrateur et cliquez sur OK pour valider 
l'installation.
7 Suivez les instructions à l'écran jusqu'à la fin de la procédure.
8 Lorsque l'installation est terminée, cliquez sur Fermer (Mac) ou sur Terminer (Windows).

La taille du contenu associé aux instruments virtuels est très importante et son installation 
peut prendre jusqu'à vingt minutes. Pendant ce temps, l'installation du logiciel progresse, 
même si la barre de progression ne semble pas l 'indiquer. Ne quittez pas la procédure 
d'installation.
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Lancement de Pro Tools
Pour utiliser le logiciel Pro Tools, vous devez disposer d'une clé iLok contenant une licence 
d'autorisation pour la version de Pro Tools que vous avez installée (pour plus d'informations, 
reportez-vous à la section « Autorisation de Pro Tools »  à la page 27).

Pour lancer le logiciel Pro Tools :

1 Vérifiez que votre interface audio est bien connectée à votre ordinateur et sous tension.
2 Insérez une clé iLok autorisée dans un port USB disponible de votre ordinateur (reportez-vous 
à la section « Autorisation de Pro Tools »  à la page 27).

3 Effectuez l'une des opérations suivantes :
• Sur Mac, cliquez sur le raccourci Pro Tools du Dock ou double-cliquez sur l ' icône de 

l 'application sous Macintosh HD/Applications/Avid/Pro Tools.
– ou –

• Sous Windows, double-cliquez sur le raccourci Pro Tools du bureau ou sur l'application située 
dans le dossier Programmes\Avid\Pro Tools.

4 Utilisez la boîte de dialogue Quick Start pour effectuer l'une des opérations suivantes :
• Créer une nouvelle session à partir d'un modèle.

• Créer une nouvelle session vierge.

• Ouvrir une autre session présente sur votre système.

Ne débranchez pas la clé iLok lors de l'ouverture ou de l'utilisation de Pro Tools.

Pour plus d'informations sur la boîte de dialogue Quick Start et les modèles de session, 
consultez le Guide de référence Pro Tools.
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Configuration de votre système Pro Tools
Une fois que vous avez installé, autorisé et ouvert le logiciel Pro Tools, vous pouvez configurer 
votre système pour répondre aux besoins spécifiques de votre studio. Pour obtenir des 
informations supplémentaires sur la configuration du logiciel Pro Tools, reportez-vous au 
Guide de référence Pro Tools (disponible à partir du menu Help de Pro Tools).

Logiciels supplémentaires du disque d'installation Pro Tools
Le disque d'installation de Pro Tools fournit de la documentation et des logiciels supplémentaires 
pour votre système Pro Tools, disponibles dans le dossier Additional Files.

Documentation
Le dossier Documentation contient des documents au format PDF concernant le logiciel, le 
matériel, les plug-ins et les options de Pro Tools.

Tech Support
Le dossier Tech Support contient de la documentation au format PDF, des informations sur 
les ressources disponibles en ligne et sur les sessions Pro Tools de dépannage de votre système.

Optional Installers
Le dossier Optional Installers contient des programmes d'installation d'options logicielles de 
Pro Tools que vous pouvez acheter et autoriser séparément.

HEAT
(systèmes Avid HDX et Pro Tools|HD uniquement)

HEAT (Harmonically Enhanced Algorithm Technology) est une option logicielle payante 
pour Pro Tools HD qui ajoute une « couleur analogique » au son des systèmes Avid HDX et 
Pro Tools|HD. Pour plus d'informations, reportez-vous au Guide de l'option logicielle HEAT.
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Session de démonstration Pro Tools
Le disque d'installation de Pro Tools contient une session de démonstration permettant de 
vérifier le bon fonctionnement de votre système.

Pour installer la session de démonstration :

1 Insérez le disque d'installation de Pro Tools dans votre lecteur DVD.
2 Sur le disque d'installation de Pro Tools, localisez et ouvrez le dossier Additional Files.
3 Copiez le dossier de la session de démonstration Pro Tools sur un lecteur audio valide
4 Ouvrez la session de démonstration.

Désinstallation de Pro Tools
Si vous souhaitez désinstaller le logiciel Pro Tools de votre ordinateur, utilisez l'application 
de désinstallation sur Mac ou l'utilitaire Désinstaller ou modifier un programme de Windows. 

Désinstallation de Pro Tools sur Mac

Pour désinstaller Pro Tools sur Mac :

1 Assurez-vous que vous êtes connecté en tant qu'administrateur au compte sur lequel Pro Tools 
est installé.  
2 Accédez à l'emplacement Applications/Avid/Pro Tools/Pro Tools Utilities, puis double-cliquez 
sur le fichier Uninstall Pro Tools.
3 Cliquez sur Continuer pour initier la procédure de désinstallation.
4 Sélectionnez le type de désinstallation à effectuer :
Safe Uninstall : conserve des fichiers système et de plug-in requis pour la compatibilité avec 
certains produits Avid. Optez pour cette désinstallation partielle si vous utilisez une application 
Avid ou effectuez une mise à jour vers une version CS (service clients).
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Clean Uninstall : supprime tous les fichiers Pro Tools, y compris les fichiers système, les plug-ins 
Avid et les noms de patch MIDI. Optez pour cette désinstallation complète si vous effectuez une 
mise à niveau ou souhaitez corriger des problèmes en repartant d'un système propre.
5 Cliquez sur Désinstaller. 
6 Entrez le mot de passe administrateur, puis cliquez sur OK. 
7 Cliquez sur Terminer pour fermer la fenêtre du programme d'installation.

Désinstallation de Pro Tools sous Windows

Pour désinstaller Pro Tools sous Windows :

1 Sélectionnez Démarrer > Panneau de configuration.
2 Cliquez sur Programmes et fonctionnalités. 

3 Cliquez sur Désinstaller un programme.

4 Sélectionnez Avid Pro Tools dans la liste des applications installées.
5 Cliquez sur Désinstaller.
6 Suivez les instructions à l'écran pour désinstaller Pro Tools.

Notez que vous devrez désinstaller séparément les plug-ins, tels que les effets Avid, ainsi 
que tous les pilotes audio et MIDI.
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Optimisation d'un système Mac pour Pro Tools
Pour garantir des performances optimales avec Pro Tools, commencez par configurer votre 
ordinateur.
Avant de configurer votre ordinateur, assurez-vous que vous êtes connecté en tant 
qu'administrateur pour le compte sur lequel vous souhaitez installer Pro Tools. Pour obtenir des 
détails sur les privilèges d'administrateur sous Mac OS X, reportez-vous à votre documentation 
Apple OS X. 

Désactivation de la mise à jour logicielle

Pour désactiver la fonction de mise à jour logicielle :

1 Dans le menu Pomme, sélectionnez Préférences Système.
2 Cliquez sur Mise à jour de logiciels.
3 Cliquez sur l'onglet Planification des vérifications. 
4 Désélectionnez l'option Rechercher les mises à jour.

5 Ensuite, sélectionnez Préférences Système > Quitter les Préférences Système.
Désactivation de l'économiseur d'énergie

Pour désactiver l'économiseur d'énergie :

1 Dans le menu Pomme, sélectionnez Préférences Système.
2 Cliquez sur Économiseur d'énergie.
3 Définissez le Mode de veille sur Jamais.
4 Définissez le paramètre de Veille d'affichage sur Jamais.
5 Désélectionnez Suspendre dès que possible l'activité du ou des disques durs.
6 Ensuite, sélectionnez Préférences Système > Quitter les Préférences Système.

N'utilisez pas la fonction de mise à jour logicielle automatique de Mac OS X, car cela peut 
entraîner une mise à jour de votre système avec une version de Mac OS qui n'a pas été 
qualifiée pour Pro Tools. Pour plus de détails sur les versions de Mac OS qualifiées, reportez-
vous aux informations de compatibilité accessibles sur notre site Web (www.avid.com).
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Désactivation ou réassignation des raccourcis clavier Mac utilisés par 
Pro Tools
Pour exploiter tous les raccourcis clavier que propose Pro Tools,  vous devez désactiver ou 
réassigner les éventuels raccourcis clavier Mac OS X en conflit dans les préférences système 
Apple.

Pour désactiver ou réassigner les raccourcis clavier Mac utilisés par Pro Tools (Mac OS X Lion) :

1 Dans le menu Pomme, sélectionnez Préférences Système.
2 Cliquez sur Clavier.
3 Cliquez sur l'onglet Raccourcis clavier.
4 Vous pouvez désactiver ou réassigner les raccourcis clavier Mac OS en conflit avec ceux de 
Pro Tools. La liste suivante répertorie plusieurs raccourcis clavier Mac courants qui peuvent 
également être utilisés par Pro Tools, en fonction du modèle et de la configuration de votre Mac :
• Sous « Launchpad et Dock »

• « Activer/désactiver le masquage du Dock »
• Sous « Mission Control »

• « Mission Control »

• « Fenêtres d'applications »

• « Afficher le bureau »

• « Afficher le Dashboard »

• « Mission Control > Déplacer d'un espace vers la gauche »

• « Mission Control > Déplacer d'un espace vers la droite »

• « Mission Control > Passer au Bureau n »

Pour obtenir une liste complète des raccourcis clavier Pro Tools, reportez-vous au Guide des 
raccourcis clavier (Help > Keyboard Shortcuts).
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• Sous « Saisie de texte »
• « Déplacer le focus sur le volet de la fenêtre »

• Sous « Services »
• « Envoyer le fichier vers un appareil Bluetooth »
• « Rechercher avec Google »
• « Spotlight »
• « Rechercher dans les pages de manuels »

• Sous « Spotlight »
• « Afficher le champ de recherche Spotlight »
• « Afficher la fenêtre Spotlight »

• Sous « Accès universel »
• « Zoom »
• « Contraste »

• Sous « Raccourcis d'applications »
• « Afficher le menu Aide »

Pour désactiver ou réassigner les raccourcis clavier Mac utilisés par Pro Tools (Mac OS X Snow 
Leopard) :

1 Dans le menu Pomme, sélectionnez Préférences Système.
2 Cliquez sur Clavier.
3 Cliquez sur l'onglet Raccourcis clavier.
4 Vous pouvez désactiver ou réassigner les raccourcis clavier Mac OS en conflit avec ceux 
de Pro Tools.  La liste suivante répertorie plusieurs raccourcis clavier Mac courants qui sont 
également utilisés par Pro Tools :
• Sous « Dashboard et Dock »

• « Activer/désactiver le masquage du Dock »
• « Dashboard »
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• Sous « Exposé et Spaces »
• « Toutes les fenêtres »

• « Fenêtres d'applications »

• « Bureau »
• Sous « Saisie de texte »

• « Déplacer le focus sur le volet de la fenêtre »
• Sous « Spotlight »

• « Afficher le champ de recherche Spotlight » 

• « Afficher la fenêtre Spotlight »
• Sous « Raccourcis d'applications »

• « Afficher le menu Aide »

Désactivation de l'indexation Spotlight
La fonction Spotlight de Mac OS X indexe automatiquement les fichiers et dossiers des disques 
durs locaux en arrière-plan. Dans la plupart des cas, cela ne perturbe pas le fonctionnement 
de Pro Tools ; cependant, si Spotlight lance l'indexation des disques durs lors d'un enregistrement 
dans une session Pro Tools comportant un nombre de piste élevé, les performances du système 
Pro Tools peuvent être affectées. Pour les projets d'enregistrement Pro Tools les plus importants, 
il est conseillé de désactiver l'indexation Spotlight pour tous les disques locaux.

Pour désactiver l'indexation Spotlight :

1 Dans le menu Pomme, sélectionnez Préférences Système,  puis cliquez sur Spotlight .
2 Dans la fenêtre Spotlight, cliquez sur l'onglet Confidentialité.
3 Faites glisser l'icône du disque que vous ne souhaitez pas indexer du bureau vers la liste.

Notez que cela désactivera également la fonction Rechercher de Mac OS X. 
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Activation de la journalisation des lecteurs audio
Les performances des lecteurs audio peuvent être améliorées en activant la journalisation.

Pour activer la journalisation :

1 Dans le dossier Applications/Utilitaires, démarrez l 'application Utilitaire de disque.
2 Sélectionnez le volume dans la colonne de gauche de la fenêtre Utilitaire de disque.
3 Sélectionnez Activer la journalisation dans la barre d'outils.

Optimisation d'un système Windows pour Pro Tools
Pour des performances optimales avec Pro Tools, configurez votre ordinateur avant d'utiliser 
le matériel et le logiciel Pro Tools.

Avant de configurer votre ordinateur, assurez-vous que vous êtes connecté en tant 
qu'administrateur pour le compte sur lequel vous souhaitez installer Pro Tools. Pour tout 
renseignement complémentaire sur les privilèges d'administrateur, reportez-vous à votre 
documentation Windows.

Optimisations nécessaires
Pour garantir des performances optimales, configurez les paramètres suivants avant d'utiliser 
le logiciel Pro Tools.

Pour accéder aux informations les plus récentes sur le paramétrage des systèmes Windows 
et sur la configuration d'ordinateurs spécifiques, rendez-vous sur le site Web Avid 
(www.avid.com).

Redémarrez votre ordinateur après avoir modifié les paramètres système de Windows.
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Désactivation du contrôle de compte d'utilisateur

Pour désactiver le contrôle de compte d'utilisateur :

1 Sélectionnez Démarrer > Panneau de configuration.
2 Cliquez sur Comptes et protection des utilisateurs.
3 Cliquez sur Comptes d’utilisateur.
4 Cliquez sur Modifier les paramètres de contrôle de compte d’utilisateur.
5 Déplacez le curseur sur Ne jamais m'avertir.
6 Cliquez sur OK.

Configuration de la mise en veille et de la gestion de l'alimentation
Si vous utilisez Pro Tools, le mode de mise en veille du système Windows doit être défini sur 
Toujours actif. Cela permet d'éviter qu'une longue session d'enregistrement ou de lecture soit 
interrompue inopinément à cause de l'arrêt de ressources système. 

Pour configurer la gestion de l'alimentation Windows :

1 Sélectionnez Démarrer > Panneau de configuration.
2 Cliquez sur Système et sécurité.
3 Cliquez sur Options d'alimentation.
4 Cliquez sur la flèche pour Afficher les modes supplémentaires.
5 Sélectionnez Performances élevées.
6 Cliquez sur Modifier les paramètres du mode.
7 Cliquez sur Modifier les paramètres d'alimentation avancés.
8 Dans la boîte de dialogue Options d'alimentation, développez l'option Disque dur > Arrêter le 

disque dur après.
9 Cliquez sur l'option Paramètre.
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10 Sélectionnez une valeur dans le champ Paramètre (Minutes) et appuyez sur la touche Retour 
arrière du clavier ou sélectionnez Jamais dans la liste déroulante.
11 Cliquez sur OK.  Le paramètre du disque dur est défini sur Jamais  et la boîte de dialogue 
Options d'alimentation se ferme.
12 Dans la fenêtre Modifier les paramètres du mode de gestion de l’alimentation, cliquez sur 
Enregistrer les modifications puis fermez la fenêtre.

Optimisations recommandées
D'autres pilotes logiciels et matériels installés sur votre ordinateur peuvent également interférer 
avec Pro Tools. Pour obtenir des performances optimales, nous vous suggérons d'effectuer les 
opérations suivantes :

• Évitez d'exécuter simultanément Pro Tools et des programmes dont vous n'avez pas 
absolument besoin.

• Désactivez les logiciels qui fonctionnent en tâche de fond, tels que Windows Messenger, 
les calendriers et les programmes de maintenance de disque. 

• Lorsque vous exécutez Pro Tools, éteignez tous les périphériques USB non indispensables.

Lors de son ouverture, Pro Tools modifie automatiquement les paramètres d'alimentation en les 
définissant sur Performances élevées. Si vous les aviez modifiés, les paramètres d'alimentation 
d'origine de Windows sont rétablis lorsque vous quittez le logiciel Pro Tools. Par conséquent, 
lorsque vous souhaitez optimiser les paramètres de gestion de l'alimentation pour Pro Tools, 
vous devez configurer uniquement le mode Performances élevées.
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Optimisations facultatives
Les optimisations du système suivantes peuvent améliorer les performances de Pro Tools sur 
certains systèmes. Il est recommandé de ne recourir à ces optimisations qu'en cas de nécessité, 
car elles peuvent désactiver ou compromettre certaines fonctionnalités d'autres programmes 
installés sur votre système.

Réglage de la planification du processeur

Pour régler les performances de planification du processeur :

1 Cliquez avec le bouton droit de la souris sur Ordinateur,  puis sélectionnez Propriétés.
2 Cliquez sur Paramètres système avancés.
3 Dans la zone Performances, cliquez sur le bouton Paramètres.
4 Dans la fenêtre Options de performances, cliquez sur l'onglet Avancé.
5 Dans la section Performance des applications, sélectionnez l'option Services d'arrière-plan.
6 Cliquez sur OK pour fermer la fenêtre Options de performances.
7 Cliquez sur OK pour fermer la fenêtre Propriétés système.

Désactivation des éléments de démarrage du système
Moins les processus actifs sur votre ordinateur sont nombreux, plus les ressources disponibles 
pour Pro Tools sont importantes. Certaines applications de démarrage consomment inutilement 
les ressources du processeur et peuvent être désactivées. 

Ne désactivez les éléments de démarrage suivants qu'en toute connaissance de cause :
• le numéro de série d'un support mobile (nécessaire aux applications utilisant une clé de 

protection contre la copie) ;

• le service Plug and Play ;

• le journal d'événements ;

• les services cryptographiques.
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Pour désactiver les éléments de démarrage du système :

1 Depuis le menu Démarrer, saisissez « msconfig » dans la zone de recherche et appuyez sur 
Entrée pour ouvrir l 'utilitaire de configuration du système.
2 Sous l'onglet Général, sélectionnez Démarrage sélectif.
3 Désactivez l'option Charger les éléments de démarrage, puis cliquez sur OK.
4 Cliquez sur Redémarrer pour redémarrer l'ordinateur.
5 Après le redémarrage, un message relatif à la configuration système s'affiche à l'écran. Vérifiez 
que les performances de Pro Tools ont été améliorées avant de désactiver la case « Ne plus 
afficher ce message ». Si les performances n'ont pas été améliorées, exécutez l'utilitaire msconfig 
et sélectionnez le mode Démarrage normal (charger tous les pilotes de périphérique et tous les 

services) au lieu du mode de démarrage sélectif, ou désactivez un par un les éléments lancés au 
démarrage et les processus non indispensables.

Sauvegarde de votre système
Une fois la configuration du système et l 'installation de Pro Tools terminées, enregistrez une 
image de votre disque système à l'aide d'un utilitaire de sauvegarde. Cette opération vous permet, 
en cas de problèmes, de restaurer rapidement la configuration et les paramètres de votre système.
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Installieren der Pro Tools-Software

Willkommen bei Pro Tools® von Avid. In diesem Handbuch erfahren Sie, wie Sie Ihre Pro Tools-
Software auf Mac- und Windows-Systemen installieren und autorisieren. Nähere Informationen 
zur Konfiguration Ihres Pro Tools-Systems sowie über dessen volle Funktionalität erhalten Sie 
im Pro Tools-Referenzhandbuch (Zugriff über das Hilfemenü in Pro Tools).

Es gibt vier Arten von Pro Tools-Systemen:
Pro Tools-Software

Zu diesen Systemen gehört Pro Tools-Software zusammen mit Audio-Interfaces der Produktfamilien 
Avid 003™, Digi 002®, Eleven® Rack, Mbox® und Mbox 2 oder M-Audio-Hardware. Die in diesen 
Systemen enthaltene Pro Tools-Software kann auch mit Audio-Interfaces anderer Hersteller, 
die Core Audio-Treiber (Mac, einschließlich der im Mac integrierten Audiofunktionen) oder 
ASIO-Treiber (Windows) unterstützen, eingesetzt werden.
Pro Tools HD-Software mit Hardwarebeschleunigung

Zu diesen Systemen gehört Pro Tools HD zusammen mit Avid HDX, Pro Tools|HD- oder HD Native-
Hardware. Systeme mit Hardwarebeschleunigung bieten erweiterte Anschlussmöglichkeiten und 
Niedriglatenz-Monitoring. Pro Tools HD-Software mit Avid HDX- oder Pro Tools|HD-Hardware 
bietet DSP-Leistung eigens für Plug-In-Verarbeitung und große Mixer-Konfigurationen.
Pro Tools HD-Software und Pro Tools-Software mit Complete Production Toolkit

Zu diesen Systemen gehören Pro Tools HD- oder Pro Tools-Software mit Complete Production 
Tool kit zusammen mit kompatibler Avid-, Core Audio- oder ASIO-Hardware. 
Pro Tools Express-Software

Zu diesen Systemen gehört Pro Tools Express-Software zusammen mit Audio-Interfaces der 
Mbox-Produktfamilie (3. Generation). (Weitere Informationen hierzu finden Sie im Pro Tools 
Express-Installationshandbuch.)

Eine Liste der qualifizierten Audio-Interfaces und Computer für alle Pro Tools-Systeme finden 
Sie unter: www.avid.com/compatibility. 
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Systemanforderungen und Kompatibilität
Pro Tools kann auf einem qualifizierten Windows- oder Mac-Computer mit einem qualifizierten 
Audio-Interface eingesetzt werden.

Zur Verwendung des Pro Tools-Installationsdatenträgers ist ein DVD-Laufwerk erforderlich.

Für den Download des Pro Tools-Installationsprogramms benötigen Sie eine Internetverbindung.

Avid kann die Kompatibilität und technische Unterstützung nur für Hardware- und Softwarekom-
ponenten zusichern, die entsprechend geprüft und genehmigt wurden. 

Die kompletten Systemanforderungen und eine Liste der qualifizierten Computer, Betriebssysteme, 
Festplatten und Geräte von Drittanbietern finden Sie auf der Website:

www.avid.com/compatibility

Autorisierter iLok
Das Standard-Pro Tools-Software-Paket umfasst einen bereits autorisierten iLok für die Pro Tools-
Software. Zum Lieferumfang von Hardware-Systemen mit Pro Tools gehören ein nicht autorisierter 
iLok und ein Aktivierungscode für Ihre Pro Tools-Autorisierung. Weitere Informationen hierzu 
finden Sie unter „Autorisieren von Pro Tools“ auf Seite 53.

MIDI-Anforderungen
USB-, FireWire- und PCI MIDI-Interfaces funktionieren mit Pro Tools-Systemen auf Mac oder 
unter Windows. Serielle MIDI-Interfaces werden nur auf Windows-Systemen unterstützt.

Damit Sie Pro Tools verwenden können, muss ein autorisierter iLok in einen USB-Anschluss 
Ihres Computers eingesteckt sein.

Eine Liste der unterstützten MIDI-Interfaces und MIDI-Controller finden Sie auf www.avid.com.
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Anforderungen an die Festplatten
Für eine optimale Audioaufnahme und -wiedergabe benötigen alle Pro Tools-Systeme mindestens 
eine von Avid qualifizierte Festplatte. 

Initialisieren Sie Ihre Festplatte mit dem Festplatten-Dienstprogramm in der Apple-Systemsoftware 
(Mac) oder mit der Windows-Datenträgerverwaltung (Windows).

Nicht auf das Systemlaufwerk aufnehmen
Das Aufnehmen auf das Systemlaufwerk ist möglich, aber nicht empfehlenswert. Bei Aufnahme 
und Wiedergabe auf Systemlaufwerken können weit weniger Spuren und Plug-Ins verwendet werden.

Autorisieren von Pro Tools
Pro Tools-Software wird mit Hilfe des iLok USB Smart Key (iLok) von PACE Anti-Piracy autorisiert. 
Ein iLok kann über 100 Autorisierungen für alle Ihre iLok-geschützten Anwendungen speichern. 
Nachdem ein iLok für eine bestimmte Software autorisiert wurde, können Sie mit dem iLok 
diese Software auf einem beliebigen Computer autorisieren.

Für optimale Leistung kann es von Vorteil sein, Ihr Systemlaufwerk mit DigiBase als Laufwerk 
nur für die Wiedergabe oder nur für die Übertragung einzurichten. Weitere Informationen 
hierzu finden Sie im Pro Tools-Referenzhandbuch.

iLok USB Smart Key

Sie können für Ihre Pro Tools-Autorisierungen entweder die neue Version des iLok (abgebildet) 
oder die vorherige Version des iLok verwenden.
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Pro Tools HD-Autorisierung
Mit einer Pro Tools HD-Autorisierung können Sie Pro Tools HD auf einem unterstützten Mac- 
oder Windows-Computer mit oder ohne Avid HDX, Pro Tools|HD- oder HD Native-Hardware 
ausführen. Mit einer Autorisierung für Pro Tools HD können Sie Pro Tools HD auch mit jedem 
anderen von Avid qualifizierten Audio-Interface (wie Mbox Pro oder Fast Track) ausführen 
oder mit einem Audio-Interface eines anderen Herstellers, das Core Audio- (Mac) oder ASIO-
Gerätetreiber (Windows) unterstützt.

Pro Tools-Autorisierung
Mit einer Autorisierung für Pro Tools können Sie Pro Tools-Software auf einem unterstützten 
Mac- oder Windows-Computer mit einem von Avid qualifizierten Audio-Interface (wie Mbox 
Pro oder Fast Track) ausführen oder mit einem Audio-Interface eines anderen Herstellers, das 
Core Audio- (Mac) oder ASIO-Gerätetreiber (Windows) unterstützt.

Complete Production Toolkit-Autorisierung
Eine Complete Production Toolkit-Autorisierung zusammen mit einer Pro Tools-Autorisierung 
ermöglicht die Ausführung von Pro Tools-Software und die Nutzung aller Funktionen von 
Complete Production Toolkit. Mit der Pro Tools-Softwareoption Complete Production Toolkit 
stehen zusätzliche Spuren und spielbare Spuren (Voices) sowie Funktionen für Surround-Mischen, 
-Editing und -Automation zur Verfügung, die das Niveau von Pro Tools HD erreichen.

Eine Pro Tools-Autorisierung genügt nicht für die Ausführung der Pro Tools HD-Software. 
Wenn Sie versuchen, Pro Tools-Software auf einem System mit HDX, Pro Tools|HD- oder 
HD Native-Hardware ohne eine Pro Tools HD-Autorisierung zu starten, startet die Pro Tools-
Software zwar, wenn sie Core Audio oder ASIO mit integriertem Sound oder einem anderen 
Audio-Interface verwenden kann, es kann aber installierte HDX-, Pro Tools|HD- oder HD 
Native-Hardware nicht nutzen.

Weitere Hinweise zu Complete Production Toolkit finden Sie im Handbuch zu Complete 
Production Toolkit sowie im Pro Tools-Referenzhandbuch.
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Autorisieren des iLok mit einem Aktivierungscode
Wenn Sie eine neue Version von Pro Tools-Software als Box-Version gekauft haben, ist ein bereits 
autorisierter iLok enthalten. In diesem Fall können Sie diesen Abschnitt überspringen und bei 
„Installieren von Pro Tools“ auf Seite 56 weiterlesen.

Wenn Sie ein neues Avid HDX-, Pro Tools|HD- oder HD Native-System gekauft haben, wird dieses 
mit einem leeren iLok und einem Aktivierungscode (auf der mitgelieferten Aktivierungskarte) 
zur Autorisierung von Pro Tools HD-Software geliefert. Folgen Sie zur Autorisierung den 
nachstehenden Anweisungen.

Upgrades von einer früheren Version der Pro Tools-Software umfassen einen Aktivierungscode 
(auf der beigelegten Aktivierungskarte), mit dem Sie Ihr Software-Upgrade auf Ihrem iLok 
autorisieren. Folgen Sie zur Autorisierung den nachstehenden Anweisungen.

So autorisieren Sie Ihre Pro Tools-Software mit einem Aktivierungscode:

1 Wenn Sie kein iLok.com-Konto haben, erstellen Sie eines auf www.iLok.com.
2 Übertragen Sie die Lizenz für Ihre Software folgendermaßen auf Ihr iLok.com-Konto:

• Besuchen Sie www.avid.com/activationcard.

– und –
• Geben Sie Ihren Aktivierungscode (auf Ihrer Aktivierungskarte aufgeführt) und Ihre 

iLok.com-Anwender-ID ein. Ihre iLok.com-Anwender-ID ist der Name, den Sie für Ihr 
iLok.com-Konto erstellt haben.

3 Übertragen Sie die Lizenzen von Ihrem iLok.com-Konto wie folgt auf Ihren iLok USB Smart Key:
• Stecken Sie den iLok in einen USB-Anschluss am Computer.

• Gehen Sie zu www.iLok.com und melden Sie sich an.

• Folgen Sie den Anweisungen am Bildschirm, um Ihre Lizenzen auf Ihren iLok zu übertragen.

Weitere Informationen erhalten Sie auf der iLok-Website (www.iLok.com).
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Installieren von Pro Tools

Überblick zur Installation
Bei der Installation von Pro Tools sind die folgenden Schritte auszuführen:
1 „Installieren von Hardware-Treibern“ auf Seite 56 
2 „Installieren der Pro Tools-Software“ auf Seite 57 
3 „Installieren von virtuellen Instrumenten“ auf Seite 61 (optional)
4 „Starten von Pro Tools“ auf Seite 62 
5 Konfigurieren Ihres Systems zur Leistungsoptimierung (siehe Pro Tools-Referenzhandbuch)
6 Herstellen der Audioverbindungen zu Ihrem Audio-Interface (siehe Dokumentation zu Ihrem 
Audio-Interface)

Installieren von Hardware-Treibern
Bevor Sie die Pro Tools-Software installieren, müssen Sie sicherstellen, dass Ihre Audio-Hardware 
installiert ist und die neuesten Treiber für Ihre Hardware eingerichtet wurden. Weitere Hinweise 
hierzu finden Sie in der Dokumentation zu Ihrer Hardware. Für Avid-Audio-Interfaces installieren 
Sie die Treiber Ihrer Hardware mit dem entsprechenden Treiberinstallationsprogramm auf der DVD, 
die mit Ihrer Pro Tools-Installation mitgeliefert wurde, oder Sie laden sie von www.avid.com/drivers 
herunter und installieren sie auf Ihrem Gerät.

Wenn Sie ein Pro Tools-Upgrade durchführen, deinstallieren Sie zuerst ältere Pro Tools-
Versionen von Ihrem Computer. Siehe „Deinstallieren von Pro Tools“ auf Seite 65.

Das Pro Tools-Installationsprogramm installiert die erforderlichen Hardwaretreiber nur für 
Avid HDX-, Pro Tools|HD-Systeme und HD Native-Hardware automatisch.

Pro Tools erkennt Ihre Audio-Interfaces nicht, wenn Sie die Treiber nicht installieren. Wenn 
Sie ein Upgrade von Pro Tools vornehmen, achten Sie darauf, die neuesten Treiber für Ihre 
Hardware zu installieren.



Installieren der Pro Tools-Software
Nachdem Sie die Treiber für Ihr Audio-Interface installiert haben, können Sie Pro Tools installieren.

So installieren Sie Pro Tools:

1 Sie müssen als Administrator für das Konto angemeldet sein, für das Sie Pro Tools installieren 
möchten. 
2 Sie haben folgende Möglichkeiten:
• Legen Sie den Pro Tools-Installationsdatenträger in das DVD-Laufwerk ein. 

– oder –
• Laden Sie das Installationsprogramm für Pro Tools herunter.
3 Sie haben folgende Möglichkeiten:
• Suchen Sie auf dem Mac die Datei Install Pro Tools.mpkg und doppelklicken Sie darauf.
• Unter Windows führen Sie einen der folgenden Schritte aus:

• Wenn Windows Autorun aktiviert ist, wird ein Mini-Browser geöffnet. Wählen Sie Install 

Pro Tools, um mit der Installation zu beginnen. 
– oder –
• Wenn Sie von der DVD installieren und Windows Autorun deaktiviert ist, doppelklicken 

Sie auf die Datei Setup.exe und wählen Sie dann Install Pro Tools, um mit der Installation zu 
beginnen.

 

Lesen Sie vor dem Installieren dieser Version von Pro Tools die Informationen in der Readme-
Datei.

Unter Windows klicken Sie im Dialogfeld der Benutzerkontensteuerung auf „Erlauben“. 
Während der Installation werden mehrere Meldungen angezeigt, die ignoriert werden können, 
darunter mehrfache „Neue Hardware gefunden“-Dialogfelder und „Während der Hardware-
installation ist ein Problem aufgetreten“-Meldungen. Sollte außerdem an dieser Stelle 
eine Warnmeldung bezüglich des nicht bestandenen Windows-Logo-Tests eines Treibers 
angezeigt werden, ignorieren Sie diese und klicken Sie auf „Weiter“.
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4 Folgen Sie den Installationsanweisungen auf dem Bildschirm, um mit der Installation fortzufahren.
5 Auf der Installationsart-Seite gehen Sie wie folgt vor:
• Wenn Sie alle Pro Tools-Anwendungsdateien und die kostenlosen Plug-In-Suites (sowie die 

dazugehörigen Inhalte) installieren möchten, lassen Sie die Standardoptionen für die Installation 
unverändert und klicken Sie auf Continue.
– oder –

• Wählen Sie die Option zur benutzerdefinierten Konfiguration oder heben Sie diese Auswahl auf 
(siehe „Installationsoptionen“ auf Seite 58) und klicken Sie auf Continue.

6 Klicken Sie auf Install.
7 Geben Sie bei entsprechender Aufforderung das Administrator-Kennwort ein und klicken Sie zum 
Ausführen der Installation auf OK. 
8 Folgen Sie den weiteren Anweisungen auf dem Bildschirm. 
9 Wenn die Installation abgeschlossen ist, klicken Sie auf Restart (Mac) oder Finish (Windows).

Installationsoptionen
Optionen für Pro Tools 10

Wenn Sie nur einen Teil der Pro Tools-Software und -Plug-Ins installieren möchten, klicken Sie 
im Installationsprogramm auf das Dreieckszeichen für Pro Tools 10 und heben Sie die Auswahl 
der Optionen, die Sie nicht installieren möchten, auf.
Application Files (Required for Pro Tools) – damit werden die Pro Tools-Software und die 
dazugehörigen Bibliotheksdateien installiert. Diese Option muss aktiviert sein, um Pro Tools 
zu installieren.
Avid Effects – installiert kostenlose Audio-Effekt-Plug-Ins von Avid. Weitere Informationen 
finden Sie im Audio-Plug-Ins-Handbuch.

Die Pro Tools-Installations-DVD enthält weitere Software für Ihr System. Weitere Informati-
onen hierzu finden Sie unter „Weitere Software auf der Pro Tools-Installations-DVD“ auf 
Seite 64.
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Pro Tools Utilities – installiert Pro Tools-Dienstprogramme wie DigiTest und das Deinstallations-
programm „Uninstall Pro Tools“ (nur Mac).
Weitere Optionen

Das Pro Tools-Installationsprogramm bietet die folgenden zusätzlichen Optionen zur Installation 
mit Pro Tools-Software und -Plug-Ins.
Mac HFS+ Disk Support Option (nur Windows) – mit dieser Option kann das Pro Tools-System 
auf in HFS+ formatierten Mac-Festplatten lesen, schreiben, aufzeichnen und wiedergeben. 
Festplatten des Typs HFS+ werden auch als Mac OS Extended-Festplatten bezeichnet. Weitere 
Informationen hierzu finden Sie im Pro Tools-Referenzhandbuch.
Avid Video Engine – die Avid Video Engine ist erforderlich, um Pro Tools mit Avid-Video-
peripheriegeräten wie Avid Mojo® SDI zu verwenden. Weitere Informationen hierzu finden 
Sie im Handbuch zu Avid-Videoperipheriegeräten.

Starten bzw. Herunterfahren des Systems
Damit die einzelnen Komponenten Ihres Pro Tools-Systems ordnungsgemäß miteinander 
kommunizieren können, müssen sie in einer bestimmten Reihenfolge gestartet werden.

Starten Sie das Pro Tools-System in dieser Reihenfolge:

1 Vergewissern Sie sich, dass sämtliche Geräte (einschließlich des Computers) ausgeschaltet sind.
2 Reduzieren Sie die Lautstärke aller Ausgabegeräte des Systems. 
3 Schalten Sie bei Systemen mit Erweiterungschassis zuerst dieses Chassis ein.
4 Schalten Sie alle externen Festplatten ein. Warten Sie 10 Sekunden, bis diese ihre Betriebsge-
schwindigkeit erreicht haben.
5 Schalten Sie alle Bedienoberflächen ein.
6 Schalten Sie MIDI-Interfaces, MIDI-Geräte und/oder Synchronisationseinheiten ein.
 Installieren der Pro Tools-Software 59



7 Bei Systemen, die eine externe Stromversorgung benötigen, schalten Sie dann die Hardware 
ein (wie etwa HD I/O oder 003). Warten Sie mindestens 15 Sekunden, bis das Audio-Interface 
initialisiert ist. Die Status-LEDs hören dann auf zu blinken.
8 Schalten Sie Ihren Computer ein. 
9 Starten Sie Pro Tools (siehe „Starten von Pro Tools“ auf Seite 62) bzw. Audio- oder MIDI-
Anwendungen anderer Hersteller. 

Fahren Sie das Pro Tools-System in der folgenden Reihenfolge herunter:

1 Beenden Sie Pro Tools und alle anderen laufenden Anwendungen. 

2 Schalten Sie die Ausgabegeräte des Systems aus oder reduzieren Sie die Lautstärke auf das 
Minimum. 
3 Schalten Sie Ihren Computer aus.
4 Bei Systemen mit Hardware, die eine externe Stromversorgung benötigt, schalten Sie die 
Hardware aus.
5 Schalten Sie die Pro Tools-Audio-Interfaces ein.
6 Schalten Sie bei Systemen mit Erweiterungschassis zuerst dieses Chassis aus.
7 Schalten Sie MIDI-Interfaces, MIDI-Geräte und Synchronisationsgeräte aus.
8 Schalten Sie alle Bedienoberflächen aus.
9 Schalten Sie die externen Festplatten aus.

Um Pro Tools zu beenden, wählen Sie „Pro Tools > Quit“ (Mac) oder „File > Exit“ (Windows).
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Installieren von virtuellen Instrumenten
Avid bietet eine Zusammenstellung virtueller Instrumenten-Plug-Ins und dazugehöriger Sample-
Inhalte für die Verwendung mit Pro Tools. Weitere Informationen finden Sie im Audio-Plug-
Ins-Handbuch.

So installieren Sie Avid Virtual Instruments:

1 Sie müssen als Administrator für das Konto angemeldet sein, für das Sie Avid Virtual Instruments 
installieren möchten. 
2 Sie haben folgende Möglichkeiten:
• Legen Sie den Pro Tools-Installationsdatenträger in das DVD-Laufwerk ein. 

– oder –
• Laden Sie das Installationsprogramm für Avid Virtual Instruments sowie die zugehörigen 

Inhalte von der Website herunter.
3 Sie haben folgende Möglichkeiten:
• Suchen Sie auf dem Mac die Datei Install Avid Virtual Instruments.mpkg und doppelklicken Sie 

darauf.
• Unter Windows führen Sie einen der folgenden Schritte aus:

• Wenn Sie von der DVD installieren und Windows Autorun aktiviert ist, wird ein Mini-Browser 
geöffnet. Wählen Sie Install Avid Virtual Instruments,  um mit der Installation zu beginnen. 

• Wenn Sie von der DVD installieren und Windows Autorun deaktiviert ist, doppelklicken 
Sie auf die Datei Setup.exe und wählen Sie dann Install Avid Virtual Instruments, um mit der 
Installation zu beginnen.

• Wenn Sie das Installationsprogramm für Avid Virtual Instruments heruntergeladen haben, 
führen Sie die Datei Avid Virtual Instruments.exe aus.

4 Folgen Sie den Installationsanweisungen auf dem Bildschirm, um mit der Installation fortzufahren.
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5 Klicken Sie auf Install.

6 Geben Sie bei entsprechender Aufforderung das Administrator-Kennwort ein und klicken 
Sie zum Ausführen der Installation auf OK.
7 Folgen Sie den weiteren Anweisungen auf dem Bildschirm.
8 Wenn die Installation abgeschlossen ist, klicken Sie auf Close (Mac) bzw. Finish (Windows).

Starten von Pro Tools
Um Pro Tools-Software einsetzen zu können, müssen Sie über einen iLok mit einer Lizenz verfügen, 
die die von Ihnen installierte Pro Tools-Version autorisiert (weitere Informationen finden Sie 
unter „Autorisieren von Pro Tools“ auf Seite 53).

So starten Sie die Pro Tools-Software:

1 Vergewissern Sie sich, dass das Audio-Interface mit dem Computer verbunden und eingeschaltet ist.
2 Stecken Sie einen autorisierten iLok in einen USB-Anschluss am Computer (siehe „Autorisieren 
von Pro Tools“ auf Seite 53).

Die Inhalte für virtuelle Instrumente sind sehr umfangreich und die Installation kann bis 
zu 20 Minuten dauern. Es kann während dieser Zeit den Anschein haben, dass sich der 
Fortschrittsbalken nicht bewegt, aber die Software wird trotzdem installiert. Brechen Sie 
die Installation nicht ab.

Entfernen Sie den iLok während des Starts und der Verwendung von Pro Tools nicht.
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3 Sie haben folgende Möglichkeiten:
• Auf dem Mac klicken Sie auf den Pro Tools-Schnellaufruf in Ihrem Dock (oder doppelklicken 

Sie auf das Programmsymbol in Macintosh HD/Programme/Avid/Pro Tools).
– oder –

• Unter Windows doppelklicken Sie auf die Pro Tools-Verknüpfung auf Ihrem Desktop (oder auf 
die Anwendungsdatei in Programme\Avid\Pro Tools).

4 Im Quick Start-Dialogfeld haben Sie folgende Möglichkeiten:
• Erstellen einer neuen Session aus einer Vorlage

• Erstellen einer neuen leeren Session

• Öffnen einer anderen Session in Ihrem System

Konfigurieren des Pro Tools-Systems
Nachdem Sie die Pro Tools-Software installiert, autorisiert und gestartet haben, können Sie 
Ihr Pro Tools-System konfigurieren, um es an die besonderen Anforderungen Ihres Studios 
anzupassen. Detaillierte Hinweise zur Konfiguration Ihrer Pro Tools-Software finden Sie im 
Pro Tools-Referenzhandbuch (im Hilfemenü von Pro Tools).

Weitere Informationen zu Quick Start-Dialogfeld und Session-Vorlagen finden Sie im 
Pro Tools-Referenzhandbuch.
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Weitere Software auf der Pro Tools-Installations-DVD
Auf der Pro Tools-Installations-DVD finden Sie im Ordner Additional Files weitere Dokumentation 
und Software für Ihr Pro Tools-System.

Dokumentation
Im Documentation-Ordner finden Sie PDF-Dokumentation für Pro Tools-Software, -Hardware, 
-Plug-Ins und -Optionen.

Technische Hilfe
Im Tech Support-Ordner finden Sie die PDF-Dokumentation, Informationen über Online-
Ressourcen und Pro Tools-Sessions für die Fehlersuche in Ihrem Pro Tools-System.

Optionale Installationsprogramme
Der Optional Installers-Ordner enthält Installationsprogramme für Pro Tools-Softwareoptionen, 
die separat erworben und autorisiert werden können.

HEAT
(Nur Avid HDX und Pro Tools|HD-Systeme)

HEAT (Harmonically Enhanced Algorithm Technology) ist eine Softwareoption, die Pro Tools HD 
zusammen mit Avid HDX und Pro Tools|HD-Systemen „analoges Feeling“ verleiht. Weitere 
Informationen hierzu finden Sie im HEAT-Handbuch.

Pro Tools-Demo-Session
Die Pro Tools-Installations-DVD enthält eine Demo-Session, mit deren Hilfe Sie feststellen 
können, ob Ihr System funktioniert.

So installieren Sie die Demo-Session:

1 Legen Sie die Installations-DVD für Pro Tools in das DVD-Laufwerk ein.
2 Öffnen Sie auf der Pro Tools Installations-DVD den Additional Files-Ordner.
3 Kopieren Sie den Pro Tools Demo Session-Ordner auf ein gültiges Audiolaufwerk.
4 Öffnen Sie die Demo-Session.
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Deinstallieren von Pro Tools
Wenn Sie Pro Tools von Ihrem Computer entfernen möchten, benutzen Sie auf dem Mac die 
Uninstaller-Anwendung und unter Windows in der Systemsteuerung die Option „Programme“. 

Deinstallieren von Pro Tools auf dem Mac
So deinstallieren Sie Pro Tools auf dem Mac:

1 Vergewissern Sie sich, dass Sie als Administrator für das Konto angemeldet sind, für das 
Pro Tools installiert ist. 
2 Rufen Sie das Verzeichnis Programme/Avid/Pro Tools/Pro Tools Utilities auf und doppelklicken 
Sie auf die Datei Uninstall Pro Tools.
3 Klicken Sie auf Continue,  um mit der Deinstallation fortzufahren.
4 Wählen Sie die durchzuführende Deinstallationsart:
Safe Uninstall – bei dieser Deinstallationsart werden bestimmte Plug-Ins und Systemdateien, 
die zur Kompatibilität mit einigen Avid-Produkten erforderlich sind, nicht entfernt. Verwenden 
Sie „Safe Uninstall“, wenn Sie eine Avid-Anwendung verwenden oder eine Aktualisierung auf 
eine CS-Version (Customer Support) planen.
Clean Uninstall – alle Pro Tools-Dateien werden entfernt, einschließlich Systemdateien, Avid-
Plug-Ins und MIDI-Patch-Namen. Verwenden Sie „Clean Uninstall“, wenn Sie eine Aktualisierung 
planen oder ein neu installiertes System zur Fehlerbehebung benötigen.
5 Klicken Sie auf Uninstall. 
6 Geben Sie Ihr Administratorkennwort ein und klicken Sie auf OK. 
7 Klicken Sie auf Finish, um das Installationsfenster zu schließen.
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Deinstallieren von Pro Tools unter Windows
So deinstallieren Sie Pro Tools unter Windows:

1 Wählen Sie Start > Systemsteuerung.
2 Klicken Sie auf Programme und Funktionen.
3 Klicken Sie auf Programm deinstallieren.
4 Wählen Sie Avid Pro Tools aus der Liste installierter Anwendungen.
5 Klicken Sie auf Deinstallieren.
6 Folgen Sie den Bildschirmanweisungen, um Pro Tools zu entfernen.

Optimieren eines Mac-Systems für Pro Tools
Damit Pro Tools optimal funktioniert,  müssen Sie den Computer vor der Ver wendung der 
Pro Tools-Software konfigurieren.

Vor dem Konfigurieren Ihres Computers müssen Sie als Administrator für das Konto angemeldet 
sein, für das Sie Pro Tools installieren möchten. Weitere Informationen zur Anmeldung als 
Administrator auf Mac OS X finden Sie in der Apple-Dokumentation zu OS X.

Beachten Sie, dass Plug-Ins (wie Avid Effects) sowie Audio- und MIDI-Gerätetreiber separat 
deinstalliert werden müssen.

Verwenden Sie keinesfalls die Funktion zur automatischen Software-Aktualisierung von 
Mac OS X, da sonst möglicherweise eine Version von Mac OS installiert wird, die noch nicht 
für die Verwendung mit Pro Tools qualifiziert wurde. Weitere Informationen zu empfohlenen 
Versionen von Mac OS erhalten Sie in den aktuellen Kompatibilitätsinformationen auf der 
Avid-Website (www.avid.com).
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Deaktivieren der Software-Aktualisierung

So deaktivieren Sie die Software-Aktualisierung:

1 Wählen Sie aus dem Apple-Menü Systemeinstellungen.
2 Klicken Sie auf Softwareaktualisierung.
3 Klicken Sie auf die Registerkarte Planmäßige Überprüfung. 
4 Deaktivieren Sie Nach Updates suchen.
5 Wählen Sie anschließend Systemeinstellungen > Systemeinstellungen beenden.

Deaktivieren der Energiesparfunktion

So deaktivieren Sie die Funktion „Energie sparen“:

1 Wählen Sie aus dem Apple-Menü Systemeinstellungen.
2 Klicken Sie auf Energie sparen.
3 Setzen Sie die Einstellung für den Ruhezustand des Computers auf Nie.
4 Setzen Sie die Einstellung für den Ruhezustand des Monitors auf Nie.
5 Heben Sie die Auswahl der Option Wenn möglich Ruhezustand der Festplatte(n) aktivieren auf.
6 Wählen Sie anschließend Systemeinstellungen > Systemeinstellungen beenden.

Deaktivieren oder Neuzuordnen der Mac-Tastenkombinationen für Pro Tools
Um alle Pro Tools-Tastenkombinationen verwenden zu können, müssen Sie zuerst dazu im 
Widerspruch stehende Mac OS X-Tastenkombinationen in den Apple-Systemeinstellungen 
deaktivieren oder neu zuordnen.

Eine vollständige Liste der Pro Tools-Tastenkombinationen finden Sie in der Dokumentation 
zu den Tastenkombinationen (Help > Keyboard Shortcuts).
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So deaktivieren Sie Mac-Tastenkombinationen für Pro Tools oder ordnen sie neu zu (Mac OS X Lion):

1 Wählen Sie aus dem Apple-Menü die Option Systemeinstellungen.
2 Klicken Sie auf Tastatur & Maus.
3 Klicken Sie auf die Registerkarte Tastatur-Kurzbefehle.
4 Sie können die Mac OS-Tastenkombinationen, die mit den Pro Tools-Tastenkombinationen 
in Konflikt stehen, deaktivieren oder neu programmieren. Die folgende Liste enthält einige 
häufige Mac-Tastenkombinationen, die je nach Mac-Modell möglicherweise auch von Pro Tools 
benutzt werden:
• Unter „Launchpad & Dock“

• Dock ein- oder ausblenden
• Unter „Mission Control“

• Mission Control

• Programmfenster

• Schreibtisch einblenden

• Dashboard einblenden

• Mission Control > Einen Space nach links bewegen

• Mission Control > Einen Space nach rechts bewegen

• Mission Control > Zu Schreibtisch n wechseln
• Unter „Tastatur & Texteingabe“

• Fokus zum aktiven oder nächsten Fenster bewegen
• Unter „Dienste“

• Datei an Bluetooth-Gerät senden

• Mit Google suchen

• Spotlight

• In man-Seiten im Terminal suchen
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• Unter „Spotlight“
• Spotlight-Suchfeld einblenden

• Spotlight-Fenster einblenden
• Unter „Universal Access“

• Zoom

• Kontrast
• Unter dem Menü für Programm-Kurzbefehle

• Hilfemenü einblenden

So deaktivieren Sie Mac-Tastenkombinationen für Pro Tools oder ordnen sie neu zu (Mac OS X Snow 
Leopard):

1 Wählen Sie aus dem Apple-Menü die Option Systemeinstellungen.
2 Klicken Sie auf Tastatur & Maus.
3 Klicken Sie auf die Registerkarte Tastatur-Kurzbefehle.
4 Sie können die Mac OS-Tastenkombinationen, die mit den Pro Tools-Tastenkombinationen 
in Konflikt stehen, deaktivieren oder neu programmieren. Die folgende Liste enthält einige 
häufige Mac-Tastenkombinationen, die auch von Pro Tools verwendet werden:
• Unter „Dashboard & Dock“

• Dock ein- oder ausblenden

• Dashboard
• Unter „Exposé & Spaces“

• Alle Fenster

• Programmfenster

• Schreibtisch
• Unter „Tastatur & Texteingabe“

• Fokus zum aktiven oder nächsten Fenster bewegen
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• Unter „Spotlight“
• Spotlight-Suchfeld einblenden 
• Spotlight-Fenster einblenden

• Unter dem Menü für Programm-Kurzbefehle
• Hilfemenü einblenden

Deaktivieren der Spotlight-Indizierung
Die Spotlight-Funktion von Mac OS X indiziert automatisch im Hintergrund Dateien und Ordner 
auf lokalen Festplatten. Dies ist für die normalen Pro Tools-Funktionen in den meisten Fällen 
kein Problem. Wenn aber Spotlight mit dem Indizieren der Festplatten während einer länger 
dauernden Aufnahme in einer Pro Tools-Sitzung mit vielen Spuren beginnt, kann das die Leistung 
des Pro Tools-Systems deutlich vermindern. Es kann also sinnvoll sein, die Spotlight-Indizierung 
für alle lokalen Festplatten zu deaktivieren, bevor Sie mit Pro Tools größere Aufnahmeprojekte 
durchführen.

So deaktivieren Sie die Spotlight-Indizierung:

1 Wählen Sie aus dem Apple-Menü Systemeinstellungen und klicken Sie auf Spotlight.
2 Klicken Sie im Spotlight-Fenster auf die Registerkarte Privatsphäre.
3 Um die Indizierung eines Laufwerks zu verhindern, ziehen Sie das entsprechende Laufwerkssym-
bol vom Schreibtisch in die Liste.
Aktivieren von Journaling für Audiolaufwerke
Um die Leistung der Audiolaufwerke zu verbessern, können Sie Journaling aktivieren.

So aktivieren Sie Journaling:

1 Starten Sie das Festplattendienstprogramm (im Ordner „Programme/Dienstprogramme“).
2 Wählen Sie in der linken Spalte des Festplatten-Dienstprogramm-Fensters das Volume aus.
3 Wählen Sie in der Symbolleiste Journaling aktivieren.

Durch das Deaktivieren der Spotlight-Indizierung wird auch die Suchfunktion in Mac OS X 
deaktiviert. 
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Optimieren eines Windows-Systems für Pro Tools
Damit Pro Tools optimal funktioniert, müssen Sie den Computer vor der Verwendung der 
Pro Tools-Hardware und -Software konfigurieren.

Vor dem Konfigurieren Ihres Computers müssen Sie als Administrator für das Konto angemeldet 
sein, für das Sie Pro Tools installieren möchten. Weitere Informationen hierzu finden Sie in 
der Windows-Dokumentation.

Erforderliche Optimierungsmaßnahmen
Für eine optimale Leistung von Pro Tools sollten Sie vor dem Verwenden der Pro Tools-Hardware 
und -Software die im Folgenden beschriebenen Einstellungen vornehmen.

Benutzerkontensteuerung deaktivieren

So deaktivieren Sie die Benutzerkontensteuerung:

1 Wählen Sie Start > Systemsteuerung.
2 Klicken Sie auf Benutzerkonten und Jugendschutz.
3 Klicken Sie auf Benutzerkonten.
4 Klicken Sie auf Einstellungen der Benutzerkontensteuerung ändern.
5 Setzen Sie den Schieberegler auf Nie benachrichtigen.
6 Klicken Sie auf OK.

Aktuelle Informationen zu Windows-Systemeinstellungen sowie Informationen zu bestimmten 
Computern finden Sie auf der Avid-Website (www.avid.com).

Nachdem Sie die erforderlichen Windows-Systemeinstellungen geändert haben, starten Sie 
den Computer neu.
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Konfigurieren von System-Standby und Energieverwaltung
Bei der Arbeit mit Pro Tools muss das Energieschema für Windows-System-Standby immer auf 
Dauerbetrieb gesetzt sein. Dadurch wird vermieden, dass lange Aufnahme- oder Wiedergabedurch-
läufe aufgrund eines plötzlichen Ausfalls der Systemressourcen unterbrochen werden. 

So konfigurieren Sie die Windows-Energieverwaltung:

1 Wählen Sie Start > Systemsteuerung.
2 Klicken Sie auf System und Sicherheit.
3 Klicken Sie auf Energieoptionen.
4 Klicken Sie auf den Pfeil für die Option Weitere Energiesparpläne einblenden.
5 Wählen Sie Hohe Leistung.
6 Klicken Sie auf Energiesparplaneinstellungen ändern.
7 Klicken Sie auf Erweiterte Energieeinstellungen ändern.
8 Im Dialogfeld der Energieoptionen suchen Sie Festplatte > Festplatte ausschalten nach.
9 Klicken Sie auf die Option Einstellungen.
10 Wählen Sie im Feld für die Einstellung der Minuten den gewünschten Wert und drücken Sie 
die Rücktaste auf der Computertastatur oder setzen Sie den Wert auf Nie.
11 Klicken Sie auf OK. Die Festplatteneinstellung ändert sich auf Nie und das Dialogfeld für 
die Energieoptionen wird geschlossen.
12 Klicken Sie im Fenster „Energiesparplaneinstellungen bearbeiten“ auf Änderungen speichern 
und schließen Sie das Fenster.

Pro Tools aktiviert beim Start automatisch die Energiespareinstellung „Hohe Leistung“. 
Windows kehrt in die vorher ausgewählte Energiespareinstellung zurück, wenn Pro Tools 
beendet wird. Wenn Sie also die Energiespareinstellung für Pro Tools ändern möchten, 
brauchen Sie nur die Energiespareinstellung „Hohe Leistung“ einzustellen.
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Empfohlene Optimierungsmaßnahmen
Andere auf dem Computer installierte Software- und Hardwaretreiber können sich auf die Leistung 
von Pro Tools auswirken. Beachten Sie die folgenden Empfehlungen, um eine optimale Leistung 
mit Pro Tools zu erzielen:

• Nicht erforderliche andere Programme sollten nicht gleichzeitig mit Pro Tools ausgeführt 
werden.

• Deaktivieren Sie im Hintergrund ausgeführte Dienstprogramme (wie Windows Messenger, 
Kalender und Datenträger-Wartungsprogramme). 

• Schalten Sie während der Arbeit mit Pro Tools alle nicht unbedingt erforderlichen USB-
Geräte aus.

Optionale Optimierungsmaßnahmen
Die folgenden Maßnahmen zur Systemoptimierung steigern die Leistung von Pro Tools auf 
manchen Systemen. Sie sollten diese Optimierungseinstellungen nur vornehmen, wenn dies 
unbedingt nötig ist, da sie sich auf die Funktion anderer Programme Ihres Systems auswirken 
können.

Einstellen der Prozessorzeitplanung

So stellen Sie die Prozessorzeitplanung ein:

1 Klicken Sie mit der rechten Maustaste auf das Symbol Arbeitsplatz und wählen Sie Eigenschaften.
2 Klicken Sie auf Erweiterte Systemeinstellungen.
3 Klicken Sie unter „Leistung“ auf die Schaltf läche Einstellungen.
4 Klicken Sie im Dialogfeld „Leistungsoptionen“ auf die Registerkarte Erweitert.
5 Wählen Sie im Abschnitt „Prozessorzeitplanung“ die Option Hintergrunddienste.
6 Klicken Sie auf OK,  um das Dialogfeld „Leistungsoptionen“ zu schließen.
7 Klicken Sie auf OK,  um das Dialogfeld „Systemeigenschaften“ zu schließen.
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Deaktivieren von Elementen für den Systemstart
Je weniger Elemente von Ihrem Computer benutzt werden, desto mehr Ressourcen sind für 
Pro Tools verfügbar. Manche Systemstartelemente verbrauchen unnötigerweise Rechnerressourcen 
und sollten daher deaktiviert werden. 
Gehen Sie beim Deaktivieren der folgenden Systemstartelemente sorgfältig vor:

• Seriennummer der tragbaren Medien (für einige Anwendungen mit einem Kopierschutz-
schlüssel benötigt)

• Plug & Play-Dienst
• Ereignisprotokoll
• Kryptografiedienste

So deaktivieren Sie Elemente für den Systemstart:

1 Wählen Sie im Startmenü die Option „Ausführen“, geben Sie „msconfig“ ein und drücken Sie 
die Eingabetaste, um das Dienstprogramm zur Systemkonfiguration aufzurufen.
2 Wählen Sie auf der Registerkarte Allgemein die Option Benutzerdefinierter Systemstart.
3 Deaktivieren Sie Systemstartelemente laden und klicken Sie auf OK.
4 Klicken Sie auf Neu starten,  um den Computer neu zu starten.
5 Nach dem Neustart wird eine Meldung zur Systemkonfiguration angezeigt. Starten Sie Pro Tools 
und überprüfen Sie, ob die Leistung verbessert wurde, bevor Sie die Option „Diese Meldung 
nicht mehr anzeigen“ aktivieren. Hat sich die Leistung nicht verbessert, führen Sie „msconfig“ 
erneut aus und setzen Sie die Einstellung „Systemstartauswahl“ Ihres Computers wieder auf 
Normaler Systemstart - Alle Gerätetreiber und Dienste laden. Sie können die Systemstartelemente 
und weniger wichtige Vorgänge auch manuell deaktivieren.

Anfertigen von Sicherheitskopien
Nach der Konfiguration Ihres Systems und der Installation von Pro Tools sollten Sie mit einem 
Backup-Programm ein Image des Systems erstellen. Auf diese Weise können Sie die System-
konfiguration und -einstellungen bei Problemen schnell wiederherstellen.
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Instalación del software Pro Tools
Te damos la bienvenida a Pro Tools® de Avid. En esta guía se explican los procesos de instalación 
y autorización del software Pro Tools en sistemas Mac y Windows. Para obtener información 
detallada sobre cómo configurar tu sistema Pro Tools e información completa sobre sus 
posibilidades, características y funciones, consulta la Guía de referencia de Pro Tools (disponible 
en el menú Help de Pro Tools).

Hay tres tipos de sistemas Pro Tools:
Software Pro Tools

Estos sistemas incluyen software Pro Tools con interfaces de audio de las familias 003® o 
Digi 002™; Eleven® Rack, Mbox®, Mbox 2 o hardware de M-Audio. El software Pro Tools también 
puede usarse con interfaces de audio de otros fabricantes compatibles con drivers Core Audio 
(Mac, incluido el audio incorporado) o ASIO (Windows).
Software Pro Tools HD con aceleración por hardware

Estos sistemas Pro Tools HD acelerados por hardware vienen con el programa Pro Tools HD 
y hardware Avid HDX, Pro Tools|HD o HD Native. Los sistemas acelerados por hardware ofrecen 
funciones de E/S ampliadas y monitorización de baja latencia. El software Pro Tools HD con 
hardware Avid HDX o Pro Tools|HD también proporciona procesadores DSP dedicados para 
procesar plug-ins y para configuraciones de mezcla grandes.
Software Pro Tools HD o Pro Tools con Complete Production Toolkit

Estos sistemas incluyen el programa Pro Tools HD o el programa Pro Tools,  más la opción 
Complete Production Toolkit, con cualquier equipo compatible con Avid, Core Audio o ASIO. 
Software Pro Tools Express

Estos sistemas incluyen el programa Pro Tools Express con interfaces de audio de la familia 
Mbox (3.ª generación). Para obtener más información, consulta la Guía de instalación de 
Pro Tools Express.

Para obtener una lista de ordenadores e interfaces de audio homologados para todos los 
sistemas Pro Tools, visita www.avid.com/compatibility. 
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Requisitos y compatibilidad del sistema
Pro Tools se puede utilizar con un interface de audio homologado en un equipo con Windows 
o Mac también debidamente homologado.

Se requiere una unidad DVD para el disco de instalación de Pro Tools.

Se requiere una conexión a Internet para descargar el instalador de Pro Tools.

Avid solo puede asegurar la compatibilidad y proporcionar asistencia relativa al hardware y 
al software probado y homologado por Avid. 

Para ver listas completas de requisitos de sistema, ordenadores admitidos, sistemas operativos, 
discos duros y dispositivos de otros fabricantes, visita:

www.avid.com/compatibility

Llave iLok autorizada
El paquete de software Pro Tools estándar incluye una llave iLok previamente autorizada para 
ejecutar el software Pro Tools. Los paquetes de hardware incluyen una llave iLok todavía sin 
autorizar y un código de activación para la autorización de Pro Tools. Para más información, 
consulta “Autorización de Pro Tools” en la página 78.

Requisitos de MIDI
Los interfaces MIDI USB, FireWire y PCI funcionan correctamente con sistemas Pro Tools en 
equipos Mac o Windows. Los interfaces MIDI serie solo son compatibles con los sistemas Windows.

Para poder usar Pro Tools, hay que insertar una llave iLok autorizada en un puerto USB 
del ordenador.

Para ver una lista de interfaces y controladores MIDI admitidos, visita www.avid.com.
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Requisitos de disco duro
Para grabar y reproducir audio de forma óptima, los sistemas Pro Tools requieren uno o varios 
discos duros homologados. 

Inicializa tus discos duros con la Utilidad de disco incluida en los sistemas Apple (Mac) o la 
herramienta Administración de discos de Windows.

Procura no grabar en la unidad del sistema
Es posible grabar en la unidad del sistema, aunque no se recomienda. Grabar y reproducir en 
la unidad del sistema puede disminuir el número de pistas y de plug-ins que pueden 
utilizarse.

Para un rendimiento óptimo, es posible que desees designar la unidad del sistema como 
volumen de solo reproducción o solo transferencia en DigiBase. Para obtener más información, 
consulta la Guía de referencia de Pro Tools.
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Autorización de Pro Tools
El software Pro Tools se autoriza con una llave iLok USB Smart Key (iLok) de PACE Anti-Piracy. 
Una de estas llaves puede contener cientos de autorizaciones para todo el software que utiliza 
iLok. Una vez se haya autorizado la llave para un determinado programa, puedes utilizarla 
para autorizar dicho software en cualquier ordenador.

Autorización de Pro Tools HD
Una autorización de Pro Tools HD permite ejecutar Pro Tools HD en un ordenador Mac o Windows 
compatible con o sin hardware Avid HDX, Pro Tools|HD o HD Native. Una autorización de 
Pro Tools HD permite ejecutar este programa en cualquier interface de audio homologado 
por Avid (como Mbox Pro o Fast Track) o cualquier interface de audio de otro fabricante con 
drivers de dispositivo Core Audio (Mac) o ASIO (Windows).

Llave iLok USB

Se puede usar la nueva versión de iLok (mostrada arriba) o la versión previa para guardar 
tus autorizaciones de Pro Tools.
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Autorización de Pro Tools
Una autorización de Pro Tools permite ejecutar Pro Tools en un ordenador compatible Mac o 
Windows con un interface de audio homologado por Avid (como Mbox Pro o Fast Track) o 
cualquier interface de audio de otro fabricante con drivers de dispositivo Core Audio (Mac) 
o ASIO (Windows).

Autorización de Complete Production Toolkit
Una autorización de Complete Production Toolkit junto con una autorización de Pro Tools 
permiten ejecutar Pro Tools con las capacidades del Complete Production Toolkit. La opción 
Complete Production Toolkit proporciona una mayor cantidad de voces y pistas,  así como 
funciones de mezcla, edición y automatización surround, equivalentes a las de Pro Tools HD.

Autorización de llave iLok con un código de activación
Si has comprado una nueva versión en caja de Pro Tools, dicha versión viene con una llave iLok 
preautorizada. Puedes omitir esta sección y seguir con “Instalación de Pro Tools” en la 
página 80.

Si compraste un nuevo sistema Avid HDX, Pro Tools|HD o HD Native, este se entrega con una 
llave iLok vacía y un código (en la tarjeta de activación que se incluye) para autorizar el programa 
Pro Tools HD. Sigue las instrucciones a continuación.

Una autorización de Pro Tools es insuficiente para ejecutar el programa Pro Tools HD. Si 
se intenta ejecutar Pro Tools en un sistema con HDX, Pro Tools|HD o HD Native sin una 
autorización de Pro Tools HD, el programa se iniciará si puede usar Core Audio o ASIO 
con el interface de audio integrado u otro, pero no podrá usar el hardware HDX, Pro Tools|HD 
o HD Native.

Para obtener más información sobre la opción de software Complete Production Toolkit, 
consulta la guía de Complete Production Toolkit o la Guía de referencia de Pro Tools.
 Instalación del software Pro Tools 79



Si has actualizado una versión anterior de Pro Tools, la autorización se entrega con un código 
(en la tarjeta de activación incluida) para autorizar la actualización del software en la llave 
iLok. Sigue las instrucciones a continuación.

Para autorizar el software Pro Tools mediante un código de autorización:

1 Si no tienes una cuenta de iLok.com, visita www.iLok.com y crea una cuenta.
2 Transfiere la licencia de tu software a la cuenta de iLok.com de la siguiente manera:

• Visita www.avid.com/activationcard.

– y –

• Introduce el código (que aparece en la tarjeta de activación) y el ID de usuario de iLok.com. 
El ID de usuario es el nombre que creas para la cuenta de iLok.com.

3 Transfiere las licencias de tu cuenta de iLok.com a tu USB Smart Key siguiendo estos pasos:
• Inserta la llave iLok en un puerto USB disponible del ordenador.

• Ve a www.iLok.com e inicia sesión.

• Sigue las instrucciones en pantalla para transferir las licencias a tu llave iLok.

Instalación de Pro Tools

Descripción general de la instalación
La instalación de Pro Tools implica los pasos siguientes:
1 “Instalación de drivers de hardware” en la página 81.

Para obtener más información, visita la página web de iLok (www.iLok.com).

Si estás actualizando Pro Tools, asegúrate de desinstalar cualquier versión anterior del 
programa. Consulta “Desinstalación de Pro Tools” en la página 89.
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2 “Instalación del software Pro Tools” en la página 81.
3 “Instalación de instrumentos virtuales de Avid” en la página 85 (optativo).
4 “Inicio de Pro Tools” en la página 87.
5 Configuración del sistema para obtener un rendimiento mejorado (consulta la Guía de 
referencia de Pro Tools).
6 Establecimiento de las conexiones de audio con el interface de audio. (Consulta la documentación 
que se entrega con el interface de audio).

Instalación de drivers de hardware
Antes de instalar el software Pro Tools, cerciórate de tener instalados el hardware de audio y los 
drivers más recientes para el mismo. Consulta la documentación del hardware para obtener más 
información. Para los interfaces de audio Avid, instala los drivers para el hardware mediante 
el instalador correspondiente en el disco de instalación de drivers que se incluye en el paquete 
de instalación de Pro Tools,  o visita www.avid.com/es/drivers para descargar e instalar los 
drivers más recientes para tu dispositivo.

Instalación del software Pro Tools
Cuando hayas instalado los drivers para tu interface de audio, podrás instalar Pro Tools.

En los sistemas con hardware Avid HDX, Pro Tools|HD y HD Native, el instalador de Pro Tools 
instala automáticamente los drivers de hardware necesarios.

Pro Tools no reconocerá tu interface de audio si no instalas los drivers. Si estás actualizando 
Pro Tools, asegúrate de instalar los drivers más recientes para tu hardware.

Antes de instalar esta versión de Pro Tools, consulta los documentos Read Me que se incluyen.
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Para instalar Pro Tools:

1 Inicia sesión como administrador en la cuenta donde desees instalar Pro Tools. 
2 Lleva a cabo uno de estos procedimientos:
• Inserta el disco de instalación de Pro Tools en la unidad de DVD. 

– o bien –
• Descarga a través de Internet el instalador de Pro Tools.
3 Lleva a cabo uno de estos procedimientos:
• En un ordenador Mac, busca y haz doble clic en Install Pro Tools.mpkg.
• En Windows, realiza una de estas acciones:

• Si está activada la opción Ejecución automática de Windows, aparecerá un pequeño explorador. 
Selecciona Install Pro Tools para iniciar la instalación. 

– o bien –
• Si está deshabilitada la Ejecución automática de Windows, haz doble clic en Setup.exe y 

selecciona Install Pro Tools para iniciar la instalación.
 

4 Sigue las instrucciones en pantalla para continuar con la instalación.

En Windows, si se abre el cuadro de diálogo Control de cuentas de usuario, haz clic en 
Permitir. Aparecerán varios mensajes durante la instalación que se pueden omitir, como 
varios cuadros de diálogo sobre hardware nuevo encontrado y sobre problemas durante la 
instalación del hardware. Si aparece un cuadro de diálogo que indica que el driver no 
supera la prueba del logotipo de Windows, continúa de todos modos.
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5 En la página Installation Type, realiza una de las siguientes acciones:
• Para instalar todos los archivos de la aplicación Pro Tools y las suites de plug-ins gratuitas 

(junto con el contenido asociado), deja seleccionadas las opciones de instalación predeterminadas 
y haz clic en Continue.
– o bien –

• Selecciona las opciones de instalación que desees o anula la selección de las que no desees 
(consulta “Opciones de instalación” en la página 83) y haz clic en Continue.

6 Haz clic en Install.
7 Si se te solicita, introduce tu contraseña de administrador y haz clic en Aceptar para autorizar 
la instalación. 
8 Sigue las instrucciones en pantalla. 
9 Una vez completada la instalación, haz clic en Restart (Mac) o Finish (Windows).

Opciones de instalación
Opciones de Pro Tools 10

Para instalar solo un subconjunto de plug-ins y software Pro Tools, haz clic en el triángulo que 
aparece junto a la opción Pro Tools 10 en el instalador y deselecciona cualquiera de las siguientes 
opciones que no desees instalar.
Application Files (necesarios para Pro Tools) Instala la aplicación Pro Tools y los archivos de 
librería necesarios para ejecutar Pro Tools. Esta opción debe estar seleccionada para instalar 
Pro Tools.
Avid Effects Instala los plug-ins de efectos de audio de Avid. Para obtener más información, 
consulta la Guía de plug-ins de audio.
Pro Tools Utilities Instala utilidades de Pro Tools, como DigiTest y Uninstall Pro Tools (solo Mac).

El disco de instalación de Pro Tools incluye software adicional para el sistema. Para más 
información, consulta “Software adicional en el disco de instalación de Pro Tools” en la 
página 88.
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Additional Options

El instalador de Pro Tools proporciona las siguientes opciones adicionales, que se pueden 
instalar junto con los plug-ins y el software Pro Tools.
Opción Mac HFS+ Disk Support (solo Windows) Esta opción permite leer, escribir, grabar y reproducir 
material en discos con formato HFS+ de Mac en el sistema Pro Tools. Los discos HFS+ se suelen 
llamar discos extendidos de Mac OS. Para obtener más información, consulta la Guía de referencia 
de Pro Tools.
Avid Video Engine Avid Video Engine es necesario para utilizar Pro Tools con periféricos de 
vídeo de Avid, como Avid Mojo® SDI. Si necesitas más información, consulta la Guía de periféricos 
de vídeo de Avid.

Encendido y apagado del sistema
Para que haya una correcta comunicación entre los componentes del sistema Pro Tools, es 
preciso seguir un orden de inicio concreto.

Inicia el sistema Pro Tools en este orden:

1 Asegúrate de que todos los componentes (incluido el ordenador) estén apagados.
2 Baja el volumen de todos los dispositivos de salida del sistema. 
3 En los sistemas con un chasis de expansión, enciende primero el chasis.
4 Enciende los discos duros externos. Espera diez segundos para que alcancen la velocidad de 
funcionamiento.
5 Enciende las superficies de control.
6 Enciende los interfaces y los dispositivos MIDI, o los periféricos de sincronización.
7 En el caso de sistemas que necesitan alimentación externa, enciende el equipo (por ejemplo, 
HD I/O o 003). Espera al menos quince segundos para que el interface de audio se inicie y los 
indicadores LED de estado dejen de parpadear.
8 Enciende el ordenador. 
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9 Inicia Pro Tools (consulta “Inicio de Pro Tools” en la página 87) o cualquier aplicación 
MIDI o de audio de otros fabricantes. 

Apaga el sistema Pro Tools en este orden:

1 Cierra Pro Tools y las demás aplicaciones que estén en uso. 

2 Apaga o baja el volumen de todos los dispositivos de salida del sistema. 
3 Apaga el ordenador.
4 En los sistemas con hardware que requiere alimentación externa, apaga el hardware.
5 Apaga los interfaces de audio de Pro Tools.
6 En los sistemas con un chasis de expansión, apaga el chasis.
7 Apaga los interfaces y los dispositivos MIDI, o los periféricos de sincronización.
8 Apaga cualquier superficie de control o de trabajo.
9 Apaga los discos duros externos.

Instalación de instrumentos virtuales de Avid
Avid ofrece un conjunto de plug-ins de Instrumentos virtuales gratuitos relacionados con 
contenido de samples para utilizar con Pro Tools. Para obtener más información, consulta la 
Guía de plug-ins de audio.

Para instalar los instrumentos virtuales de Avid:

1 Inicia sesión como administrador en la cuenta donde desees instalar los instrumentos virtuales 
de Avid. 
2 Lleva a cabo uno de estos procedimientos:

Para salir de Pro Tools, selecciona Pro Tools › Quit (Mac) o File › Exit (Windows).
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• Inserta el disco de instalación de Pro Tools en la unidad de DVD. 
– o bien –

• Descarga a través de Internet el instalador de los instrumentos virtuales de Avid y el contenido 
relacionado.

3 Lleva a cabo uno de estos procedimientos:
• En un equipo Mac, busca y haz doble clic en Install Avid Virtual Instruments.mpkg.
• En Windows, realiza una de estas acciones:

• Al instalar desde el disco, si está activada la opción Ejecución automática de Windows, 
aparecerá un pequeño explorador. Selecciona Install Avid Virtual Instruments para iniciar la 
instalación. 

• Al instalar desde el disco, si está desactivada la opción Ejecución automática de Windows, 
haz doble clic en Setup.exe y luego selecciona Install Avid Virtual Instruments para comenzar 
la instalación.

• Si te descargaste el instalador de Instrumentos virtuales de Avid, ejecuta Avid Virtual 

Instruments.exe.

4 Sigue las instrucciones en pantalla para continuar con la instalación.
5 Haz clic en Install.

6 Si se te solicita, introduce tu contraseña de administrador y haz clic en OK para autorizar la 
instalación.
7 Sigue las instrucciones en pantalla.
8 Una vez completada la instalación, haz clic en Close (Mac) o Finish (Windows).

El contenido de los instrumentos virtuales es muy amplio, y su instalación puede llevar 
hasta 20 minutos. Durante este tiempo, es posible que parezca que la barra de progreso no 
se mueve, pero el software seguirá instalándose. No canceles la instalación.
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Inicio de Pro Tools
Para usar el software Pro Tools, se debe tener una llave iLok con una licencia que autorice la 
versión de Pro Tools instalada (para obtener más información, consulta “Autorización de 
Pro Tools” en la página 78).

Para iniciar el software Pro Tools:

1 Comprueba que el interface de audio esté conectado al ordenador y encendido.
2 Inserta una llave iLok autorizada en cualquier puerto USB del ordenador que esté disponible 
(consulta “Autorización de Pro Tools” en la página 78).

3 Lleva a cabo uno de estos procedimientos:
• En Mac, haz clic en el acceso directo de Pro Tools en el Dock (o haz doble clic en el icono de 

la aplicación en Macintosh HD/Applications/Avid/Pro Tools).
– o bien –

• En Windows, haz doble clic en el acceso directo a Pro Tools en el escritorio (o en la aplicación 
en Archivos de programa\Avid\Pro Tools).

4 Utiliza el cuadro de diálogo Quick Start para:
• Crear una sesión a partir de una plantilla.

• Crear una sesión en blanco.

• Abrir cualquier otra sesión que se encuentre en el sistema.

Durante el inicio o la utilización de Pro Tools, no retires la llave iLok.

Para obtener más información sobre el cuadro de diálogo Quick Start y las plantillas de 
sesión, consulta la guía de referencia de Pro Tools.
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Configuración del sistema Pro Tools
Cuando hayas instalado, autorizado e iniciado el software Pro Tools, podrás configurar el sistema 
Pro Tools según las necesidades específicas de tu estudio. Para obtener más información sobre 
la configuración del software Pro Tools, consulta la Guía de referencia de Pro Tools (disponible 
en el menú Help de Pro Tools).

Software adicional en el disco de instalación de Pro Tools
El disco de instalación de Pro Tools incluye documentación y software adicionales para el 
sistema Pro Tools en la carpeta Additional Files.

Documentation
La carpeta Documentation contiene documentación en formato PDF para el software, hardware, 
los plug-ins y las opciones de Pro Tools.

Tech Support
La carpeta Tech Support contiene documentación en formato PDF, información sobre recursos 
online y sesiones de Pro Tools para solucionar problemas con el sistema Pro Tools.

Optional Installers
La carpeta Optional Installers contiene instaladores para opciones de software de Pro Tools 
que se pueden adquirir y autorizar por separado.

HEAT
(solo sistemas Avid HDX y Pro Tools|HD)

HEAT (Harmonically Enhanced Algorithm Technology) es una opción de software de pago que 
añade “personalidad analógica” a los sistemas Avid HDX y Pro Tools|HD. Para más información, 
consulta la Guía de la opción de software HEAT.
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Sesión de demostración de Pro Tools
El disco de instalación de Pro Tools HD incluye una sesión de demostración que puedes utilizar 
para comprobar el buen funcionamiento del sistema.

Para instalar la sesión de demostración:

1 Inserta el disco de instalación de Pro Tools en la unidad de DVD.
2 En el disco de instalación de Pro Tools, busca y abre la carpeta Additional Files.
3 Copia la carpeta Pro Tools Demo Session a una unidad de audio válida.
4 Abre la sesión de demostración.

Desinstalación de Pro Tools
Si necesitas desinstalar el programa Pro Tools del ordenador, utiliza la aplicación de desinstalación 
en Mac, o el Panel de control (Programas) en Windows. 

Desinstalación de Pro Tools en Mac

Para desinstalar Pro Tools de un sistema Mac:

1 Asegúrate de iniciar sesión como administrador en la cuenta en la que esté instalado Pro Tools. 
2 Ve a Aplicaciones/Avid/Pro Tools/Pro Tools Utilities y haz doble clic en Uninstall Pro Tools.
3 Haz clic en Continue para proceder a la desinstalación.
4 Selecciona el tipo de desinstalación que deseas efectuar:
Safe Uninstall Esta opción omite la desinstalación de plug-ins y archivos del sistema que se 
necesitan para la compatibilidad con otros productos de Avid. Utiliza la opción Safe Uninstall 
si usas una aplicación Avid o vas a actualizar a una versión de soporte de cliente.
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Clean Uninstall Esta opción elimina todos los archivos de Pro Tools, incluidos los archivos del 
sistema, plug-ins de Avid y nombres de patches MIDI. Utiliza la opción Clean Uninstall si estás 
preparando el sistema para una actualización o si quieres solucionar problemas a partir de un 
sistema limpio.
5 Haz clic en Uninstall. 
6 Introduce la contraseña de administrador y haz clic en OK. 
7 Haz clic en Finish para cerrar la ventana del instalador.

Desinstalación de Pro Tools en sistemas Windows
Para desinstalar Pro Tools en Windows:

1 Elige Inicio › Panel de control.
2 Haz clic enProgramas y características. 

3 Haz clic en Desinstalar un programa.

4 Selecciona Avid Pro Tools de la lista de aplicaciones instaladas.
5 Haz clic en Desinstalar.
6 Sigue las instrucciones en pantalla para eliminar el programa.

Ten en cuenta que deberás desinstalar los plug-ins (como los efectos de Avid), así como todos 
los drivers de dispositivos MIDI y de audio, por separado.
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Optimización de un sistema Mac para Pro Tools
Para garantizar el óptimo funcionamiento con Pro Tools, antes de usar el software Pro Tools, 
configura el ordenador.

Antes de configurar el ordenador, inicia sesión como administrador en la cuenta donde desees 
instalar Pro Tools. Para obtener información sobre los privilegios de administrador en Mac OS X, 
consulta la documentación de Apple OS X. 

Desactivación de la actualización de software

Para desactivar la función de actualización de software:

1 Elige Preferencias del Sistema en el menú Apple.
2 Haz clic en Actualización de Software.
3 Haz clic en la pestaña Búsquedas programadas.  
4 Anula la selección de Buscar actualizaciones.
5 Al finalizar, selecciona Preferencias del Sistema › Salir de Preferencias del Sistema.

Desactivación del economizador

Para desactivar la función de economizador:

1 Elige Preferencias del Sistema en el menú Apple.
2 Haz clic en Economizador.
3 Configura la opción Reposo del ordenador en Nunca.
4 Configura la opción Reposo del ordenador en Nunca.

No utilices la función de actualización automática del software de Mac OS X, ya que podría 
actualizar el  sistema con una versión de Mac OS que aún no se haya homologado para 
Pro Tools. Para obtener información sobre versiones homologadas de Mac OS, consulta la 
información de compatibilidad actualizada de nuestra página web (www.avid.com).
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5 Anula la selección de la opción Poner el disco en reposo cuando sea posible.
6 Al finalizar, selecciona Preferencias del Sistema › Salir de Preferencias del Sistema.

Desactivación o reasignación de los atajos de teclado de Mac que se utilizan 
en Pro Tools
Para poder utilizar todos los métodos abreviados de teclado de Pro Tools, debes desactivar o 
reasignar en las preferencias del sistema de Apple los métodos abreviados de teclado de Mac 
OS X que entren en conflicto con el software.

Desactivación o reasignación de los métodos abreviados de teclado que se utilizan en Pro Tools 
(Mac OS X Lion):

1 En el menú Apple, selecciona Preferencias del Sistema.
2 Haz clic en Teclado y ratón.
3 Haz clic en la pestaña Funciones rápidas de teclado.
4 Puedes deshabilitar o reasignar los atajos de teclado que entren en conflicto con los de Pro Tools. 
La siguiente lista incorpora varios atajos de teclados comunes que, según cual sea el modelo 
de tu Mac, también pueden ser utilizados por Pro Tools:
• En “Launchpad y Dock”

• “Ocultar y mostrar el Dock automáticamente”
• En “Mission Control”

• “Mission Control”

• “Ventanas de aplicación”

• “Mostrar escritorio”

• “Mostrar Dashboard”

• “Mission Control › Mover a la izquierda un espacio”

Para ver una lista completa de los métodos abreviados de teclado de Pro Tools, consulta 
la Guía de métodos abreviados de teclado (Help > Keyboard Shortcuts).
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• “Mission Control › Mover a la derecha un espacio”

• “Mission Control › Pasar al Escritorio n”
• En “Teclado y entrada de texto”

• “Mover el enfoque al cajón de la ventana”
• En “Servicios”

• “Enviar archivo a dispositivo Bluetooth”

• “Buscar con Google”

• “Spotlight”

• “Buscar páginas man en Terminal”
• En “Spotlight”

• “Mostrar el campo de búsqueda de Spotlight”

• “Mostrar la ventana de Spotlight”
• En “Acceso universal”

• “Zoom”

• “Contraste”
• En “Atajos de aplicaciones”

• “Mostrar el menú Ayuda”

Desactivación o reasignación de los métodos abreviados de teclado de Mac que se utilizan en Pro Tools 
(Mac OS X Snow Leopard):

1 En el menú Apple, selecciona Preferencias del Sistema.
2 Haz clic en Teclado y ratón.
3 Haz clic en la pestaña Funciones rápidas de teclado.
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4 Puedes deshabilitar o reasignar los atajos de teclado que entren en conflicto con los de Pro Tools. 
La lista siguiente incluye varios atajos de teclado comunes de Mac que también usa Pro Tools:
• En “Dashboard y Dock”

• “Ocultar y mostrar el Dock automáticamente”

• “Dashboard”
• En “Exposé y Spaces”

• “Todas las ventanas”

• “Ventanas de aplicación”

• “Escritorio”
• En “Teclado y entrada de texto”

• “Mover el enfoque al cajón de la ventana”
• En “Spotlight”

• “Mostrar el campo de búsqueda de Spotlight” 

• “Mostrar la ventana de Spotlight”
• En “Atajos de aplicaciones”

• “Mostrar el menú Ayuda”

Desactivación de los índices de Spotlight
La función Spotlight de Mac OS X indexa automáticamente los archivos y carpetas de los discos 
duros locales en segundo plano. En la mayoría de los casos, esto no supone un problema para 
el uso normal de Pro Tools. Sin embargo, si Spotlight comienza a indexar el contenido de las 
unidades de disco mientras se está grabando en una sesión de Pro Tools con muchas pistas 
durante un tiempo prolongado, puede afectar negativamente al rendimiento del sistema Pro Tools. 
Si piensas utilizar Pro Tools para proyectos de grabación de gran tamaño, es recomendable 
desactivar antes la indexación de las unidades locales de Spotlight.
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Para desactivar la función de indexación de Spotlight:

1 Elige Preferencias del Sistema en el menú Apple y haz clic en Spotlight.
2 En la ventana Spotlight, haz clic en la pestaña Privacidad.
3 Para evitar la indexación de una unidad, arrastra su icono del escritorio a la lista.

Activación del registro para las unidades de audio
Para conseguir un mejor rendimiento con unidades de audio, activa la función de registro.

Para activar la función de registro:

1 Inicia la aplicación Utilidad de disco, ubicada en Aplicaciones/Utilidades.
2 En la columna izquierda de la ventana Utilidad de disco, selecciona el volumen.
3 En la barra de herramientas, selecciona Activar registro.

Optimización de un sistema Windows para Pro Tools
Para asegurar un rendimiento óptimo con Pro Tools, configura el ordenador antes de utilizar 
el hardware y el software Pro Tools.

Antes de configurar el ordenador, inicia sesión como administrador en la cuenta donde desees 
instalar Pro Tools. Para obtener más información al respecto, consulta la documentación de 
Windows.

Al desactivar la indexación de Spotlight también se desactiva la función de búsqueda de 
Mac OS X. 

Para obtener la información más actualizada acerca de la configuración del sistema de 
Windows y para obtener información acerca de ordenadores específicos, visita la página 
web de Avid (www.avid.com).
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Optimizaciones obligatorias
Para asegurar un rendimiento óptimo con Pro Tools, configura los parámetros siguientes antes 
de utilizar el hardware y el software Pro Tools.

Desactivación del Control de cuentas de usuario

Para desactivar el Control de cuentas de usuario:

1 Elige Inicio › Panel de control.
2 Haz clic en Cuentas de usuario y protección infantil.
3 Haz clic en Cuentas de usuario.
4 Haz clic en Cambiar configuración de Control de cuentas de usuario.
5 Coloca el control deslizante en No notificar nunca.
6 Haz clic en Aceptar.

Configuración de inactividad del sistema y administración de energía
Cuando utilices Pro Tools, establece la opción de energía de modo de espera de Windows en 
Siempre activo. De este modo, se evita que se detengan los pases de grabación y reproducción 
prolongados porque el sistema entra en el modo de ahorro de energía.

Para configurar Administración de energía de Windows:

1 Elige Inicio › Panel de control.
2 Haz clic en Sistema y seguridad.
3 Haz clic en Opciones de energía.
4 Haz clic en la flecha para Mostrar planes adicionales.
5 Selecciona Alto rendimiento.

Cuando hayas terminado de cambiar la configuración del sistema Windows, reinicia el 
ordenador.
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6 Haz clic en Cambiar la configuración del plan.
7 Haz clic en Cambiar la configuración avanzada de energía.
8 En el cuadro de diálogo Opciones de energía, abre Disco duro › Apagar disco duro tras.
9 Haz clic en la opción Configuración.
10 Selecciona el valor en el campo Configuración (minutos) y pulsa la tecla Retroceso en el 
teclado o lleva el valor a Nunca.
11 Haz clic en Aceptar. La configuración del disco duro cambia a Nunca y se cierra el cuadro de 
diálogo Opciones de energía.
12 En la ventana Editar la configuración del plan, haz clic en Guardar cambios y cierra la ventana.

Optimizaciones recomendadas
Otros drivers de hardware y software que estén instalados en el ordenador también pueden afectar 
a Pro Tools. Para obtener un rendimiento óptimo, se recomienda (aunque no es imprescindible) 
que hagas lo siguiente:

• Evita la ejecución simultánea de otros programas innecesarios al mismo tiempo que Pro Tools.

• Cierra las utilidades de software que se ejecuten en segundo plano, por ejemplo, Windows 
Messenger, calendarios y programas de mantenimiento de discos. 

• Mientras utilizas Pro Tools, apaga todos los dispositivos USB que no sean imprescindibles.

Pro Tools cambia automáticamente a la opción de administración de energía “Alto 
rendimiento” al iniciarse. Windows regresa a la opción de administración de energía 
seleccionada anteriormente (si la hubiere) al salir de Pro Tools. Por consiguiente, al optimizar 
la opción de administración de energía para Pro Tools, siempre se debería optimizar 
únicamente la configuración de Alto rendimiento.
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Optimizaciones opcionales
Las siguientes optimizaciones del sistema pueden contribuir a un mejor funcionamiento de 
Pro Tools en algunos sistemas. Se recomienda usar estas optimizaciones solamente cuando 
sea necesario, ya que pueden desactivar otros programas del sistema o repercutir negativamente 
en su funcionamiento.

Ajuste de la programación del procesador

Para ajustar el rendimiento de la programación del procesador:

1 Haz clic con el botón derecho del ratón en Mi PC y selecciona Propiedades.
2 Haz clic en Configuración avanzada del sistema.
3 En el área Rendimiento, haz clic en el botón Configuración.
4 En la ventana Opciones de rendimiento, haz clic en la pestaña Opciones avanzadas.
5 En Programación del procesador, selecciona Servicios en segundo plano.
6 Haz clic en Aceptar para cerrar la ventana Opciones de rendimiento.
7 Haz clic en Aceptar para cerrar la ventana Propiedades del sistema.

Desactivación de los elementos de inicio del sistema
Cuantos menos elementos utilice el ordenador, más recursos habrá disponibles para Pro Tools. 
Algunas aplicaciones que se inician automáticamente al arrancar el sistema pueden estar 
consumiendo recursos de la CPU innecesariamente y pueden desactivarse. 

Ten cuidado si desactivas alguno de los elementos de inicio siguientes:
• Número de serie de medio portátil (necesario para algunas aplicaciones que utilizan una 

clave de protección anticopia)

• Servicio Plug and Play

• Registro de eventos

• Servicios de cifrado
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Para desactivar los elementos de inicio del sistema:

1 En el menú Inicio, escribe “msconfig” en Ejecutar y haz clic en Aceptar para abrir la Utilidad 
de configuración del sistema.
2 En la pestaña General, elige Inicio selectivo.
3 Anula la selección de Cargar elementos de inicio y haz clic en Aceptar.
4 Haz clic en Reiniciar para volver a iniciar el ordenador.
5 Tras reiniciar, el ordenador mostrará un mensaje de configuración del sistema. Comprueba 
si ha mejorado el rendimiento de Pro Tools antes de anular la selección de la casilla “No volver 
a mostrar este mensaje”. Si no se observa ninguna mejora en el rendimiento, ejecuta “msconfig” 
y vuelve a establecer Selección de inicio en Inicio normal: cargar todos los controladores de dispositivo 

y servicios. También puedes desactivar los elementos de inicio y los procesos que no sean 
imprescindibles de uno en uno.

Copias de seguridad del sistema
Tras configurar el sistema e instalar Pro Tools, debes guardar una imagen de la unidad del 
sistema con una utilidad de copia de seguridad. De este modo, podrás restaurar rápidamente 
la configuración del sistema en caso de producirse algún problema.
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Pro Toolsソフトウェアをインストールする

Avidの Pro Tools®へようこそ。本ガイドでは、Pro ToolsソフトウェアをMacおよびWindowsシス
テムにインストールし、オーソライズする方法について説明します。Pro Toolsシステムの設定方法
と Pro Toolsシステムの性能と機能について詳しくは、『Pro Toolsリファレンス・ガイド』（Pro Tools
の［ヘルプ］メニュー）をご参照ください。

Pro Toolsシステムには 4種類あります。
Pro Toolsソフトウェア
このシステムには、Pro Toolsソフトウェアと共に、Avid 003™または Digi 002®ファミリーのオー
ディオ・インターフェイス、Eleven® Rack、Mbox®またはMbox 2ファミリーのオーディオ・イン
ターフェイス、またはM-Audioハードウェアを使用するシステムが含まれます。Pro Toolsソフト
ウェアと共に Core Audio（Mac）または ASIO（Windows）ドライバー対応のサードパーティ製オー
ディオ・インターフェイスを使用するシステムも含まれます。

ハードウェア・アクセラレーションを使用したPro Tools HDソフトウェア
ハードウェア・アクセラレーションを使用した Pro Tools HDシステムには、Pro Tools HDソフト
ウェアと共に、Avid HDX、Pro Tools|HD、またはHD Nativeハードウェアを使用するシステムが
含まれます。ハードウェア・アクセラレーションを使用したシステムは、拡張 I/O機能と低レイテン
シー・モニタリングを提供します。Pro Tools HDソフトウェアと Avid HDXまたは Pro Tools|HD
ハードウェアの組み合わせでは、プラグイン・プロセッシングおよびより大型のミキサー構成用の
専用 DSPも提供します。
Pro Tools HDソフトウェアおよびComplete Production Toolkitを使用したPro Toolsソフ
トウェア
これらのシステムには、Pro Tools HDソフトウェアまたは Pro Toolsソフトウェアと共に、Complete
Production ToolkitオプションおよびAvid/Core Audio/ASIOハードウェアを使用するシステムが含
まれます。

Pro Tools Expressソフトウェア
これらのシステムには、Pro Tools  Expressソフトウェアと共にMboxファミリーのオーディオ・
インターフェイス（第 3世代）を使用するシステムが含まれます。（詳しくは、『Pro Toolsリファレ
ンス・ガイド』をご参照ください。）

要件を満たしたオーディオ・インターフェイスとコンピューターの一覧については、Avid
ウェブサイト（www.avid.com/compatibility）をご覧ください。
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システム要件と互換性
Pro Toolsは、要件を満たすWindowsまたはMacコンピューター上で、動作検証済みのオーディオ・
インターフェイスと組み合わせて使用できます。

Pro Toolsインストーラー・ディスクを使用するには DVDドライブが必要です。

Pro Toolsインストーラーをダウンロードするにはインターネット接続が必要です。

Avidは、動作確認が行われたハードウェアとソフトウェアに対してのみ互換性を保証し、サポート
を提供します。

完全なシステム要件および要件を満たすコンピューター、オペレーティング・システム、ハード・
ドライブ、サードパーティ製機器のリストについては、次のウェブサイトをご覧ください。

www.avid.com/compatibility

オーソライズ済み iLok
標準の Pro Toolsソフトウェア・パッケージには、Pro Toolsソフトウェア用のオーソライズ済み
iLokが 1つ同梱されています。Pro Toolsを伴うハードウェア・パッケージには、オーソライズさ
れていない iLokが 1つと、Pro Toolsのオーソライズ用のアクティベーション・コードが 1つ同梱
されています。詳しくは、103 ページの「Pro Toolsをオーソライズする」をご参照ください。

MIDIの要件
USB、FireWire、PCIのMIDIインターフェイスは、MacまたはWindowsコンピューター上の Pro Tools
システムと共に効率的に動作します。シリアル方式のMIDIインターフェイスは、Windowsシステ
ムでのみサポートされています。

Pro Toolsを起動する際には、オーソライズ済み iLokをコンピューターのUSBポートに差
し込んでおく必要があります。

対応MIDIインターフェイスとコントローラーの一覧については、www.avid.comをご覧く
ださい。
 Pro Toolsソフトウェアをインストールする102

http://www.avid.com/compatibility
http://www.avid.com


ハードディスクの要件
オーディオのレコーディングとプレイバックを最適に行うには、すべての Pro Toolsシステムに、
要件を満たす 1つまたは複数のハードディスクが必要です。
［ディスクユーティリティ］（Mac）または［ディスクの管理］（Windows）を使用し、ハードディス
クを初期化します。

システム・ドライブへはレコーディングしない
システム・ドライブへのレコーディングは可能ですが、推奨されません。システム・ドライブ上で
レコーディングやプレイバックを行うと、使用できるトラックやプラグインの数が少なくなる場合
があります。

Pro Toolsをオーソライズする
Pro Toolsソフトウェアは、PACE Anti-Piracyの iLok USBスマート・キー（iLok）を使用してオー
ソライズします。このキー 1つで、100以上の iLok対応ソフトウェアすべてをオーソライズできます。
iLokが目的のソフトウェア用にオーソライズされると、任意のコンピューター上でそのソフトウェ
アをオーソライズできるようになります。

最適なパフォーマンスを得るためには、DigiBaseで再生または転送用のみのボリュームと
してシステム・ドライブを指定するとよいでしょう。詳しくは、『Pro Toolsリファレンス・
ガイド』をご参照ください。

iLok USBキー

Pro Toolsのオーソリゼーションは、新しいバージョンの iLok（上図）または以前のバー
ジョンの iLokを使用して保存できます。
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Pro Tools HDのオーソリゼーション
Pro Tools HDのオーソリゼーションにより、Avid HDX、Pro Tools|HD、または Pro Tools|HD Native
ハードウェアの有無に関係なく、要件を満たすMacまたはWindowsコンピューター上で Pro Tools
HDソフトウェアを使用できます。また、Pro Tools HDのオーソリゼーションにより、Avidの要件
を満たすオーディオ・インターフェイス（Mbox Proや Fast Trackなど）または対応 Core Audio
（Mac）および ASIO（Windows）デバイス・ドライバーを使用するサードパーティ製オーディオ・
インターフェイスでも Pro Tools HDを使用できます。

Pro Toolsのオーソリゼーション
また、Pro Toolsのオーソリゼーションにより、Avidの要件を満たすオーディオ・インターフェイス
（Mbox Proや Fast Trackなど）または対応 Core Audio（Mac）および ASIO（Windows）デバイス・
ドライバーを使用するサードパーティ製オーディオ・インターフェイスと共にMacまたはWindows
コンピューター上で Pro Toolsソフトウェアを使用できます。

Complete Production Toolkitのオーソリゼーション
Complete Production Toolkitと Pro Toolsの両方のオーソリゼーションにより、Complete Production
Toolkit 2の機能を Pro Toolsソフトウェアで使用できます。Pro Tools用 Complete Production Toolkit
ソフトウェア・オプションは、さらに多くのボイス数とトラック数、および Pro Tools HDと同等
のサラウンド・ミキシング、編集、オートメーション機能を提供します。

Pro Toolsオーソリゼーションでは、Pro Tools HDソフトウェアを動作させることはでき
ません。Pro Tools HDをオーソライズしないでHDX、Pro Tools|HD、またはHD Native
を使用したシステム上で Pro Toolsソフトウェアを起動した場合、内蔵サウンドまたは他の
オーディオ・インターフェイスで Core Audioまたは ASIOを使用することはできますが、
HDX、Pro Tools|HD、または HD Nativeハードウェアを使用することはできません。

Complete Production Toolkitについて詳しくは、『Complete Production Toolkitガイド』
または『Pro Toolsリファレンス・ガイド』をご参照ください。
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アクティベーション・コードを使用して iLokをオーソライズする
新規でパッケージ版の Pro Toolsソフトウェアをご購入の場合、オーソライズ済みの iLokが同梱さ
れています。本セクションを飛ばし、106 ページの「Pro Toolsをインストールする」に進んでくだ
さい。

新規で Avid HDX、Pro Tools|HD、または HD Nativeシステムをご購入の場合、Pro Tools HDソフ
トウェアのオーソライズ用の空の iLokとアクティベーション・コード（付属のアクティベーション・
カードに記載）が同梱されています。以下のオーソライズ手順に従ってください。

以前のバージョンの Pro Toolsソフトウェアからアップグレードした場合、ご使用の iLok上でソフ
トウェア・アップグレードをオーソライズするためのアクティベーション・コード（付属のアクティ
ベーション・カードに記載）が同梱されています。以下のオーソライズ手順に従ってください。

アクティベーション・コードを使用してPro Toolsソフトウェアをオーソライズするには：

1 iLok.comのアカウントをお持ちでない場合は、www.iLok.com にアクセスしてアカウントを作成
します。

2 次の方法で、ソフトウェアのライセンスを iLok.comのアカウントに転送します。
• www.avid.com/activationcard を開きます。

および

• アクティベーション・コード（アクティベーション・カードに記載）と iLok.comのユーザー ID
を入力します。iLok.comのユーザー IDは、iLok.comのアカウント作成時に入力した名前です。

3 次の方法で、iLok.comのアカウントのライセンスを iLok USBスマート・キーに転送します。
• iLokをコンピューターの USBポートに差し込みます。
• www.iLok.com を開いてログインします。
• 画面上の指示に従ってライセンスを iLokに転送します。

詳しくは、iLokウェブサイト（www.iLok.com）をご覧ください。
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Pro Toolsをインストールする

インストレーションの概要
Pro Toolsのインストール手順は以下のとおりです。
1 106 ページの「ハードウェアのドライバーをインストールする」。
2 107 ページの「Pro Toolsソフトウェアをインストールする」。
3 110 ページの「Avid Virtual Instrumentsをインストールする」（オプション）。
4 112 ページの「Pro Toolsを起動する」。
5 システムを設定してパフォーマンスを向上させる（『Pro Toolsリファレンス・ガイド』参照）。
6 オーディオ・インターフェイスのオーディオ接続を行う。（オーディオ・インターフェイスに付属
のマニュアルをご参照ください。）

ハードウェアのドライバーをインストールする
Pro Toolsソフトウェアをインストールする前に、オーディオ・ハードウェアが正しくインストール
されており、ご使用のハードウェア用の最新ドライバーがインストールされていることを確認して
ください。詳しくは、ご使用のハードウェアに付属の説明書をご参照ください。Avidのオーディオ・
インターフェイスの場合、Pro Toolsインストーラー・パッケージに付属のドライバー・インストー
ラー・ディスクにあるドライバー・インストーラーを使用してドライバーをインストールするか、
www.avid.comから最新のドライバーをダウンロードしてインストールします。

Pro Toolsをアップグレードする場合、以前のバージョンの Pro Toolsをコンピューターか
らアンインストールしておく必要があります。114 ページの「Pro Toolsをアンインストー
ルする」をご参照ください。

Avid HDX、Pro Tools|HD、HD Nativeハードウェアの場合のみ、Pro Toolsインストー
ラーは必要なハードウェア・ドライバーを自動的にインストールします。

ドライバーがインストールされていないと、Pro Toolsはご使用のオーディオ・インター
フェイスを認識しません。Pro Toolsをアップグレードする場合は、必ずご使用のハード
ウェア用の最新のドライバーをインストールしてください。
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Pro Toolsソフトウェアをインストールする
オーディオ・インターフェイスのドライバーのインストールが完了したら、Pro Toolsをインストー
ルできます。

Pro Toolsをインストールするには：

1 Pro Toolsをインストールするアカウントに管理者としてログインしていることを確認します。
2 以下のいずれかを行います。
• Pro Toolsインストーラー・ディスクをDVDドライブに挿入します。

または

• Pro Toolsインストーラーをオンラインでダウンロードします。
3 以下のいずれかを行います。
• Macの場合、［Install Pro Tools.mpkg］をダブルクリックします。
• Windowsの場合、以下のいずれかを行います。

• Windows AutoRunが有効の場合、ミニブラウザーが表示されます。［Install Pro Tools］を選択し、
インストールを開始します。

または

• Windows AutoRunが無効の場合、［Setup.exe］をダブルクリックしてから［Install Pro Tools］
を選択してインストールを開始します。

 

このバージョンの Pro Toolsをインストールする前に、付属の『お読みください』をご参照
ください。

Windowsで［ユーザー アカウント制御］ダイアログが表示された場合は、［許可］をクリッ
クします。インストール中にWindowsに表示される［新しいハードウェアの検出］ダイア
ログや「ハードウェアのインストール中に問題が発生しました」などのメッセージは無視
してかまいません。また、「ドライバーがWindows Logoテストをパスしない」といったよ
うな警告メッセージが表示された場合も［続行］をクリックします。
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4 画面上の指示に従ってインストレーションを続けます。

5［インストール タイプ］ページで、以下のいずれかの操作を行います。
• すべての Pro Tools アプリケーション・ファイルと無償プラグイン・スイート（および関連のコン
テンツ）をインストールするには、デフォルトのインストール・オプションを選択したままにして、
［続行］（Continue）をクリックします。

または

• インストール・オプションのカスタム構成（108 ページの「インストレーション・オプション」参照）
を選択（または選択解除）して、［続行］をクリックします。

6［インストール］（Install）をクリックします。

7 メッセージが表示されたら、管理者パスワードを入力し、［OK］をクリックしてインストールを承
認します。

8 画面上のその他の指示に従います。

9 インストレーションが完了したら、［再起動］（Mac）または［完了］（Windows）をクリックします。

インストレーション・オプション
Pro Tools 10のオプション
Pro Toolsソフトウェアとプラグインの一部をインストールするには、インストーラーのPro Tools 10
オプション用表示三角形をクリックし、インストールしたくないオプションの選択を解除します。

［アプリケーション ファイル］（Application Files）（Pro Toolsに必須） Pro Toolsアプリケーショ
ンと Pro Toolsの実行に必要なサポート・ライブラリー・ファイルをインストールします。Pro Tools
をインストールする場合は必ずこのオプションを選択してください。

［Avid Effects］ 無償の Avid Audio Effectsプラグインをインストールします。詳しくは、『オー
ディオ・プラグイン・ガイド』をご参照ください。

［Pro Toolsユーティリティ］（Pro Tools Utilities） ［DigiTest］や［Uninstall Pro Tools］（Macのみ）
などの Pro Toolsのユーティリティをインストールします。

Pro Toolsインストーラー・ディスクには、システム用の追加ソフトウェアが収録されてい
ます。詳しくは、113 ページの「Pro Toolsインストーラー・ディスクに収録されている追加
ソフトウェア」をご参照ください。
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追加オプション
Pro Toolsインストーラーには、Pro Toolsソフトウェアとプラグインのほか、次に示すその他のオ
プションをインストールすることができます。

［Mac HFS+ディスク サポート オプション］（Mac HFS+ Disk Support Option）（Windows
のみ） このオプションでは、Mac形式のHFS+ディスクを使用して Pro Toolsシステムでの読み取り、
書き込み、録音、プレイバックが可能です。HFS+ディスクは一般的にMac OS Extendedディスク
とも呼ばれます。詳しくは、『Pro Toolsリファレンス・ガイド』をご覧ください。
［Avidビデオ エンジン］（Avid Video Engine） Avidビデオ・エンジンは、AvidMojo® SDIなどの

Avidビデオ機器と共に Pro Toolsを使用する際に必要です。詳しくは、『Avidビデオ機器ガイド』
をご覧ください。

システムの起動とシャットダウン
Pro Toolsシステムのコンポーネントが互いに正しく通信するためには、決まった順序で電源を入れ
る必要があります。

Pro Toolsシステムを起動するには：

1 すべての装置（コンピューターを含む）がオフになっていることを確認します。

2 システム内のすべての出力機器のボリュームを下げます。

3 拡張シャーシを使用しているシステムの場合は、まず拡張シャーシの電源を入れます。

4 外付けハードディスクの電源を入れます。ハードディスクが規定の回転速度に到達するまで約 10
秒待ちます。

5 コントロール・サーフェスの電源を入れます。

6 MIDIインターフェイス、MIDIデバイス、または同期機器を使用している場合は、その電源を入
れます。

7 外部電源を必要とするシステムの場合、ハードウェア（HD I/Oや 003など）の電源を入れます。
オーディオ・インターフェイスが初期化され、ステータス LEDの点滅が停止するまで、少なくとも
15秒間待ちます。
8 コンピューターの電源を入れます。

9 Pro Tools（112 ページの「Pro Toolsを起動する」参照）またはサードパーティ製オーディオ・
アプリケーションやMIDIアプリケーションを起動します。
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Pro Toolsシステムをシャットダウンするには：

1 Pro Toolsとその他のアプリケーションを終了します。

2 システムの出力機器のボリュームを下げるか、電源を切ります。

3 コンピューターの電源を切ります。

4 外部電源を必要とするハードウェアを使用しているシステムの場合、ハードウェアの電源を切り
ます。

5 すべての Pro Toolsオーディオ・インターフェイスの電源を切ります。
6 拡張シャーシを使用しているシステムの場合は、拡張シャーシの電源を切ります。

7 MIDIインターフェイス、MIDI機器、同期機器を使用している場合は、その電源を切ります。
8 コントロール・サーフェスまたはワークサーフェスの電源を切ります。

9 外付けハードディスクの電源を切ります。

Avid Virtual Instrumentsをインストールする
Avidは、Pro Toolsと共に使用する無償バーチャル・インストゥルメント・プラグインとサンプル・
コンテンツを提供しています。詳しくは、『オーディオ・プラグイン・ガイド』をご参照ください。

Avid Virtual Instrumentsをインストールするには：

1 Avid Virtual Instrumentsをインストールするアカウントに管理者としてログインしていること
を確認します。

2 以下のいずれかを行います。
• Pro Toolsインストーラー・ディスクをDVDドライブに挿入します。

または

• Avid Virtual Instrumentsインストーラーと関連コンテンツをオンラインでダウンロードします。

Pro Toolsを終了するには、［Pro Tools］ > ［終了］（Quit）（Mac）または［ファイル］
（File） > ［終了］（Exit）（Windows）を選択します。
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3 以下のいずれかを行います。
• Macでは、［Install Avid Virtual Instruments.mpkg］をダブルクリックします。
• Windowsの場合、以下のいずれかを行います。

• ディスクからインストールする場合、Windows AutoRunが有効であれば、ミニブラウザーが表
示されます。［Install Avid Virtual Instruments］を選択してインストールを開始します。

• ディスクからインストールする場合、Windows AutoRunが無効であれば、［Setup.exe］をダブ
ルクリックしてから［Install Avid Virtual Instruments］を選択してインストールを開始します。

• Avid Virtual Instrumentsインストーラーをダウンロードした場合は、［Avid Virtual Instruments.exe］
を実行します。

4 画面上の指示に従ってインストレーションを続けます。

5［インストール］（Install）をクリックします。

6 メッセージが表示されたら、管理者パスワードを入力し、［OK］をクリックしてインストールを承
認します。

7 画面上のその他の指示に従います。

8 インストールが完了したら、［閉じる］（Mac）または［終了］（Windows）をクリックします。

バーチャル・インストゥルメントのコンテンツはファイル・サイズが非常に大きく、イン
ストールに 20分程度かかることがあります。インストール中、進捗バーが止まっているよ
うに見えることがありますが、実際にはインストールは進行しています。インストールを
終了しないでください。
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Pro Toolsを起動する
Pro Toolsソフトウェアを使用するには、インストールされている Pro Toolsのバージョンをオーソ
ライズしているライセンス用の iLokが必要です（詳しくは 103 ページの「Pro Toolsをオーソライ
ズする」をご参照ください）。

Pro Toolsソフトウェアを起動するには：

1 オーディオ・インターフェイスがコンピューターに接続されており、電源が入っていることを確認
します。

2 オーソライズされた iLokをコンピューターのUSBポートに差し込みます（103 ページの「Pro Tools
をオーソライズする」参照）。

3 以下のいずれかを行います。
• Macの場合、Dockの［Pro Tools］ショートカットをクリックします（または、［Macintosh HD］/
［アプリケーション］/［Avid］/［Pro Tools］のアプリケーション・アイコンをダブルクリックします）。
または

• Windows の場合、デスクトップの［Pro Tools］ショートカット（または、［Program Files］\
［Avid］\［Pro Tools］のアプリケーション・ファイル）をダブルクリックします。

4［クイック スタート］ダイアログを使って以下のいずれかを行います。
• テンプレートから新規セッションを作成する。
• 空の新規セッションを作成する。
• システムにある他のセッションを開く。

Pro Toolsの起動中または使用中に iLokを取り外さないでください。

［クイック スタート］ダイアログとセッションのテンプレートについて詳しくは、
『Pro Toolsリファレンス・ガイド』をご参照ください。
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Pro Toolsシステムを設定する
Pro Toolsソフトウェアのインストール、オーソライズ、起動が完了したら、ご使用の Pro Tools
システムをスタジオのニーズに合わせて設定できます。Pro Toolsソフトウェアの設定方法について
詳しくは、『Pro Tools リファレンス・ガイド』（Pro Toolsの［ヘルプ］メニュー）をご参照ください。

Pro Toolsインストーラー・ディスクに収録されている追加ソフト
ウェア
Pro Toolsインストーラー・ディスクにより、ご使用の Pro Toolsシステム用の追加説明書とソフト
ウェアが［Additional Files］フォルダーにインストールされます。

ドキュメンテーション
［Documentation］フォルダーには、Pro Toolsソフトウェア、ハードウェア、プラグイン、オプショ
ンに関する説明書の PDF版が含まれています。

テクニカル・サポート
［Tech Support］フォルダーには、Pro Toolsシステムのトラブルシューティング用の説明書の PDF版、
オンライン・リソース情報、Pro Toolsセッションが含まれています。

オプションのインストーラー
［Optional Installers］フォルダーには、Pro Toolsソフトウェア・オプション用のインストーラーが
含まれており、別途購入してオーソライズできます。

HEAT
（Avid HDXおよびPro Tools|HDシステムのみ）

HEAT（Harmonically Enhanced Algorithm Technology）は有償ソフトウェア・オプションで、
Pro Tools HDXおよび Pro Tools|HDシステムを使用した Pro Tools HDに「アナログ色」を追加で
きます。HEATについて詳しくは、『HEATソフトウェア・オプション・ガイド』をご参照ください。
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Pro Toolsデモ・セッション
Pro Toolsインストーラー・ディスクにはデモ・セッションが収録されており、システムが正しく動
作しているかどうかを確認することができます。

デモ・セッションをインストールするには：

1 Pro Toolsインストーラー・ディスクを DVDドライブに挿入します。
2 Pro Toolsインストーラー・ディスクの［Additional Files］フォルダーを開きます。
3［Pro Tools Demo Session］フォルダーを適切なオーディオ・ドライブにコピーします。
4 デモ・セッションを開きます。

Pro Toolsをアンインストールする
コンピューターから Pro Toolsソフトウェアを削除する必要がある場合、Macでは［Uninstaller］アプ
リケーションを、Windowsでは［コントロール パネル］を使用します。

MacでPro Toolsをアンインストールする
MacでPro Toolsをアンインストールするには：

1 Pro Toolsがインストールされているアカウントに管理者としてログインしていることを確認します。
2［アプリケーション］/［Avid］/［Pro Tools］/［Pro Tools Utilities］へ移動し、［Uninstall Pro Tools］
をダブルクリックします。

3［続ける］（Continue）をクリックしてアンインストールを続けます。

4 実行するアンインストールのタイプを選択します。

［セーフ アンインストール］（Safe Uninstall） 一部のAvid製品との互換性の維持に必要となる特定
のプラグインとシステム・ファイルを残します。Avidアプリケーションを使用している場合や CS
（カスタマー・サポート）リリースにアップデートする場合は、［セーフ アンインストール］を選択
します。

［クリーン アンインストール］（Clean Uninstall） システム・ファイル、Avid プラグイン、MIDI
パッチ名など、すべての Pro Toolsファイルを削除します。アップグレードを行う場合やトラブル
シューティングを行う場合は、［クリーン アンインストール］を選択してください。
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5［アンインストール］（Uninstall）をクリックします。

6 管理者パスワードを入力し、［OK］をクリックします。

7［完了］（Finish）をクリックし、インストーラーのウィンドウを閉じます。

WindowsでPro Toolsをアンインストールする
WindowsでPro Toolsをアンインストールするには：

1［スタート］ > ［コントロール パネル］を選択します。

2［プログラムと機能］ をクリックします。

3［プログラムのアンインストール］をクリックします。

4 インストールされているアプリケーションのリストから［Avid Pro Tools］を選択します。
5［アンインストール］をクリックします。

6 画面の指示に従って、Pro Toolsを削除します。

プラグイン（Avid Effectsなど）、およびオーディオとMIDIのデバイス・ドライバーは別途
アンインストールする必要があります。
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Pro Toolsに対してMacシステムを最適化する
Pro Toolsで最適のパフォーマンスを得られるようにするには、まずコンピューターの設定を行います。
コンピューターを設定する前に、Pro Toolsをインストールするアカウントに管理者としてログイン
していることを確認してください。Mac OS Xの管理者権限について詳しくは、Apple OS Xの説明
書をご参照ください。

ソフトウェア・アップデートをオフにする

 ソフトウェア・アップデート機能をオフにするには：

1 Appleメニューから［システム環境設定］を選択します。
2［ソフトウェアアップデート］をクリックします。

3［アップデート確認と予約設定］タブをクリックします。

4［アップデートの確認］の選択を解除します。

5 設定が完了したら、［システム環境設定］ > ［システム環境設定を終了］を選択します。

［省エネルギー］をオフにする

［省エネルギー］機能をオフにするには：

1 Appleメニューから［システム環境設定］を選択します。
2［省エネルギー］をクリックします。

3［コンピュータのスリープ］設定を［しない］にします。

4［ディスプレイのスリープ］設定を［しない］にします。

5［可能な場合はハードディスクをスリープさせる］オプションの選択を解除します。

6 設定が完了したら、［システム環境設定］ > ［システム環境設定を終了］を選択します。

Mac OS Xの自動ソフトウェア・アップデート機能は使用しないでください。アップデート
により、ご使用のシステムが Pro Toolsの要件を満たさないMac OSのバージョンへとアッ
プグレードされてしまう場合があります。要件を満たすMac OSのバージョンについて詳し
くは、弊社のウェブサイトの最新の互換情報（www.avid.com）をご覧ください。
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Pro Toolsが使用するMacのキーボード・ショートカットを無効にするか再割り当てする
Pro Toolsのキーボード・ショートカットをすべて使用するには、コンフリクトを起こすMac OS X
のキーボード・ショートカットを Appleの［システム環境設定］で無効にするか再割り当てする必
要があります。

Pro Toolsで使用するMacキーボード・ショートカットを無効にするか再割り当てするには
（Mac OS X Lion）：

1［Apple］メニューから［システム環境設定］を選択します。
2［キーボード］をクリックします。

3［キーボードショートカット］タブをクリックします。

4 Pro Toolsキーボード・ショートカットとコンフリクトを起こすMac OSのキーボード・ショート
カットは無効にするか再割り当てできます。以下に、Macの型とモデルによっては Pro Toolsキー
ボード・ショートカットとコンフリクトを起こす可能性のあるMacのキーボード・ショートカット
を示します。
•［LaunchpadとDock］の下

•［Dockを自動的に隠す機能の入／切］
•［Mission Control］の下

•［Mission Control］
•［アプリケーションのウィンドウ］
•［デスクトップを表示］
•［Dashboardを表示］
•［Mission Control］ > ［左の操作スペースに移動］
•［Mission Control］ > ［右の操作スペースに移動］
•［Mission Control］ > ［デスクトップ nへ切り替え］

•［キーボードと文字入力］の下
•［ウインドウの引き出しパネルを操作対象にする］

Pro Toolsのキーボード・ショートカットの完全なリストについては、『キーボード・ショー
トカット・ガイド』（［ヘルプ］ > ［キーボードショートカット］）をご参照ください。
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•［サービス］の下
•［Bluetoothデバイスにファイルを送信］
•［Googleで検索］
•［Spotlight］
•［manページをターミナルで検索］

•［Spotlight］の下
•［Spotlight検索フィールドを表示］
•［Spotlightウィンドウを表示］

•［ユニバーサルアクセス］の下
•［拡大／縮小］
•［コントラスト］

•［アプリケーション］の下
•［ヘルプメニューを表示］

Pro Toolsで使用するMacキーボード・ショートカットを無効にするか再割り当てするには
（Mac OS X Snow Leopard）：

1［Apple］メニューから［システム環境設定］を選択します。
2［キーボード］をクリックします。

3［キーボードショートカット］タブをクリックします。

4 Pro Toolsキーボード・ショートカットとコンフリクトを起こすMac OSのキーボード・ショート
カットは無効にするか再割り当てできます。以下に、Pro Toolsキーボード・ショートカットとコン
フリクトを起こす可能性があるMacキーボード・ショートカットを示します。
•［DashboardとDock］の下

•［Dockを自動的に隠す機能の入／切］
•［Dashboard］

•［Exposéと Spaces］の下
•［すべてのウィンドウ］
•［アプリケーションのウィンドウ］
•［デスクトップ］
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•［キーボードと文字入力］の下
•［ウインドウの引き出しパネルを操作対象にする］

•［Spotlight］の下
•［Spotlight検索フィールドを表示］ 
•［Spotlightウィンドウを表示］

•［アプリケーション］の下
•［ヘルプメニューを表示］

Spotlightの索引付けをオフにする
Mac OS Xの Spotlight機能は、ローカル・ドライブ上のファイルとフォルダーに索引を付けます。
これはバックグラウンドで自動的に行われます。ほとんどの場合、これが Pro Toolsの動作に対して
問題となることはありません。ただし、トラック数の多い Pro Toolsセッションを長時間レコーディン
グしているときに Spotlightがドライブの索引付けを始めると、Pro Toolsシステムの処理能力に悪
影響を与える可能性があります。Pro Toolsを使って大規模なレコーディングを行うときは、ローカ
ルのすべてのドライブに対する Spotlightの索引付けをオフにしておく方がよいでしょう。

Spotlightの索引付けをオフにするには：

1 Appleメニューから［システム環境設定］を選択し、［Spotlight］ をクリックします。

2［Spotlight］ウィンドウの［プライバシー］タブをクリックします。
3 ドライブの索引付けを防ぐには、ドライブのアイコンをデスクトップからリストへとドラッグします。

オーディオ・ドライブのジャーナリングを有効にする
オーディオ・ドライブのパフォーマンスを向上させるには、ジャーナリングを有効にします。

ジャーナリングを有効にするには：

1［アプリケーション］/［ユーティリティ］フォルダーの中にある［ディスクユーティリティ］アプ
リケーションを起動します。

2［ディスクユーティリティ］ウィンドウの左の欄にあるボリュームを選択します。

3 ツールバーの［ジャーナル記録を開始］を選択します。

Spotlightの索引付けをオフにすると、Mac OS Xの［検索］機能もオフになります。
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Pro Toolsに対してWindowsシステムを最適化する
Pro Toolsで最適のパフォーマンスを得られるようにするには、まずコンピューターの設定を行います。
コンピューターを設定する前に、Pro Toolsをインストールするアカウントに管理者としてログイン
していることを確認してください。管理者権限について詳しくは、Windowsの説明書をご参照くだ
さい。

必須の最適化
Pro Toolsの処理能力を最大にするために、Pro Toolsハードウェアとソフトウェアを使用する前に
以下の設定を行います。

ユーザー・アカウント制御を無効にする

ユーザー・アカウント制御（UAC）を無効にするには：

1［スタート］ > ［コントロール パネル］を選択します。

2［ユーザー アカウントと家族のための安全設定］をクリックします。

3［ユーザー アカウント］をクリックします。

4［ユーザー アカウント制御設定の変更］をクリックします。

5 スライダーを［通知しない］に設定します。

6［OK］をクリックします。

システム・スタンバイと電源管理を設定する
Pro Toolsを使用するときは、Windowsの［システム スタンバイ］電源設定を［なし］に設定する必
要があります。これで、システムの電源がオフになることによる長いレコーディング・パスまたは
プレイバック・パスの停止を防ぐことができます。

Windowsのシステム設定の最新情報と特定のコンピューターに関する情報については、
Avidのウェブサイト（www.avid.com）をご覧ください。

Windowsのシステム設定が完了したら、コンピューターを再起動します。
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Windowsの電源設定を変更するには：

1［スタート］ > ［コントロール パネル］を選択します。

2［システムとセキュリティ］をクリックします。

3［電源オプション］をクリックします。

4［追加のプランを表示します］の矢印をクリックします。

5［高パフォーマンス］を選択します。

6［プラン設定の変更］をクリックします。

7［詳細な電源設定の変更］をクリックします。

8［電源オプション］ダイアログで、［ハード ディスク］ > ［次の時間が経過後ハード ディスクの電源を切る］を表
示します。

9［設定］のオプションをクリックします。

10［設定］（分）フィールドを選択し、コンピューターのキーボードの Backspaceを押すか、値をス
クロールして［オフにしない］に設定します。

11［OK］をクリックします。ハードディスクの設定が［なし］に変わり、［電源オプション］ダイアロ
グが閉じます。

12［プラン設定の編集］ウィンドウで、［変更の保存］をクリックしてウィンドウを閉じます。

推奨されている最適化
Pro Toolsは、コンピューターにインストールされた他のソフトウェアやハードウェア・ドライバーの
影響を受けることがあります。最適なパフォーマンスを得るためにも、以下をおすすめします（任意）。

• 不要なプログラムを Pro Toolsと同時に起動しない。
• Windows Messengerやカレンダーなど、バックグラウンドで動作するソフトウェア・ユーティ
リティをオフにする。

• Pro Toolsの使用中は不要な USBデバイスをオフにする。

Pro Toolsを起動すると、自動的に「高パフォーマンス」の電源設定に切り替わります。
Pro Toolsを終了すると、それまで選択されていた電源設定に戻ります（設定が異なる場合）。
従って、Pro Toolsに対して電源設定を最適化するときは「高パフォーマンス」にのみ設定
してください。
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任意の最適化
システムによっては、以下のシステム最適化によって Pro Toolsの処理能力が向上することがあります。
ご使用のシステム上の他のプログラムの機能が無効になったり低下したりする場合があるので、これ
らの最適化は必要な場合にのみ行うことをおすすめします。

プロセッサー・スケジューリングを調整する

プロセッサー・スケジューリングのパフォーマンスを調整するには：

1［コンピューター］を右クリックし、［プロパティ］を選択します。

2［システムの詳細設定］をクリックします。

3［パフォーマンス］セクションの［設定］ボタンをクリックします。

4［パフォーマンス オプション］ウィンドウの［詳細設定］タブをクリックします。
5［プロセッサのスケジュール］セクションの下の［バックグラウンド サービス］オプションを選択します。

6［OK］をクリックして［パフォーマンス  オプション］ウィンドウを閉じます。
7［OK］をクリックして［システムのプロパティ］ウィンドウを閉じます。

システムのスタートアップ項目を無効化する
コンピューターで使用される項目が少ないほど、Pro Toolsに割り当てられるリソースが多くなります。
CPUを消費する不要なスタートアップ項目はオフに切り替えることができます。
ただし、以下の項目については細心の注意が必要です。

• ポータブル・メディアのシリアル・ナンバー（コピー・プロテクション・キーを採用している
一部のアプリケーションに必要）

• プラグアンドプレイ・サービス
• イベント・ログ
• 暗号サービス
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システムのスタートアップ項目を無効にするには：

1［スタート］メニューの［プログラムのファイルと検索］に「msconfig」とタイプ入力し、Enter
を押してシステム構成ユーティリティを開きます。

2［全般］タブの下の［スタートアップのオプションを選択］を選択します。

3［スタートアップの項目を読み込む］のチェックをはずし、［OK］をクリックします。

4［再起動］をクリックして、コンピューターを再起動します。

5 再起動後、［システム構成］のメッセージが表示されます。［このメッセージを表示しない］オプ
ションを選択する前に、Pro Toolsの処理能力が向上しているかどうか確認してください。処理能力
に変化がない場合は、「msconfig」を実行して、［スタートアップの選択］を［通常スタートアップ - すべ
てのデバイス ドライバーとサービスを読み込む］に戻します。また、スタートアップ項目と不要なプロセスを
個別にオフに切り替えます。

システムのバックアップを行う
システムの設定と Pro Toolsのインストールが完了したら、バックアップ・ユーティリティを使用し、
システム・ドライブのイメージを保存します。こうしておけば、問題が発生した場合にも、システ
ム構成とその他の設定を迅速に復元できます。
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安装 Pro Tools 软件

欢迎使用 Avid 提供的 Pro Tools®。本指南文档说明如何在 Mac 和 Windows 系统中安装和授权
Pro Tools 软件。有关配置 Pro Tools 系统的详细信息以及 Pro Tools 系统功能的完整信息，请参阅
《Pro Tools 参考指南》（可通过 Pro Tools 的 “ 帮助 ” 菜单获取）。

Pro Tools 系统有四种类型：

Pro Tools 软件

这些系统包括 Pro Tools 软件，与 Avid 003™ 或 Digi 002® 家庭音频接口、 Eleven® Rack、 Mbox®
或 Mbox 2 家庭音频接口或  M-Audio 硬件配合使用。此外，还包括使用第三方音频接口的  Pro Tools
软件，这些接口采用了可支持的 Core Audio（Mac，包括 Mac 计算机上的内置音频）或 ASIO (Windows)
驱动程序。

带硬件加速的 Pro Tools HD 软件

带硬件加速的  Pro Tools HD 系统包括  Pro Tools HD 软件，能够与  Avid HDX、 Pro Tools|HD
或  HD Native 硬件配合使用。带硬件加速的系统提供更强大的 I/O 功能以及低滞后监听功能。配合
Avid HDX 或 Pro Tools|HD 硬件使用的 Pro Tools HD 软件还提供了用于插件处理以及大型混音器配置
的专用 DSP。

带 Complete Production Toolkit 的 Pro Tools HD 软件或 Pro Tools 软件

这些系统包括带有 Complete Production Toolkit 选件的 Pro Tools HD 软件或 Pro Tools 软件，能够与
任何兼容的 Avid、 Core Audio 或 ASIO 硬件配合使用。

Pro Tools Express 软件

这些系统包括 Pro Tools Express 软件，与 Mbox 家庭音频接口 （第三代）配合使用。（有关详细信息，
请参阅 《Pro Tools Express 安装指南》。）

有关所有 Pro Tools 系统的适用音频接口和计算机列表，请访问 www.avid.com/compatibility。
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系统要求及兼容性

Pro Tools 能够与经认证的音频接口配合使用，在经认证的  Windows 或 Mac 计算机上运行。

必须具备 DVD 驱动器才能使用 Pro Tools 安装程序光盘。

需要连接到网络才能下载 Pro Tools 安装程序。

Avid 只保证已通过测试和批准的软件及硬件的兼容性，并仅提供有关这些软件及硬件的支持。

若要获得完整的系统要求及认可的计算机、操作系统、硬盘和第三方设备的列表，请访问：

www.avid.com/compatibility

授权的 iLok
标准的 Pro Tools 软件包包括一个预先授权的 iLok，以供运行 Pro Tools 软件之用。带 Pro Tools 的硬件
包包括一个未经授权的 iLok 和一个用于授权 Pro Tools 的激活码。详细信息，请参阅第 127 页的 “ 授权
Pro Tools”。

MIDI 需求

USB、 FireWire 和 PCI MIDI 接口可在 Mac 或 Windows 上与 Pro Tools 系统有效地协作。只有
Windows 系统才支持串行 MIDI 接口。

硬盘需求

为了获得最佳的音频录音和播放效果，所有 Pro Tools 系统均需要一个或多个经过认证的硬盘。

使用 Apple 系统软件包含的 Disk Utility （磁盘工具）应用程序 (Mac) 或 Windows 的  Disk
Management （磁盘管理） (Windows) 对硬盘进行初始化。

必须将已授权的 iLok 插入计算机上可用的 USB 端口， Pro Tools 才能运行。

若要获取支持的 MIDI 接口和控制器的列表，请访问 www.avid.com。
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避免向系统驱动器录音

允许向系统驱动器录音，但不推荐执行此操作。在系统驱动器上录音和播放可能会减少轨道数量和
插件数量。

授权 Pro Tools
Pro Tools 软件使用 PACE Anti-Piracy 提供的  iLok USB 智能密钥  (iLok) 进行授权。此密钥可以容
纳所有启用了 iLok 的软件的几百个授权。一旦针对给定的一款软件授权 iLok，您就可以使用 iLok 在任
何计算机上授权此软件。

Pro Tools HD 授权

Pro Tools HD 授权让您能够在配备或未配备 Avid HDX、 Pro Tools|HD 或 Pro Tools|HD Native
硬件的受支持 Mac 或  Windows 计算机上运行 Pro Tools HD 软件。Pro Tools HD 授权还可以让您
配合经 Avid 认证的音频接口（如 Mbox 或 Fast Track）或任何采用支持的 Core Audio (Mac) 或  ASIO
(Windows) 设备驱动程序的第三方音频接口运行 Pro Tools HD 软件。

为了取得最佳性能，您可能需要将您的系统驱动器指定为 DigiBase 中的仅播放卷或仅传输卷。 有关

详细信息，请参阅 《Pro Tools 参考指南》。

iLok USB 密钥

您既可使用新版的 iLok （如上所示）也可使用旧版的 iLok 来保留 Pro Tools 的授权。
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Pro Tools 授权

Pro Tools 授权让您可以在支持的  Mac 或 Windows 计算机上运行  Pro Tools 软件，该软件可与经
Avid 认证的音频接口 （如  Mbox 或 Fast Track）或任何采用支持的 Core Audio (Mac) 或 ASIO
(Windows) 设备驱动程序的第三方音频接口配合使用。

Complete Production Toolkit 授权

Complete Production Toolkit 授权再加上 Pro Tools 授权便可运行提供 Complete Production
Toolkit 功能的  Pro Tools 软件。Pro Tools 的  Complete Production Toolkit 软件选件提供更高的
音量和更多的音轨数量，并具有不逊于 Pro Tools HD 的环绕声混音、编辑和自动化功能。

使用激活码授权 iLok 
购买新 Pro Tools 软件盒装版将可获得预先授权的 iLok。您可以跳过此部分继续第 129 页的 “ 安装
Pro Tools”。
如果您购买新 Avid HDX、 Pro Tools|HD 或 HD Native 系统，便可获得一个空白的 iLok 和一个激活码
（在附带的激活卡上），以供授权  Pro Tools HD 软件之用。请按照下面的授权说明执行操作。

如果您对 Pro Tools 软件的旧版本进行升级，您可获得一个激活码 （在附带的激活卡上），以供您对
iLok 上的软件升级进行授权。请按照下面的授权说明执行操作。

Pro Tools 授权不足以用于运行 Pro Tools HD 软件。若尝试在没有 Pro Tools HD 授权时在 HDX、

Pro Tools|HD 或 HD Native 系统上启动 Pro Tools 软件，而系统可以使用带有内置声音或其

他音频接口的 Core Audio 或 ASIO， Pro Tools 则可以启动，但不能使用任何安装的 HDX、

Pro Tools|HD 或 HD Native 硬件。

有关 Complete Production Toolkit 的详细信息，请参阅 《Complete Production Toolkit 指南》

或 《Pro Tools 参考指南》。
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使用激活码授权 Pro Tools 软件：

1 如果您没有 iLok.com 帐户，请访问  www.iLok.com 并注册一个帐户。

2 通过执行以下操作将软件许可传输到您的 iLok.com 帐户：

• 请访问 www.avid.com/activationcard。

– 与 –

• 输入激活码（列于激活卡上）和 iLok.com 用户 ID。您的 iLok.com 用户 ID 就是您创建 iLok.com
帐户的名称。

3 通过执行以下操作将许可从 iLok.com 帐户传输到 iLok USB 智能密钥：

• 将 iLok 插入计算机上可用的 USB 端口。

• 转到 www.iLok.com 并登录。

• 按照屏幕上的说明将许可传输到 iLok。

安装 Pro Tools

安装概述

安装 Pro Tools 包括以下步骤：

1 第 130 页的 “ 安装硬件驱动程序 ”。
2 第 130 页的 “ 安装  Pro Tools 软件 ”。
3 第 134 页的 “ 安装  Avid 虚拟乐器 ” （可选）。

4 第 135 页的 “ 启动  Pro Tools”。
5 配置您的系统以改善性能 （请参阅 《Pro Tools 参考指南》）。

6 将音频设备连接到音频接口 （请参阅音频接口随附的相关文档）。

有关详细信息，请访问 iLok 网站 (www.iLok.com)。

如果您打算升级 Pro Tools，请务必卸载计算机上任何较低版本的 Pro Tools。请参阅第 137 页的

“ 卸载 Pro Tools”。
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安装硬件驱动程序

安装 Pro Tools 软件前，请确保您已安装音频硬件以及最新的硬件驱动程序。有关详细信息，请参阅
随硬件提供的文档。对于 Avid 音频接口，安装硬件驱动程序时，使用 Pro Tools 安装程序包附带的
驱动程序安装程序光盘上相应的驱动程序安装程序，或访问 www.avid.com/drivers 下载和安装最新
的设备驱动程序。

安装 Pro Tools 软件

音频接口驱动程序安装完成后便可安装 Pro Tools 了。

安装 Pro Tools：

1 确保以管理员身份登录要安装 Pro Tools 的帐户。

2 请执行以下操作之一：

• 将 Pro Tools 安装程序光盘插入 DVD 光驱中。

– 或 –
• 上网下载 Pro Tools 安装程序。

Pro Tools 安装程序将自动安装必要的硬件驱动程序，仅适用于 Avid HDX、Pro Tools|HD 和 HD
Native 硬件。

如果没有安装驱动程序，Pro Tools 将无法识别您的音频接口。如果您打算升级 Pro Tools，请务必

安装最新的硬件驱动程序。

安装此 Pro Tools 版本前，请参阅随附的 “ 自述文件 ” 信息。
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3 请执行以下操作之一：

• 在 Mac 系统上找到并双击 Install Pro Tools.mpkg。

• 在 Windows 系统上执行以下操作之一：

• 若 Windows AutoRun （Windows 自动运行）处于启用状态，则画面上将会出现微型浏览器。
选择 Install Pro Tools （安装 Pro Tools）以开始安装。

– 或 –

• 如果禁用了 Windows AutoRun，请找到并双击 Setup.exe，然后选择 Install Pro Tools （安装
Pro Tools）以开始安装。

 

4 按着屏幕上的说明继续安装。

5 在 Installation Type （安装类型）页面，执行以下操作之一：

• 若要安装所有 Pro Tools 应用程序文件和免费插件程序套件（以及关联内容），请保持默认安装选项
的选中状态，并单击 Continue （继续）。

– 或 –
• 选择（或取消选择）自定义配置安装选项（请参阅第 132 页的 “ 安装选项 ”）并单击 Continue（继续）。

6 单击 Install （安装）。

7 根据提示输入管理员密码，然后单击 OK （确定）以验证安装。

8 按照屏幕上的其余说明执行操作。

9 安装完成后，单击 Restart （重新启动） (Mac) 或  Finish （完成） (Windows)。

在 Windows 系统中，如出现 User Account Control （用户帐户控制）对话框，请单击 Allow
（允许）。可忽视安装过程中出现的一些消息，包括多个 Found New Hardware （发现新硬件）

对话框和 A Problem Occurred During Hardware Installation （硬件安装期间出现了问题）。

此外，如果出现驱动程序没有通过 Windows 徽标测试的警告对话框，请单击 Continue
Anyway （仍然继续）。

Pro Tools 安装程序光盘包含适合于所用系统的其他软件。详细信息，请参阅第 136 页的 “Pro Tools
安装程序光盘上的其他软件 ”。
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安装选项

Pro Tools 10 选项

若要安装 Pro Tools 软件和插件程序的附属产品，请单击安装程序中 Pro Tools 10 选项的显示三角形，
并取消选择其余您不想安装的任何选项。

Application Files （应用程序文件）， Pro Tools 的必备文件 安装运行 Pro Tools 所需的
Pro Tools 应用程序与支持库文件。安装  Pro Tools 必须选择该选项。

Avid Effects （Avid 效果） 安装免费的 Avid 音频效果插件。有关详细信息，请参阅《音频插件指南》。

Pro Tools Utilities （Pro Tools 实用程序） 安装 Pro Tools 实用程序，如 DigiTest 和 Uninstall
Pro Tools （仅适用于 Mac）。

其他选项

Pro Tools 安装程序提供以下额外选项，可随 Pro Tools 软件与插件一道安装。

Mac HFS+ Disk Support Option （Mac HFS+ 磁盘支持选项），仅适用于 Windows 此 选 项
让您的 Pro Tools 系统可以利用  Mac 格式化的 HFS+ 磁盘读写、记录和播放。 HFS+ 磁盘通常被称
为 Mac OS 扩展磁盘。有关详细信息，请参阅 《Pro Tools 参考指南》。

Avid Video Engine （Avid 视频引擎） 使用 Pro Tools 与 Avid 视频外围设备 （如 Avid Mojo®

SDI）时，将需要 Avid 视频引擎。有关详细信息，请参阅 《Avid 视频外围设备指南》。
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启动或关闭系统

为了确保  Pro Tools 系统的各个组件互相能正确通信，您需要按特定的顺序一一启动它们。

请按以下顺序启动 Pro Tools 系统：

1 确保所有设备 （包括您的计算机）均已关闭。

2 调低系统中所有输出设备的音量。

3 对于配有扩展接口箱的系统，请打开扩展接口箱。

4 打开所有外置硬盘。等待十秒，让它们达到所需的转速。

5 打开所有控制界面。

6 打开所有 MIDI 接口和设备或同步外围设备。

7 对于需要外接电源的系统，请打开硬件（如 HD I/O 或 003）。等待至少十五秒，让音频接口初始化，
以及状态  LED 指示灯停止闪烁。

8 打开计算机。

9 启动 Pro Tools （请参阅第 135 页的 “ 启动 Pro Tools”）或任何第三方音频或 MIDI 应用程序。

请按以下顺序关闭 Pro Tools 系统：

1 退出 Pro Tools 和任何正在运行的其他应用程序。

2 关闭或者调低系统中所有输出设备的音量。

3 关闭计算机。

4 若系统使用需要外部电源的硬件，请关闭硬件。

5 关闭 Pro Tools 音频接口。

6 对于配有扩展接口箱的系统，请关闭扩展接口箱。

7 关闭各种 MIDI 接口、 MIDI 设备以及同步外围设备。

8 关闭所有控制界面或工作台。

9 关闭各外置硬盘。

要退出 Pro Tools，请选择 Pro Tools > Quit （Pro Tools > 退出） (Mac)，或选择 File > Exit
（文件 > 退出） (Windows)。
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安装 Avid 虚拟乐器

Avid 提供一整套免费的虚拟乐器插件和相关样本内容供您用于  Pro Tools。有关详细信息，请参阅
《音频插件指南》。

安装 Avid 虚拟乐器：

1 确保以管理员身份登录要安装 Avid 虚拟乐器的帐户。

2 请执行以下操作之一：

• 将 Pro Tools 安装程序光盘插入 DVD 光驱中。

– 或 –
• 上网下载 Avid 虚拟乐器安装程序和相关内容。

3 请执行以下操作之一：

• 在 Mac 系统上找到并双击 Install Avid Virtual Instruments.mpkg。

• 在 Windows 系统上执行以下操作之一：

• 从光盘进行安装时，如果启用了 Windows AutoRun，画面上就会显示一个迷你浏览器。选择
Install Avid Virtual Instruments （安装 Avid 虚拟乐器）以开始安装。

• 从光盘安装时，如果禁用了 Windows AutoRun，请找到并双击 Setup.exe，然后选择  Install Avid
Virtual Instruments （安装 Avid 虚拟乐器）以开始安装。

• 如果已下载了 Avid 虚拟乐器安装程序，请运行 Avid Virtual Instruments.exe。

4 按着屏幕上的说明继续安装。

5 单击 Install （安装）。

6 根据提示输入管理员密码，然后单击  OK （确定）以验证安装。

7 按照屏幕上的其余说明执行操作。

8 安装完成时，单击  Close （关闭） (Mac) 或 Finish （完成） (Windows)。

虚拟乐器内容非常庞大，可能需要长达 20 分钟才能完成安装。在此期间，进度条可能看似没有变化，

但实际上软件安装仍在进行中。请勿终止安装。
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启动 Pro Tools
若要使用 Pro Tools 软件，您必须获得带有许可的 iLok，以对您安装的 Pro Tools 版本进行授权 （有关
详细信息，请参阅第 127 页的 “ 授权 Pro Tools”）。

启动 Pro Tools 软件：

1 确保您的音频接口已连接到计算机，并且已打开电源。

2 将授权的 iLok 插入计算机上任何可用的  USB 端口 （请参阅第 127 页的 “ 授权 Pro Tools”）。

3 请执行以下操作之一：

• 在 Mac 上，单击 Dock 中的 Pro Tools 快捷方式（或双击 Macintosh HD/Applications/Avid/Pro Tools
中的应用程序图标）。

– 或 –
• 在 Windows 上，双击桌面上的 Pro Tools 快捷方式 （或 Program Files\Avid\Pro Tools 中的应

用程序）。

4 使用 Quick Start （快速开始）对话框执行以下任一操作：

• 从模板创建一个新的工程。

• 创建新的空白工程。

• 打开系统中其它任何工程。

配置 Pro Tools 系统

完成  Pro Tools  软件的安装、授权和启动后，您便可配置您的  Pro Tools  系统，以满足您工作室的
具体需求。有关 Pro Tools 软件配置的详细信息，请参阅 《Pro Tools 参考指南》（可通过 Pro Tools 的
“ 帮助 ” 菜单获取）。

不要在启动或使用 Pro Tools 过程中拔拆 iLok。

有关 “ 快速开始 ” 对话框以及工程模板的详细信息，请参阅 《Pro Tools 参考指南》。
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Pro Tools 安装程序光盘上的其他软件

Pro Tools 安装程序光盘上的 Additional Files （其他文件）文件夹中提供可供您的  Pro Tools 系统使
用的附加文档和软件。

文档

Documentation （文档）文件夹中包含关于 Pro Tools 软件、硬件、插件和选项的 PDF 文档。

技术支持

Tech Support （技术支持）文件夹中包含关于  Pro Tools 系统故障诊断所需的 PDF 文档、在线资源
信息和 Pro Tools 工程。

可选安装程序

Optional Installers（可选安装程序）文件夹中包含可单独购买和授权的 Pro Tools 软件选项的安装程序。

HEAT
（仅限于 Avid HDX 和 Pro Tools|HD 系统）

HEAT （Harmonically Enhanced Algorithm Technology，谐波增强算法技术）是付费软件选项，
可在 Avid HDX 和 Pro Tools|HD 系统中为 Pro Tools HD 添加 “ 模拟色彩 ”。有关详细信息，请参阅
《HEAT 软件选项指南》。

Pro Tools Demo Session（Pro Tools 演示工程）

Pro Tools 安装程序光盘上包括一个演示工程，用于验证您的系统是否能够正常地工作。

如需安装该演示工程：

1 将 Pro Tools 安装程序盘插入 DVD 驱动器中。

2 在 Pro Tools 安装程序光盘上找到并打开 “Additional Files” 文件夹。

3 将 Pro Tools Demo Session （Pro Tools 演示工程）文件夹复制到有效的音频驱动器中。

4 打开演示工程。
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卸载 Pro Tools
若您需要从计算机中移除  Pro Tools 软件，则必须使用  Mac 上的 “ 卸载程序 ” 应用程序或使用
Windows“ 控制面板 ” 中的程序。

在 Mac 系统上卸载 Pro Tools
在 Mac 系统上卸载 Pro Tools：

1 确保以管理员身份登录安装了 Pro Tools 的帐户。

2 访问 Applications/Avid/Pro Tools/Pro Tools Utilities 并双击 Uninstall Pro Tools（卸载 Pro Tools）。

3 单击 Continue （继续）进行卸载。

4 选择您要执行的卸载类型：

安全卸载 保留与某些 Avid 产品兼容所必需的特定插件与系统文件。如果使用的是 Avid 应用程序或者
准备更新至 CS （客户支持）版，请使用  Safe Uninstall （安全卸载）。

Clean Uninstall （完全卸载） 移除所有  Pro Tools  文件，包括系统文件、 Av id 插件以及  MIDI
音色名。如果打算进行升级，或者从干净的系统进行故障排除，请使用 Clean Uninstall （完全卸载）。

5 单击 Uninstall （卸载）。

6 输入管理员密码并单击 OK （确定）。

7 单击 Finish （完成）以关闭安装程序窗口。

在 Windows 系统上卸载 Pro Tools
在 Windows 系统上卸载 Pro Tools：

1 选择 Start > Control Panel （开始  > 控制面板）。

2 单击 Programs and Features （程序和功能）。

3 单击 Uninstall a program （卸载程序）。

4 从已安装应用程序列表中选择 Avid Pro Tools。
5 单击 Uninstall （卸载）。

6 按照屏幕上的说明移除 Pro Tools。

请注意，您必须个别卸载插件 （如 Avid 效果）以及任何音频和 MIDI 设备驱动程序。
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优化用于 Pro Tools 的 Mac 系统

为确保使用 Pro Tools 时获得最佳性能，请先对计算机进行配置。

在配置计算机之前，确保以管理员身份登录要安装 Pro Tools 的帐户。有关  Mac OS X 中管理员权限
的详细信息，请参阅 Apple OS X 文档。

关闭软件更新

关闭软件更新功能：

1 从 Apple 菜单中选择 System Preferences （系统预置）。

2 单击 Software Update （软件更新）。

3 单击 Scheduled Check （计划检查）选项卡。

4 取消选择  Check for Updates （检查更新）。

5 完成此操作后，选择 System Preferences > Quit System Preferences（系统预置 > 退出系统预置）。

关闭节能器

关闭节能器功能：

1 从 Apple 菜单中选择 System Preferences （系统预置）。

2 单击 Energy Saver （节能器）。

3 将 Computer Sleep （计算机睡眠）设置设成  Never （永不）。

4 将 Display Sleep （显示器睡眠）设置设成 Never （永不）。

5 取消选择  Put the hard disk(s) to sleep when possible （如果可能，使硬盘进入睡眠）选项。

6 完成此操作后，选择 System Preferences > Quit System Preferences（系统预置 > 退出系统预置）。

请勿使用 Mac OS X 自动的 Software Update （软件更新）功能，因为该功能可能会将系统升级到

尚未获得 Pro Tools 认可的 Mac OS 版本。有关 Mac OS 认证版本的详细信息，请参阅我们网站

(www.avid.com) 上的最新兼容性信息。
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禁用或重新分配供 Pro Tools 使用的 Mac 键盘迅捷

为完善  Pro Tools 键盘快捷键，您必须在 Apple System Preferences （系统预置）中禁用或重新分
配所有冲突的 Mac OS X 键盘迅捷。

禁用或重新分配供 Pro Tools 使用的 Mac 键盘迅捷 (Mac OS X Lion)：

1 从 Apple 菜单中选择 System Preferences （系统预置）。

2 单击 Keyboard （键盘）。

3 单击 Keyboard Shortcuts （键盘迅捷）选项卡。

4 您可以禁用或重新分配与 Pro Tools 键盘快捷键冲突的  Mac OS 键盘迅捷。下表包括各种常见的
Mac 键盘迅捷，视您的 Mac 厂商和型号而定，它们也能供 Pro Tools 使用：

• 于 Launchpad & Dock （Launchpad 和 Dock）下

• Turn Dock Hiding On/Off （打开 / 关闭  Dock 隐藏）

• 于 Mission Control （任务控制）下

• “Mission Control”
• Application windows （应用程序窗口）

• Show Desktop （显示桌面）

• Show Dashboard （显示  Dashboard）

• Mission Control > Move left a space （Mission Control > 向左移动一个空间）

• Mission Control > Move right a space （Mission Control > 向右移动一个空间）

• Mission Control > Switch to Desktop n （Mission Control > 切换至桌面 n）

要查看完整的 Pro Tools 键盘快捷键列表，请参阅《键盘快捷键指南》（Help > Keyboard Shortcuts
[ 帮助 > 键盘快捷键 ]）。
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• 于 Keyboard & Text Input （键盘和文本输入）下

• Move focus to the window drawer （移动焦点至窗口抽屉）

• 于 Services （服务）下

• Send File To Bluetooth Device （将文件发送到蓝牙设备）

• Search With Google （使用 Google 搜索）

• Spotlight
• Search Man Pages in Terminal （在终端搜索手册页）

• 于 Spotlight 下
• Show Spotlight search field （显示 Spotlight 搜索字段）

• Show Spotlight window （显示 Spotlight 窗口）

• 于 Universal Access （通用访问）下

• Zoom （缩放）

• Contrast （对比度）

• 于 Application Shortcuts （应用程序迅捷）下

• Show Help menu （显示 “ 帮助 ” 菜单）
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禁用或重新分配供 Pro Tools 使用的 Mac 键盘迅捷 (Mac OS X Snow Leopard)：

1 从 Apple 菜单中选择 System Preferences （系统预置）。

2 单击 Keyboard （键盘）。

3 单击 Keyboard Shortcuts （键盘迅捷）选项卡。

4 您可以禁用或重新分配与 Pro Tools 键盘快捷键冲突的  Mac OS 键盘迅捷。下表包括各种常见的
Mac 键盘迅捷，它们也能供  Pro Tools 使用：

• 于 Dashboard & Dock （Dashboard 和 Dock）下

• Turn Dock Hiding On/Off （打开 / 关闭  Dock 隐藏）

• Dashboard
• 于 Exposé and Spaces （Exposé 与 Spaces）下

• All windows （所有窗口）

• Application windows （应用程序窗口）

• Desktop （桌面）

• 于 Keyboard & Text Input （键盘和文本输入）下

• Move focus to the window drawer （移动焦点至窗口抽屉）

• 于 Spotlight 下
• Show Spotlight search field （显示 Spotlight 搜索字段） 
• Show Spotlight window （显示 Spotlight 窗口）

• 于 Application Shortcuts （应用程序迅捷）下

• Show Help menu （显示 “ 帮助 ” 菜单）

禁用 Spotlight 索引

Mac OS X Spotlight 功能会自动在后台对本地硬盘上的文件与文件夹进行索引。大多数情况下，普通
Pro Tools  操作不会受此影响。不过，如果用户在具高轨道数的  Pro Tools  工程中进行长时间录音，
而 Spotlight 在此过程中开始对硬盘进行索引，则会对  Pro Tools  系统性能造成不良影响。您可以在
使用 Pro Tools 进行大型录音项目前，对所有本地硬盘禁用 Spotlight 索引功能。

禁用 Spotlight 索引也会禁用 Mac OS X 的 Find （查找）功能。
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禁用 Spotlight 索引：

1 从 Apple 菜单中选择 System Preferences （系统预置），并单击 Spotlight 。

2 在 Spotlight 窗口中，单击 Privacy （隐私）选项卡。

3 为了防止对硬盘进行索引，请将其图标从桌面拖入列表中。

启用音频驱动器的日志功能

为了提高音频驱动器的性能，请启用日志功能。

启用日志功能：

1 启动位于  Applications/Utilities 下的  Disk Utility （磁盘工具）应用程序。

2 从 Disk Utility （磁盘工具）窗口的左列选择卷。

3 在工具栏中选择  Enable Journaling （启用日志）。

优化用于 Pro Tools 的 Windows 系统

为确保使用 Pro Tools 时获得最佳性能，请在使用 Pro Tools 硬件和软件前对计算机进行配置。

在配置计算机之前，确保以管理员身份登录要安装 Pro Tools 的帐户。有关管理员权限的详细信息，
请参阅 Windows 文档。

必要的优化

为确保使用 Pro Tools 时获得最佳性能，请在使用 Pro Tools 硬件和软件前对下列设置进行配置。

有关 Windows 系统设置的最新信息以及特定计算机的信息，请访问 Avid 网站 (www.avid.com)。

在完成 Windows 系统设置的更改之后，请重新启动计算机。
 安装 Pro Tools 软件142



禁用用户帐户控制

禁用用户帐户控制 (UAC)：

1 选择 Start > Control Panel （开始  > 控制面板）。

2 单击 User Accounts and Family Safety （用户帐户和家庭安全）。

3 单击 User Accounts （用户帐户）。

4 单击 Change User Account Control settings （更改用户帐户控制设置）。

5 将滑杆设置到 Never Notify （永不通知）。

6 单击 OK （确定）。

配置系统待机和电源管理

使用 Pro Tools 时， Windows 的 System Standby （系统待机）电源使用方案必须设置为 Always On
（一直开着）。这有助于避免时间很长的录音或播放因系统资源耗尽电力，而导致录音或播放停止。配置
Windows 的电源管理：

1 选择 Start > Control Panel （开始 > 控制面板）。

2 单击 System and Security （系统和安全）。

3 单击 Power Options （电源选项）。

4 单击箭头以显示  Additional Plans （其他方案）。

5 选择 High Performance （高性能）。

6 单击 Change plan settings （更改方案设置）。

7 单击 Change advanced power settings （更改高级电源设置）。

8 在 Power Options（电源选项）对话框中，显示 Hard disk > Turn off hard disk after（硬盘 > 在
一段时间后关闭硬盘）。

9 单击 Setting （设置）选项。

10 在 Setting (Minutes) （设置 [ 分钟 ] ）字段中选择值，并按下计算机键盘上的 Backspace （空格键）
或将值滚动至 Never （永不）。

11 单击  OK （确定）。硬盘设置更改为 Never （永不），而 Power Options （电源选项）对话框将随
即关闭。

12 在 Edit Plan Settings （编辑方案设置）窗口中，单击 Save changes （保存更改）并关闭窗口。
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建议优化

Pro Tools 也可能会受到计算机上安装的其他软件和硬件驱动程序的影响。为了取得最佳性能，我们建议
（但并不要求）采取以下措施：

• 在运行 Pro Tools 时避免运行任何不必要的程序。

• 关闭各种在后台运行的软件实用程序，例如 Windows Messenger、日历程序和磁盘维护程序。

• 在运行 Pro Tools 时关闭各种非必要的 USB 设备。

可选优化

以下系统优化操作可能有助于提高  Pro Tools  在某些系统上的性能。建议只在必要时才尝试这些优
化操作，因为它们可能会禁用系统上其他程序的功能或对其产生不利影响。

调整处理器计划

调整处理器计划的性能：

1 右击 Computer （我的电脑）并选择 Properties （属性）。

2 单击 Advanced system settings （高级系统设置）。

3 在 Performance （性能）部分，单击 Settings （设置）按钮。

4 在 Performance Options （性能选项）窗口中，单击 Advanced （高级）选项卡。

5 在 Processor Scheduling （处理器计划）部分，选择 Background Services （后台服务）选项。

6 单击 OK （确定），关闭  Performance Options （性能选项）窗口。

7 单击 OK （确定），关闭  System Properties （系统属性）窗口。

Pro Tools 在启动后将自动切换成 High Performance（高性能）电源管理设置。退出 Pro Tools 后，

Windows 将恢复成之前选择的电源管理设置（如不同）。因此，优化用于 Pro Tools 的电源管理设

置时，应仅优化 High Performance （高性能）配置。
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禁用系统启动项目

计算机使用的程序越少，可供  Pro Tools 使用的资源就越多。有些在系统启动时加载的应用程序会不
必要地消耗 CPU 资源，可以将此类程序关掉。

如果您要禁用以下启动项目，请小心操作：

• 便携式媒体序号 （用于使用拷贝保护键的某些应用程序）

• 即插即用服务

• 事件记录

• 密码编译服务

禁用系统启动项目：

1 在 Start（开始）菜单的 Start Search（开始搜索）中键入 msconfig，并按下 Enter 以打开  System
Configuration Utility （系统配置实用程序）。

2 在 General （一般）选项卡下，选择 Selective Startup （有选择的启动）。

3 取消选择 Load Startup Items （加载启动项），然后单击 OK （确定）。

4 单击 Restart （重新启动）以重启计算机。

5 重新启动之后，计算机就会显示  System Configuration （系统配置）消息。取消选择 Don't show
this message again （不再显示此消息）选项之前，请先检查 Pro Tools 的性能是否有所提高。如果
性能没有提高，请运行  msconfig，将计算机的 Startup Selection（启动选择）还原至 Normal Startup
- load all device drives and services （正常启动  - 加载所有设备驱动程序和服务）。或者，也可以
尝试逐个禁用启动项目和非必要的进程。

备份系统

设置系统及安装 Pro Tools 后，应使用备份实用程序来保存系统硬盘的映像。这样，如果遇到任何问题，
您都可以快速恢复系统配置与设置。
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